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PREFACEPREFACEPREFACEPREFACE    

    
 
This is the second edition of our TELR training manual. The changes are primarily seen in the 

updating of specific technology and the addition of a tutorial on Publisher. These materials are designed 
for the true computer beginner who is also an indigenous language practitioner, teacher, student or 
advocate.  In recent years, the plight of languages indigenous to the Americas has been repeatedly 
brought to light (Krauss, 1992, Hinton and Hale 2001).  The startling facts, which all point to language 
loss on a grand scale, call for urgent efforts to document, preserve, teach and generally revitalize these 
languages.  Broad based and local efforts are needed for this task.  These include community 
commitments to expand indigenous language education, increased advocacy for community languages, 
integrating the work of dedicated elders, teachers, and students of these languages and a careful 
examination of how technology can assist in these efforts.   

Digital technologies are quickly becoming an integral part of our every day world.  Harnessing 
this technology can make it a viable tool for language learning.  This training guide offers to help 
beginners create technology-enhanced language learning materials in support of indigenous language 
revitalization.  It aims to acquaint them with basic computer technologies, which can be used towards 
language teaching and language documentation.  Because this project has been supported by the Bill and 
Melinda Gates Foundation and its “Native American Access to Technology” program, these materials are 
designed to be consistent with the computers and most of the software currently used in the tribal 
libraries throughout the Southwest.   

Part I of this guide presents a brief history on the relationship between indigenous languages and 
technology.  Insights are provided as to how to acquire and use native language data as source material 
for instructional media. Part II reviews the basic parts of a computer and their functions.  Part III is 
focused on those computer programs, which will allow for the creation of the most basic types of 
interactive language lessons.  The users of these materials will need access to the Internet, Microsoft 
WORD 2003, MaxAuthor, Power Point 2003, Microsoft Publisher 2003, and Adobe Photoshop 7 to 
correctly apply the activities included here.  Each discussion of a new program includes an explanation 
of what the program capabilities are in terms of indigenous language support, a graphic description of 
how to proceed with language-specific components offered within the program and exercises throughout 
to assist in training.  Part IV discusses new directions in technology and additional resources. 

Advocacy is a beginning point for all who venture into the world of endangered languages.  To 
that end, these materials also contain stories and quotations aimed at supporting and enlightening those 
who function as language advocates for their own or another’s endangered language. 

These materials are very focused and were tested in a one-month long course at the American 

Indian Language Development Institute in Tucson, Arizona, summers of 2003-2005.  We hope these 

materials are helpful and encouraging to beginning students.  Our goal is to assist in the maintenance, 

documentation and revitalization of Indigenous languages.  We see technology as a promising way to 

bring historically rich heritage languages into present, practical use. 
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PART PART PART PART IIII: : : : THE PLACE OF TECHNOLOGY IN INDIGENOUS LANGUAGE THE PLACE OF TECHNOLOGY IN INDIGENOUS LANGUAGE THE PLACE OF TECHNOLOGY IN INDIGENOUS LANGUAGE THE PLACE OF TECHNOLOGY IN INDIGENOUS LANGUAGE 
REVITALIZATIONREVITALIZATIONREVITALIZATIONREVITALIZATION    

    
 

The world’s Indigenous languages are immensely rich and diverse. Unfortunately, in the 
Americas as elsewhere, many of these languages are endangered and are disappearing at a rapid 
rate. Why is this happening? How do we save a dying language? The answers to these 
questions are as numerous as there are languages.  Nevertheless, the challenge to preserve and 
revitalize our languages bears an enormous burden in the face of change. In this section, we 
look at the facts about Indigenous language endangerment. We also explore what it takes to be 
a language advocate for your language and discuss the place of technology in Indigenous 
language revitalization.   
 
TTTTHE FACTS ON INDIGENOUS LANGUAGE ENDANHE FACTS ON INDIGENOUS LANGUAGE ENDANHE FACTS ON INDIGENOUS LANGUAGE ENDANHE FACTS ON INDIGENOUS LANGUAGE ENDANGERMENTGERMENTGERMENTGERMENT    
 

“Of about 210 Indigenous languages still extant in the USA and Canada, 34 are 
spoken by speakers of all generations, 35 are spoken by the parental generation 
and up, 84 are spoken by the grandparental generation and up, and 57 are spoken 
by only a few aged speakers.” (Michael Krauss 1992). 

 
Current estimates predict that the 50 or more languages spoken by only a few elders 

over 70 will be extinct by the year 2010.  By the year 2060, of those languages spoken by the 
parental generation, all but 20 would be extinct (Krauss 1998).   

Those are the hard realities – and they are appalling and sad. We should be aware of 
these facts and not forget that reversing language shift calls for urgency. However, only focusing 
on the negative aspects of the problem tends to blot out the many positive things that are 
happening. There are success stories; there is hope! 

The most successful are the languages, which stand as large state-recognized languages 
like Maori in New Zealand and Hawaiian. Smaller groups like the Mikasuki (Florida), Choctaw 
(Mississippi), some Lakota-Dakota communities have made good progress.  Also, a number of 
Arizona and New Mexico Indigenous languages, namely Navajo, Western Apache, Tohono 
O’odham, Havasupai, Hualapai, Jemez, Eastern Keres, Northern Tiwa and a few others, can all 
speak to successes in preservation and revitalization. (Krauss 1998:14) 

Success is determined a number of ways, mostly judged by those languages still being 
taught to children. Languages that are no longer taught to children are considered to be 
‘moribund’, or dying.  Certainly strong immersion programs, which promote real fluency and 
generate a good number of young speakers are the hope of every endangered language 
community. But there are other measures of success as well.  

Every time community members support a language program where classes are formed, 
lessons are generated, children are included, is a success. Even smaller successes matter – a 
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new word learned today, a new student joining in, more of the language documented and 
recorded – it ALL matters!  This is important to remember. Sometimes it is easy to get 
discouraged when the bigger picture and ultimate goals of a community plan seem distant and 
hard to reach. Never forget that every step toward that ultimate goal of revitalization counts! 
 
Here are a few SUCCESS STORIES.SUCCESS STORIES.SUCCESS STORIES.SUCCESS STORIES.    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
 
 
And, you can make a difference too!And, you can make a difference too!And, you can make a difference too!And, you can make a difference too!    Look at the next storLook at the next storLook at the next storLook at the next story.y.y.y.    
    
 
 
 
 
 
 
    
    
    
    
    
    
    
    

Love of Creek language inspires teacher to share 
By KEITH DINWIDDIE / The Norman Transcript 

 
NORMAN, Okla. (AP) -- In the American Indian language of Creek, 

the word ‘mvhayv’ (pronounced mu-high-ya) means teacher. On the 
University of Oklahoma campus, Margaret Mauldin is much more than 
that. 

Mauldin, affectionately known as "Mvhayv" to her students at OU, 
is one of the world's foremost authorities on the Creek language. In 
the fall of 1995, Mauldin became OU's first Creek language 
instructor. In her first semester as a university-level Creek 
instructor, Mauldin said she had only limited homemade materials to 
use. 

During her years on the road, Mauldin said she found herself 
missing the Creek language. Once she returned home to Okemah, she 
discovered fewer and fewer people were speaking Creek. "It struck me 
that I wasn't hearing the language as frequently as I used to," 
Mauldin said. "I kept wondering why 'they' weren't doing anything 
about it, and then I thought why aren't I doing anything about it. I 
decided then that I could make a difference, and I would make a 
difference." 

http://www.okmulgeetimes.com/display/inn_news/709.txt 
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The above two stories speak to the work of internal advocates; the following story is about the 
contribution of an external advocate and linguist. 
 
 
 
    
    
    
    
    
    
    
    
    
    
    

In Her Own Tongue 
by Gayle Goddard-Taylor 

 
The dream started more than a decade ago. Cape Cod, Mass., 

resident Jessie Little Doe Fermino saw faces that seemed familiar, 
faces that looked like they belonged to her own tribe, the Mashpee 
Indians. “One day as I was driving to Woods Hole, I saw a sign for 
“Sippewisset” she recalls. “That’s when I realized the words I was 
hearing had to be Wampanoag. Her vision began to take the form of a 
question: Would today’s tribal members welcome back their native 
language, a tongue that had languished for more than 150 years?  

She posed the question to the two area Wampanoag tribes, the 
Mashpee of Cape Cod and the Aquinnah of Martha’s Vineyard, not 
convinced that she would get the unanimous support she was seeking. 
Amazingly, not a single tribe member was opposed. Some felt the 
vision hinted of an ancient prophecy that predicted the tribes would 
abandon their language but it would later return to them. 

Undeterred, she applied for a one-year fellowship at the 
Massachusetts Institute of Technology to study with world-renowned 
linguist, the late Kenneth Hale. It was a productive partnership 
that would blossom into friendship. “He was my professor, my mentor, 
and my best friend,” she says. 

Today, Fermino has developed a language curriculum for her 
students, who range in age from 12 to 78. Some even come to class 
with infants in tow. Her dictionary-in-progress has grown to 6,800 
words. Two of her advanced students have begun teaching, freeing her 
up for research. And on a personal level, Fermino converses with her 
children in Wampanoag, although, she quips, “they keep asking how to 
tell me to shut up.” 

 
http://www.americanprofile.com/issues/20040425/20040425_3859.asp 
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What is your story? Ask yourself how you fit into the efforts to revitalize the language 

you care about.  There is work enough for everyone, but there isn’t always much time. 
Remember that even small successes count – do something NOW!   
                             
OOOON BEING AN INDIGENOUS LANGUAN BEING AN INDIGENOUS LANGUAN BEING AN INDIGENOUS LANGUAN BEING AN INDIGENOUS LANGUAGGGGEEEE ADVOCATE ADVOCATE ADVOCATE ADVOCATE    
 

Language advocates transform the world by being proactive, by becoming involved, and 
by taking action. The role of the language advocate should never be underestimated and is the 
beginning point for all those who are engaged in Indigenous language revitalization. You are a 
language advocate if you have an interest in preserving and revitalizing an endangered language 
and are willing to talk about it or act on it. Being an advocate does not require specialized 
training but it does require commitment. The language advocate is committed to speaking up for 
the state and status of the language at every available opportunity—public or private. This 
means everything from talking to your family about the importance of revitalization to speaking 
to a public forum like a group of elders, a tribal council, the local school board, or a 
professional conference. It can also mean participating in classes, planning community meetings 
and doing the real hard work behind the scenes. 

You do not have to know a language to advocate for its revitalization, but it does help to 
understand both the historical and current context of a language. There are different types of 
language advocates. Internal language advocates are those who are community members and 
who are speakers or the descendants of speakers of specific Indigenous languages. There are 

Linguist bringing dormant Indian language to life:                                                                     
UA assistant professor has spent years working with tribe 

4/10/04 ARIZONA DAILY STAR  By Gerald M. Gay 
 

Natasha Warner has committed herself to bringing new life to a 
once-dormant language. For the past seven years, the assistant 
University of Arizona linguistics professor has dedicated her time 
to the Mutsun tribe of central coastal California - helping revive a 
dialect whose last fluent speaker died in 1930. 

She recalled a personal triumph she experienced last winter break 
on a visit to the Mutsun community, where she, her assistant Lynnika 
Butler and, Quirina Luna-Costillas, head of the Mutsun 
revitalization movement, made a small but important breakthrough. We 
were trying to work on getting to where we could speak the 
language," Warner said. "By the end of the week, the three of us 
were sitting around telling stories. There was a lot of hesitation 
and it wasn't fluent, but at least we were doing it! It means we are 
really on the brink of using the language productively." 

Warner has dabbled in other language projects but has no plans to 
leave the language she has grown to love. 

"This isn't something you do for a little while and just stop," 
she said. "This is the sort of project that tends to take up your 
whole life." 
 
http://www.dailystar.com/dailystar/accent/17419.php          
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also external language advocates. These people are outside the community but offer support in 
the form of networking for the needs and interests of Indigenous languages. Linguists, 
anthropologists, educators and politicians, for example, can all function as external language 
advocates—people who are in a position to speak to the concerns for particular community 
languages in very public forums outside of the community itself. For the most part, external 
language advocates can only do what the community authorizes and requests. Ultimately, the 
fate of any given Indigenous language rests with the community itself and the community’s 
vision for its preservation and practice.  

To be a good language advocate, internally or externally, it is helpful to know the facts 
about language endangerment related to the Indigenous language you support. Ask yourself, how 
many speakers are there? How many of these are truly fluent? How many semi-speakers are 
there? What does the community want for this language? Is it documentation and/or 
revitalization? Is there a council or committee of elders to guide concerns about language and 
culture? Is the local political structure supportive of language revitalization efforts? Where do the 
schools fit in?  And, this is just a beginning list of things to consider.  

The role of the language advocate is not always easy. Be prepared to face questions and 
comments like, “What’s the point of saving the language?”, “Who cares?”, “It’s too much 
work.”, “I don’t have time, besides there IS no point – its part of the past.”  Others may want 
to help, but do not know where to begin—the task seems overwhelming. Just don’t give up or 
give in. Find and build support inside and outside the community. Start a language preservation 
and revitalization group or program if there isn’t one. Be committed! 

Advocacy is born of passion for the cause of an endangered language and advocates need 
to be strong and clear in their convictions. Those closest to the language have many personal 
reasons for wanting to save it:  It is the language of their grandparents; the language of their 
own youth. It is the language that encodes all the philosophy and culture that their beliefs about 
the environment, medicine, art and kinship are based on. It is the language of their music and 
song. These reasons may resonate with members of the community but may be still hard for 
others to appreciate.  

Advocates also need to make others aware that the loss of even one language is a loss 
for all humanity. Each language represents a whole system of knowledge unlike any other.  
Leanne Hinton (2001:5) notes, 

 
The world stands to lose an important part of the sum of human knowledge 
whenever a language stops being used. Just as the human species is putting itself 
in danger through the destruction of species diversity, so might we be in danger 
from the destruction of the diversity of knowledge systems.  

 
In addition, Hinton points to the human rights issue saying,  
 

The loss of language is part of the oppression and disenfranchisement of 
Indigenous peoples…Indigenous efforts toward language maintenance or 
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revitalization are generally part of a larger effort to retain or regain their political 
autonomy, their land base or at least their own sense of identity. 
 

Advocate, whenever possible, for the right of all human beings to use, revitalize and preserve 
their own language! 

        
THE PLACE OF TECHNOLOGY IN LANGUAGE REVITALIZATIONTHE PLACE OF TECHNOLOGY IN LANGUAGE REVITALIZATIONTHE PLACE OF TECHNOLOGY IN LANGUAGE REVITALIZATIONTHE PLACE OF TECHNOLOGY IN LANGUAGE REVITALIZATION    
     
 Today, information and communication technologies are having a dramatic impact on 
Indigenous cultures.  There is a lot of talk these days specifically about the relationship between 
Indigenous languages and technology. We should remember that technology, whenever available, 
has always been brought to bear on linguistic work with Indigenous languages; this relationship 
is not new.  
 

    
 
Beginning in the 1880’s, the mass production of the Edison Wax Cylinder made it 

possible to record “live” speech.  The first attempts at live field recording by anthropologists 
and linguists took place in various speech communities beginning with the Passamaquoddy in 
1890.  Language archives such the Library of Congress, the University of California Berkeley, 
and other institutions house thousands of these early language-based wax cylinder recordings.   
 Technologically speaking, we have come a long way since 1890.  In fact, the 
contemporary situation is such that many endangered language communities are beginning to 
adopt advanced audio, video, and multimedia technologies as a means of revitalizing their 
languages.  Two general trends are observed in the use of technology for language revitalization:   
language teaching and language documentation.   
 Language teaching is described as the act of teaching a language learner to speak and 
understand an Indigenous or heritage language.  Incorporating technology into language teaching 
is often referred to as computer-assisted (or technology-enhanced) language learning.  The field 
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of computer-assisted language learning is a fast developing field due in part to continuing 
improvement and advances in technology.  Three general types of digital media are commonly 
employed in language teaching.  These are presentational software (e.g. Power Point), authoring 
multimedia software (e.g. Flash, Director, Authorware, Claymation), and web-based programs 
(e.g. HTML software, Javascript, MOO, WebCT).  The majority of these teaching tools are 
media driven in that they employ text, graphics, sound, and video in an interactive learning 
environment.   
 The field of language documentation is concerned with creating a documentary record of 
the linguistic practices of a speech community as well as creating a descriptive account of these 
practices.  Three types of digital media are typically employed for this purpose: general purpose 
tools (e.g. word processors, simple databases), specialized tools (e.g. advanced audio software, 
linguistic databases, multimedia, electronic dictionaries), and digital tools (e.g. CD-Rom, DVD, 
MPEG, image capture).  Media products that are generated from language documentation and 
description applications are often considered “authentic” materials and become the permanent 
resource of the endangered language community.  In several dramatic examples, the Rumsien 
Ohlone, Nooksack, and Mutsun speech communities are reviving their once extinct languages 
from “authentic” documentary materials such as early wax cylinders and other language media.     
 Here, we have defined technology broadly to include digital recorders, digital still and 
video cameras, and a host of supportive devices such as printers, scanners and copiers. We can 
also count as technology the huge body of software and Internet support that is filtered through 
a computer. These training materials focus on the use of computers in the development of 
multimedia language lessons. And, the concept of ‘multimedia’, by definition, is inclusive of 
several kinds of technology, notably cameras, recorders and computers.  It is the blending of 
these technologies, which allows for text, audio and video to meet in the construction of 
dynamic language lessons. When we add to that the available technology printers, scanners and 
copiers –and the ease of the production of materials is very impressive. 

To develop a model for beginning users of these technologies, we worked with the 
Colorado River Indian Tribes in testing the included materials and determining the best ways to 
introduce beginning users to the creation of vivid multimedia language lessons to support 
revitalization efforts. Once again, technology as defined by today’s standard, is being applied to 
Indigenous languages. Therefore, we can consider the work being done with these tools as just 
part of the historic continuum and strong tradition of Indigenous languages and technology.  
 
THE CRIT PROJECTTHE CRIT PROJECTTHE CRIT PROJECTTHE CRIT PROJECT    
 
 In 2003, the Bill and Melinda Gates Foundation funded a collaborative project between 
the Colorado River Indian Tribes (CRIT) and the University of Arizona. This project was part 
of the Gates “Native American Access to Technology” program initiated in 2000 with tribal 
libraries. The aim was to provide training for tribal members in technology (specifically the 
computer technology the Gates Foundation provided to tribal communities) and language 
documentation and revitalization. Moreover, this project was focused on two highly endangered 
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languages still spoken at CRIT, Mohave and Chemehuevi. A survey of these languages 
conducted at CRIT in 2001 determined that there were 42 fully fluent Mohave speakers and 
only 5 fully fluent Chemehuevi speakers. The fact that these languages both had orthographies 
with few diacritics made each language easily adaptable to a range of different software.  
 
 
 
 
 
 
 
 
 
 
 

Amelia Flores (Mohave) and Johnny Hill, Jr. (Chemehuevi) 

 
A major objective of this project was to work with tribal members who had little or no 

background in working with computers and to build a model for other communities based on 
what was learned. The materials generated here are, in large part, a reflection of what was 
applied during the CRIT project.  
 The participants learned to use the internet, to work with audio files and text material 
and to incorporate graphics into their lessons. They began with Microsoft WORD 2000 and 
Power Point and graduated to using MaxAuthor. Although we now recommend Audacity for the 
creation of sound files, the CRIT participants worked with CoolEdit. All of the participants were 
producing their own multimedia lessons within a few days of beginning their training. (For a 
sample of a Chemehuevi lesson using MaxAuthor, see www.cali.arizona.edu)  
 At the end of the project, all of the participants reported feeling much more confident 
and willing to keep trying new applications of technology. All were pleased at the final products 
of their efforts: complete multi-media language lessons! 
 
 
 
 
 
 
 
 
 
 
 

 

Comments from CRIT Participants: 

 

 “I am very happy that I had the opportunity to get to use a computer because it’s made me more aware of so much that 

can be done with our language. I am learning at a very fast rate….I can send an email, do my lessons, submit reports 

and keep in touch with ALL. …”     -Nora Vasquez, Chemehuevi 
 

“I’ve been working on the laptop and putting in the lessons we worked on last summer. I introduced this computer 

work to [tribal elders]. I told them that I would be using them for a resource. I’m getting more confident with 

computers!”       -Dorita Drennen, Mohave 
 

 “After training and returning back to the reservation, a lot of thought was put into what could be included in language 

lessons on the computer. Sharing of training was made with the library staff in the afternoons. ….On May 1
st
, I made 

my power point presentation at the Museum Association!”  -Amelia Flores, Mohave 
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One of the requests of this project was that participants use their new-found knowledge 
to train others. This aspect was realized in the last training session when two of the participants 
brought their daughters. This connection between generations is vital in all circumstances of 
working with language – technology included! 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Mother and daughter teams (left to right): Melissa and Dorita Drennen 
(Mohave), Brenda and Nora Vasquez (Chemehuevi). 

 
Working with the participants from CRIT helped us develop a model for using 

technology with Indigenous languages, which can be summarized as follows: 
 

1. To train those who are interested in true revitalization of languages in the forms of 
technology which are compatible with the accepted language-teaching strategies. The 
preferred choice in many communities today is “Immersion Language Teaching.” This 
method requires instruction only in the target language. Technology, particularly with the 
audio software available today, certainly can support this type of teaching. 

2. To develop materials modeled after the three elements of multimedia: text, audio and 
graphics. The marriage of these three elements in multimedia software supports 
immersion language teaching in unique and vivid ways. 

3. To offer training materials that can be either self-instructive or used to support a language 
class.  The content of these materials must always help the learner contextualize 
technology within the overall goals and process of language revitalization. 

4. To offer support, tools and strategies to learners from tribal communities while 
recognizing that the content of materials developed is entirely under their control as 
native speakers and/or members of the culture and community.  

5. To promote Indigenous language advocacy through the use of technology 
6. To be in service to the desires of the community regarding the place of technology in 

language revitalization efforts. For instance, in some places this means involving the 
public schools; in others, language work is strictly community controlled.  
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7. To foster a sense of cooperation between communities and resource institutions. 
8. To explore and test the most recent technological innovations in relation to what they 

might offer in the arena of language revitalization.  
 

The field of what we now call technology-enhanced language revitalization is still very 
new – an uncharted territory in many ways. As native speakers begin to take control of 
technology as a resource, the hope for Indigenous languages grows. Our model is one, which 
sets the tone for sharing knowledge, for respecting community members for their knowledge and 
determination, and for exploring all the potential technology brings. We thank the members of 
the Colorado River Indian Tribes for their insight, willingness to learn, and for helping us 
understand the needs of Indigenous people who are engaged in language revitalization. 
 
WWWWORKING WITH PEOPLE AND DATAORKING WITH PEOPLE AND DATAORKING WITH PEOPLE AND DATAORKING WITH PEOPLE AND DATA    
 
 Most of those who work with today’s Indigenous languages will find themselves working 
with community elders. These are usually the most fluent speakers of the language and their 
knowledge is always respected. In fact, the central thing to remember when working with elders 
is just that: R-E-S-P-E-C-T! Of course, respect may be defined somewhat differently in each 
community, but generally, here are a few guidelines for consideration when working with elders: 
 

� Be patient 
� Don’t interrupt 
� Be flexible – Not only when considering time in scheduling appointments or meetings 

but also consider that time in conversation may vary – pause time may be longer 
than expected. Don’t feel that you have to fill in the gaps. 

� Recognize their expertise 
� Don’t underestimate their knowledge or ability 
� Explain what you want to do very clearly  
� Explain what you intend to do with the work very clearly 
� Ask for permissions in writing 
� Respect time limits- stick to the agreed-on schedule 
� Direct eye contact isn’t often welcome (for most groups) 
� Food is almost always welcome! 

 
Working with Data 

 
Sources of Data 

 
 Data comes from lots of places: people, libraries, museums. When you are working with 
technology, which includes computers, cameras and recorders, the sources of data are very 
broad. Here are some basic steps: 
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� Look first to the elders to guide you in what is considered ‘authentic’ data.  
� Ask the elders for guidance as to what is culturally appropriate to present in a 

language lesson. 
� Seek out tribal sources first: a tribal library or museum: Be aware of copyright 

restrictions before using any materials. 
� See if there are any already published materials, which could be incorporated into 

language lessons. Be prepared to consider intellectual property rights and get written 
permissions for everything you collect from anyone! 

� Decide what level of language proficiency you are trying to document or reproduce. 
That is, be focused. 

� Remember cultural data supports language lessons so be open to using photos, 
artifacts, books, and other resources to support your language work. 

 
Types of Data 

 
 Linguistic data on Indigenous languages has long focused on the collection of word lists 
for forming dictionaries and grammars for sentence-level analysis. While these are certainly 
needed, they should be seen as a beginning of the kind of language data used for preservation 
and revitalization, not the end result. The scope of linguistic data should also include narratives 
and conversational data in the native language. In the creation of language lessons, think beyond 
a list of colors, numbers, or days of the week – think of useful daily language presented in full 
sentences and stories! Think about collecting language that supports daily use like ‘how to greet 
someone’, ‘how to apologize’, ‘how to make requests’, ‘how to leave – without saying 
goodbye’, ‘how to make commands’, ‘how to be polite when eating, visiting, or in the presence 
of elders’, ‘what to buy at the market’, ‘how to follow a recipe’, and more. The goal is to bring 
the languages out of the past and into the present. Language learners need to see practical uses 
for the Indigenous language in their every day lives. 

Once the data is collected and approved for use, you are ready to begin using it to 
support your language learning unit of study. 
    
CREATING A LANGUAGE LESSON CREATING A LANGUAGE LESSON CREATING A LANGUAGE LESSON CREATING A LANGUAGE LESSON     
    
    One thing about language learning that is true, whether you are using technology to 
support your teaching or not, is that language is best learned when the student is having fun.  
Using computers to support language learning can be fun, visually exciting and even offer an 
immersion experience in oral language. Many of the things you need to consider apply to any 
kind of language teaching. For instance,  
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What is your purpose?  
 

Of course the main purpose is to teach the language, but be clear about what aspects of 
language you are hoping to teach. For instance, are you going to teach vocabulary (numbers, 
animal names, foods)? Or are you going to teach sentences (focusing on verbs maybe)? Do you 
want your students to speak or write or both? Being clear about your purpose and goals dictates 
how you choose to structure your lesson. 

If you are working with technology, consider what relationship the techno-lesson has to 
other types of teaching that are taking place. Are you going to support a language class by 
having related lessons on the computer? Or is the computer going to be the only source of 
language learning? Maybe the computer lessons will just offer additional individual practice? 

 
Who is your audience?  
 

Know your audience! If you are working with children, learn about how children best 
learn language. Use oral language if they are very young. If you are working with adults, 
realize that they might enjoy written language, more structured kinds of learning. Think about 
what your audience needs, how they might best learn language, what they will be comfortable 
with and then build your lesson to meet their needs. Consider the following: 

 

�  Who will be using the lesson you are creating? 
�  Are they comfortable with computers? 
�  Do they have access to computers? 
�  How old are the people in your audience? 
�  Are they really fluent, partially fluent, or new learners of the language?  
�  What are their interests? 
�  How much do they know about your subject? 
�  What will they want to learn about your subject? 
�  What is a good way to reach the audience? 
�  Will they want to hear a story? 
�  Will they want to interact and talk into the computer? 
 

What are some ways of designing effective lessons? 
 

Designing lessons depends on how you identify your purpose and your audience first. It 
also depends on basic things like the physical place you might be teaching (the shape of the 
classroom, available chairs, types of computers, etc). It very much depends on any extra 
materials you might have available. It also depends on you and how you see yourself as a 
teacher.  

The most effective way to design lessons using computer technology is to enter the 
world of multimedia. You can then control the extent of oral and written language that is 



 18 

presented. You can make engaging visuals to keep students of any age involved in the language 
learning process. 
    
Language Lesson PlanningLanguage Lesson PlanningLanguage Lesson PlanningLanguage Lesson Planning    
    

 Language planning takes place on several levels: the community, the school, the 
classroom. Here, we will talk about specific language planning for the class you intend to teach. 

 Planning a classroom lesson is important because plans will help you organize your 
materials, help you keep track of the learners’ progress and give you confidence and direction. 
Most often, a single lesson is part of a larger unit. This is a good approach because it gives 
each lesson a context for the learner and it helps you build lessons that improve skill levels 
while keeping similar content. An important and unique feature of planning a language lesson is 
this fact: Cultural content AND the language skills being targeted for learning must both be 
reflected in the lesson plan.  For example, 

 
 
 
 
 
 
 
 
 
 

 
The Lesson PlanThe Lesson PlanThe Lesson PlanThe Lesson Plan    
 
A lesson plan outlines what you are going to do. The essential elements are: 

 

� Level: (beginning, middle, advanced language learners or computer users; grade 
school) 

� Time: (estimated length of the whole lesson) 
� Goals/Objectives: (what you hope to accomplish in just this lesson in terms of both 

general content and language skills) 
� Language skills: (what you are focusing on—listening, speaking, conversation, writing, 

and so forth.) 
� Organization: (Small groups?  Whole class?) 
� Activities:  

Beginning activity: warm up/ice breaker 
 Middle activity(s): core of lesson  
 Ending activity: brief review and practice 

UNIT: Plants 

THEME: Native Foods 

Language Skill:  

Words in Sentences 
Language Skill: 

Vocabulary 

Language Skill: 

Conversation 

Lesson 4: 

Requests 

Lesson 3: 

Commands 

Lesson 5: 
Common 

Phrases 

Lesson 6: 
Sample 
Dialogue 

 

Lesson 7: 
Sample 

Dialogue 

Lesson 2: Verbs 
(to eat, to drink, 
to cook, to buy…) 

 

Lesson 1: Nouns 
(types of food – 
meat, plant…)  
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� Methods and materials: If you want to include technology, specify what computers 
and what software you will be using. You will also want to address the level of 
technology your students are ready for. 

� Follow-up: (ideas for what the next lesson that will continue to build language skills) 
� Variations: (ideas for how to change the activities and still support the same goals. 

Here, using technology might be one variation on a lesson). 
� Standards: Some school districts may require a reference to how the lesson meets the 

state standards for language instruction. We recommend that teachers of Indigenous 
languages also include how the lesson meets instructional standards for heritage 
languages. 

 
 
 
 
 

    
    
    
    
    
 
 
Things to think about:  

 

� Timing: A lesson should be short, focused, and fun    
� A lesson should not be more than 10-20 minutes. This is true for adults as well as 

children.    
� Present new material in small pieces with LOTS of repetition.    
� Include some practice where the learners repeat the new material (individually and/or 

as a group)    
� For younger learners, use oral practice. Immersion methods work well.    
� For older learners, consider including writing exercises also.    
� Be patient – learning a new language (including computer languages) takes time – 

don’t force production    
� Plan time for questions and discussion    
� Choose subjects that are a part of daily life because they easier to practice    
� Keep it simple and short    
� Make lessons immediately useful    
� Use humor and stories    
� Include local culture and community for content    

 

Exercise 1: 
 
Write a response to this question:  In your opinion, what is different about 
constructing lessons which exclusively involve computer-assisted language 
instruction? 
_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________ 
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For lessons involving technology, all of the above apply, but consider emphasizing: 
 

� Using audio and video tapes for oral language support 
� Scanning in pictures and art from local sources 
� Making it interactive  

 
Always remember, for any lesson, to respect the learners, the teachers, and the languages. 
 
 
 
 
 
 

    
 
 
 
 
 

Cherokee People Work To Save Language 
Hundreds Of Adults, Children Studying Their Native Tongue 

                          
 Indeed, very few members of the Cherokee Nation speak their 
native language -- and even fewer know how it looks on paper. But 
Cherokee language teacher Harry Oosawhee said a new trend among the 
Cherokee people may change that statistic. "What we're trying to do 
is create an epidemic, so people will want to learn and share," he 
said. 
 At Lost City Elementary School in eastern Oklahoma, every student 
in the Cherokee language immersion class is learning to speak 
Cherokee --and English is not allowed while class is in session. 
 6-year-old Hawk said his mother and grandmother speak some 
Cherokee, but his father does not. When he leaves school, Hawk said, 
he becomes the teacher at home. "It makes me feel more Cherokee," he 
said. 
 
http://www.thehometownchannel.com/news/3316827/detail.html 
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Sample lesson plans from AILDI students: 

Title of lesson:            Haa’7sh2’ Din4k’ehj7 b4eso dab7zhi’ b7dahwiidiil’11[.  
                         ((((Lets learn the Navajo names for money denominatives)Lets learn the Navajo names for money denominatives)Lets learn the Navajo names for money denominatives)Lets learn the Navajo names for money denominatives)    
 

Submitted by : Benny Hale, Navajo high school teacherBenny Hale, Navajo high school teacherBenny Hale, Navajo high school teacherBenny Hale, Navajo high school teacher and AILDI student and AILDI student and AILDI student and AILDI student 

PurposePurposePurposePurpose    (“why” of the lesson, where and how does it fit into the course/curriculum)  
 

In speaking the Navajo language students will be able to count money and give correct change 

Learning outcome(s)Learning outcome(s)Learning outcome(s)Learning outcome(s) (what will students be able to do/know by the end of the lesson) 
  
Students will be able to say the Navajo words for coins, combination of coins and paper 
money. 
Students will be able to give back correct change while counting it.  

BridgeBridgeBridgeBridge----inininin (focus student attention)  
 

Names of money denominatives 2. Counting in Navajos 

PrePrePrePre----testtesttesttest (activate and diagnose prior knowledge)  
 

Knowledge of numbers 

Input from youInput from youInput from youInput from you (main content: ideas, 
information, concepts, principles, 
procedures and examples) 
 

Show from power point pictures of 
money denominatives. Repeat in 
sound the names of money 
denominatives.  
Show by power pointpower pointpower pointpower point how to count 
back change by picture and sound. 

Guided pracGuided pracGuided pracGuided practiceticeticetice (application of knowledge: classroom 
activities for students, problem to solve, etc.)  
 

1.  Students will be given coins and paper money and 
they will name them. Do this in pairs. 
2.  Students will be given items with prices and 
students will say in Navajo how much it costs. (in 
pairs)  
Student select a different partner and do the same as 1, 
2.  
Show the power point againShow the power point againShow the power point againShow the power point again for review. 

ClosureClosureClosureClosure (recap key concepts, helps students consolidate knowledge)  
 

Students will take their coins out and name the coins, bills. 
Students will count other student’s coins.  
Students will pretend that they sold something to someone and they will give money for 
payment and give correct change.   

Check for understandingCheck for understandingCheck for understandingCheck for understanding (what questions will you ask and when to determine students 
understand)  
 

Show from power point on screen coins, paper money and have students call them out loud.  

AssessmentAssessmentAssessmentAssessment (how does this lesson relate to assignments/homework/readings) 
(Standard for State Requirements and/or Indigenous Language teaching could be stated here) 
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This lesson plan was submitted by Kim Matheson, Coeur d’Alene. To support this 
lesson, Kim created a multimedia presentation in PowerPoint about counting apples 
____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________    
THEME:THEME:THEME:THEME:      “      “      “      “Counting”Counting”Counting”Counting”    
    
Learning Level:Learning Level:Learning Level:Learning Level:    Beginner (Pre-Literacy)    
Time:Time:Time:Time: 15 minutes 
Subject AreaSubject AreaSubject AreaSubject Area: Coeur d’Alene Language 
Related Subject Area:Related Subject Area:Related Subject Area:Related Subject Area:    Numbers, Kinship, Foods, Spatial     
    
Goal:Goal:Goal:Goal:    Students will be able to count to five and to use the names for relatives in Coeur 

d’Alene. 
 
Objectives:Objectives:Objectives:Objectives:        

1. Students will be able to count to five or more. 
2. Students will learn how to respond to k’winsh? (‘how many?’) with the correct 

number. 
3. Students will be able to name five or more relatives in Coeur d’Alene. 

____________________________________________________________________ 
    
Materials:Materials:Materials:Materials:  apples—real or artificial or pictures depicting various numbers of apples.  Pictures of 
family members.  Note: to distinguish whether the individual is on the maternal or paternal side 
of the family or whether a boy or girl is referenced, include two or three individuals—one 
representing the person speaking, one representing the maternal or paternal side of the family 
and one representing the individual named 

    
Background Information:Background Information:Background Information:Background Information:  The prefix hn- indicates the possessive pronoun my.  Before the 
letters k, s, t, d and other “dentals” the –n- changes to –i- and sometimes to –ii-.  Numbers 1-
10: nek’we’, esel, chi’łes, mus, tsil, tewshecht, tsunchtm, he’i’nm, qhaqh’nut, upen; epls (apple); 
relatives: nune’ (mother); pipe’ (father); tstsi’ye’ (girl’s younger sister); ‘yukwe’ (girl’s older 
sister); chi’yukwe’ (girl’s younger brother); qitsch (boy’s older brother); sintse’ (boy’s younger 
brother); sme’mulmkhw (boy’s younger sister); ‘yukwe’ (boy’s older sister); cheye’ (maternal 
grandmother--yeye’ child’s word); sile’ (maternal grandfather); qine’ (paternal grandmother); 
qhipe’ (paternal grandfather); t’upye’ (great grandparent); narye’ (great-great grandparent); tikwe’ 
(aunt—father’s sister); ’iqhwe’ (aunt—mother’s sister); puse’ (uncle—father’s brother); sisi’ 
(uncle—mother’s brother)  
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Activities: Activities: Activities: Activities:     
    

1. Students sit in a circle. 
2. Teacher recites the verse showing pictures of the relatives and modeling the actions.  

Place the apples in the middle of the circle so that they are techłu’ (over there) to 
everyone. 

3. Students echo the verse counting the items purchased.  
 

nek’we’ he epls techłu’nek’we’ he epls techłu’nek’we’ he epls techłu’nek’we’ he epls techłu’    
One apple over there 
uł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khwe hiinune’hiinune’hiinune’hiinune’    ((((e hntagwalpqwn)e hntagwalpqwn)e hntagwalpqwn)e hntagwalpqwn)    
Mother bought another one (at the grocery store)… 
esel he epls techłu’esel he epls techłu’esel he epls techłu’esel he epls techłu’ 
Two apples over there 
uł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khweuł nek’we’ tegwmintsut khwe hnpipe’hnpipe’hnpipe’hnpipe’ (e hntagwalpqwn) (e hntagwalpqwn) (e hntagwalpqwn) (e hntagwalpqwn) 
Daddy bought another one (at the grocery store)… 
chi’łes he epls techłu’chi’łes he epls techłu’chi’łes he epls techłu’chi’łes he epls techłu’ 
Three apples over there… 
 

4. Teacher adds up to five apples purchased 
5. To end the story the last line says:  
 

ekwn khwe ekwn khwe ekwn khwe ekwn khwe hiinune’hiinune’hiinune’hiinune’, hoy!  t’i’ tsi’!, hoy!  t’i’ tsi’!, hoy!  t’i’ tsi’!, hoy!  t’i’ tsi’!    
  Mother said, “Stop! That’s enough!” 
 
6. The second time through, pause before each line that says _he epls he epls he epls he epls techłutechłutechłutechłu’’’’                        

(____apples over there).  Point to the apples in the middle and ask k’winsh (how many)?  
When one of the students gives the correct number response, teacher nods in agreement 
and repeats the number adding it to the following sentence. 

7. The third time through give apples to students.  Motion five students to put an apple in 
the middle of the circle by saying they bought another apple.  (Note: in the next lesson 
plan students will be given paper coins to buy an apple before putting it in the center) 

 
Variations ofVariations ofVariations ofVariations of the game:  the game:  the game:  the game:     
    

1. Teacher leaves out vital words letting the students fill in the appropriate responses. 
2. Use different foods. 

 
Assessment:Assessment:Assessment:Assessment:  Students are able to successfully call out the correct name for the relative when 
the teacher shows the picture and stops to anticipate it in the verse. 
 
Standard(s):  Standard(s):  Standard(s):  Standard(s):  (to be added in by teachers) 
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EVALUATING WEBEVALUATING WEBEVALUATING WEBEVALUATING WEBSITESITESITESITESSSS    
 
 Indigenous communities are becoming increasingly visible on the World Wide 
Web. Among the many new sites are those that are devoted to discussions and displays 
of Native American languages. As a language teacher and language advocate, it is 
important to research these sites and to be able to evaluate their design and usefulness. 
As you begin to work with technology, you may well want to design your own 
materials for publishing on the web.  
 

1. Purpose and audience: What the site is about? What kind of information does it 
have? And who is it intended for? These questions should be visibly and verbally 
answered on the opening pages. 

2. Content: The most useful content is pushed toward the top of the site and is 
easy to locate. 

3. Site maps or table of contents give the user a visual schema into the site’s 
organization and context. 

4. Users have a choice of search interfaces, between simple and advanced, in order 
to support first time and repeat users. 

5. Examples of search technique and strategies, including the use of Boolean 
operators, are available so that users can learn how to maximize the power of 
the search interface. 

6. The scope of searchable collection is visibly identified and clearly described on 
the search interface page, helping users know where they are within the site. 

7. The scope of the searchable collection is visibly identified and described. 
8. The search results page is clearly organized and thoroughly presented so that 

selection decisions are easy and the users do not have to sort through redundant, 
vague and incomplete result links. 

9. Each page is clearly labeled with a header, date and source. 
10. Menu options are limited to five to seven choices. 
11. Links are underlined in blue for consistency and a phrase instead of a word is 

underlined so that users can recognize links and have more information on which 
to base a linking decision. 

12. Links have meaningful and obvious labels; abstraction is avoided so that users do 
not have to second-guess each link’s meaning. 

13. Alternative methods of navigation exist, including navigational bars at the bottom 
and top of the page so that users have increased control over interaction. 

14. Consistency exists throughout especially in layout, icons, terminology and 
placement of options and color. 



 25 

15. Graphics are kept at a minimum and appear only when they add valuable 
meaning to the content on the screen. In some language sites, however, the 
visual effect of the graphics adds to language learning and discussions – the 
purpose of the site dictates the use of graphics. 

16. Animation is used sparingly on descriptive pages so as not to distract users –but 
on language learning examples, animation is extremely effective. 

17. Downloading time for graphics is minimized by showing thumbnails, which can 
be enlarged. 

18. The ‘Alt Text’ tags give users the option to avoid images altogether but still 
know their meaning. 

19. Pages are laid out so that white space and barriers are at a minimum. 
20. Web writing is concise and objective, not promotional. 
21. Pages with text do not exceed two or three full screens. 
22. Users receive feedback about image size, loading time and processing time so 

they know whether the system is working. 
23. Users have the option to contact the webmaster with a ‘mail to’ function. 
 
This section was adapted from Alison J. Head. 1999.  “Design Wise: A guide for evaluating the 

interface design of information resources. New Jersey: Information Today, Inc.  
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EVALUATING CDEVALUATING CDEVALUATING CDEVALUATING CD----ROMSROMSROMSROMS    
 
 Many Indigenous communities who are involved in language revitalization efforts 
have prepared CD-ROMs to support language learning. If you decide to create your 
own CD-ROM or if you are selecting some to buy, consider the following list. Learning 
to evaluate existing materials is the first step in creating your own exceptional CDs!  
 

1. Users are presented with at least two interfaces, simple and advanced, insuring 
flexibility for users’ skill levels (beginner vs. expert) 

2. Consistency exists throughout the CD’s design in layout, terminology, color, 
placement and order of basic functions (print, search, help…) 

3. Menus are comprehensible so that users can make quick decisions. 
4. Each screen has a restart, quit and help buttons, which are highly visible. 
5. Prompts about ‘what to do next’ guide users through the interaction process. 
6. Searching features include Boolean, field searching, and proximity operators 

which support all levels of users’ skill….Search examples are included 
7. Retrieval aids, especially indexing and a thesaurus are included and are 

browsable. 
8. Feedback about users’ processing status, especially the number of records found 

so far and percentage to go during searching appears so the users know the 
system is working. 

9. Search histories can be saved for re-selection and editing to make more efficient 
use of processing time. 

10. Search terms are highlighted; users can jump to next context so that navigation 
and processing time are efficiently managed. 

11. Customizing options exist for output, download, print formats, font size, screen 
colors and record layout to meet users’ special needs. 

12. Menu bars include seven or fewer menu options per screen to limit clutter and 
help users absorb information. 

13. Color is used sparingly, making information easy to process. Screens are not 
cluttered and overlapping windows are kept to a minimum (six) so that users’ 
attention is visually managed for task support. 

14. Font style and size is readable and can be customized to meet the needs of users 
with disabilities. 

15. The help system is context-sensitive and concise, and offers step-by-step help so 
that beginning users can successfully interact with the system. 

16. Help is available throughout the program by pressing FT, a universal Dos 
standard for help. 
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17. Error messages are comprehensible so that users do not get stuck 
18. Tutorial is available at all times to help users learn the system at any point. 

 
This section was adapted from Alison J. Head. 1999.  “Design Wise: A guide for evaluating the 

interface design of information resources. New Jersey: Information Today, Inc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    

Recommended CD-ROMs 
 

 

“ Taitaduhaam: Western Mono Ways of Speaking.” 2002.  Paul 
 V. Kroskrity, Rosalie Bethel and Jennifer F. Reynolds. Norman: 

 University of Oklahoma Press. www.oupress.com. 

 

 

 “Tsi’ Thuwati’nikuhlalákhwa Ka’nihΛnáUUUUsa.” Where they take care 

 of them, the little ones. 2003. . 2003. . 2003. . 2003. An    interactive CD for Oneida 

 Language Learning. Oneida Nation Childcare. GreyFox CE.  
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ABOUT INTELLECTUAL PROPERTY RIGHTSABOUT INTELLECTUAL PROPERTY RIGHTSABOUT INTELLECTUAL PROPERTY RIGHTSABOUT INTELLECTUAL PROPERTY RIGHTS    
 
As you are about to begin developing your own materials, it is extremely important that 
you understand how to protect them. Copyright law is complicated but necessary. The 
Copyright Act of 1976 offers the ‘fair use’ of copyright protected works. This means 
that, although permission may not be required for use, credit must be given to the 
original author. Below we have summarized some of the key issues. This information is 
drawn from a paper by Leslie Barnhart (November, 2002) which was prepared for the 
Indigenous Language Institute (www.Indigenous-language.org - page numbers noted) 
 

� ‘Intellectual property’ implies that knowledge is subject to ownership. (3) 
� “Intellectual property has been defined as the transformation of ideas into 

tangible property.” (5) 
� Covers topics such as commercialization of traditional ‘folk art’, use of 

Indigenous peoples’ symbols or art as trademarks, patenting of Indigenous 
peoples’ ethnobotanical knowledge and traditional resources, and protection of 
linguistic diversity. (4) 

� Copyrights protect music, art, movies, writings, web pages, sound recordings 
and computer programs. (4) 

� In developing digital works, authors must be concerned with protecting their 
own creations but also with not infringing on other’s work (including anyone 
else’s work requires permission). (5) 

� Intellectual property laws require the identification of a specific original 
author. (3) 

� Copyrights are limited to an individual’s lifetime plus seventy years. (3) 
� Currently, there are no community rights to cultural knowledge.  
� Copyrights protect the author’s work by providing: the exclusive right to 

publish, distribute, and perform a work, the exclusive right to reproduce the 
work, the exclusive right to create new works based on the original. (5) 

� An author can transfer these rights in writing to another person or publisher 
for a period of time. (5) 

� Work does not need to be published to be protected by copyright. 
� Works do not need to be registered with the copyright office (below) to be 

protected, but it helps. (5) 
� Copyrights are administered by the U.X. Library of Congress Copyright 

Office (http://www.copyright.gov). Registration allows for a lawsuit under 
federal statute if a copyright is infringed. (5) 
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� Exemptions from copyright protections allow educational institutions, non-profit 
organizations, libraries, and others to use portions of a copyright protected 
work for non-commercial purposes. (6) 

� Once a work is produced in a digital form, it is very difficult to ensure its 
complete protection from copying or use by others. “…there is no such thing 
as total security on the internet.” (6) 

� For multimedia productions (such as CD-ROMs with photos, graphics or new 
articles and software applications to produce sound and animation) authors 
and publishers must obtain permission to use the materials they plan to 
incorporate. (10) 

� “Generally, the original author owns the ‘electronic rights’ to their work.” 
(10) 

 
The following sources are recommended:The following sources are recommended:The following sources are recommended:The following sources are recommended:    
 
For general legal information on intellectual property 

� www.findlaw.com  
 
For information on copyright administration: 

� www.copyright.gov 
 
For Tribal Law Intellectual Property Home Pate 

� http://world.std.com/~iipc/ 
 
For recommendations on gaining permission to use copyright protected works: 

� http://www.utsystem.edu/ogc/intellectualproperty/permissn.htm    
 (University of Texas) 

� http://www.k-state.edu/academicservices/intprop/howto.htm     
 (Kansas State University) 

� http://www.fplc.edu/tfield/copynet.htm        
 (Franklin Pierce Law Center) 

 
For information about online ‘Distance Education’ courses and copyrights: 

� http://www.groton.k12.ct.us/mts/pt2a13.htm 
 
For information about copyright protection for web pages: 

� http://lcweb.loc.gov/copyright/circs/circ66.pdf 
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Also see:Also see:Also see:Also see:    
 
Richard Stim.   Copyright Law. West Legal Studies, 2000. 
 
Mayer, Brown & Platt,  Corporate Primer for Intellectual Property. (1997). 

On website, www.mayerbrown.com. 
 

Steven Fishman. The Copyright Handbook: How to Protect & Use Written Works. 
 Nolo, 5th Ed. 2001.  See www.nolo.com 
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Rebirth of a language: Linguists,computer bring back 

nearly extinct Nooksack dialect 
 

DEMING, Wash. _ When Quentin Charlie first tried to speak his grandmother's 
language, the complicated, singsong words didn't come naturally. But he kept 
trying at the Nooksack Tribe's Upriver Halq'emeylem language classes. The 
language was nearly extinct 30 years ago, but Nooksack language specialist 
Catalina Renteria thinks Charlie and the rest of her students may be fluent by 
next fall, when they become the program's first graduating class. They'll be the 
first Native language students in the country to learn with an interactive 
computer program she adapted to Halq'emeylem. Roland Holterman, director of the 
Nooksack Education Department, called Renteria's project a breakthrough and said 
he envisions local school districts offering the classes for foreign-language 
credits soon. "We've taken a nearly extinct language and brought it back to 
life," Holterman said. "You can actually not speak a single word ... and in the 
matter of a year you can be totally fluent." Linguist Brent Galloway came to the 
Nooksack Tribe's 21/2-acre reservation near Deming, about 15 miles northeast of 
Bellingham, in 1974 -- a year after the United States officially recognized the 
tribe. Because the Nooksacks refused to sign the Treaty of Point Elliott in 
January 1855, the tribe was allotted no land and its members were ordered to move 
to the Lummi Reservation.  

But the Lummi and Nooksack people had little in common, except for their roots 
in what is now Whatcom County. Their languages were about as similar as German 
and English, Galloway said. So some Nooksacks settled in east Whatcom County and 
many others moved north to be with Halq'emeylem-speaking people of the Stolo 
Nation near Chilliwack, British Columbia. As time passed, the Nooksack's original 
language -- Lhechelesem -- withered away. The last fluent speaker, Sindick Jimmy, 
died in 1977.  

Galloway, now a professor at Saskatchewan Indian Federated College in Regina, 
Saskatchewan, said Nooksack elders told him they made a conscious choice to 
abandon Lhechelesem.  

"Since the language died that long ago, the elders that were left were 
speakers of Halq'emeylem," Galloway said. "So there was more hope they could 
bring it back." Halq'emeylem is one of 23 distinct Salish languages spoken by 
tribes from the Pacific Coast west to Montana and as far south as Tillamook, Ore. 
Upriver Halq'emeylem, the spoken language at Nooksack, is the only tonal language 
among them. Every vowel has three different tones that shift the meaning of the 
word.  

For the past year, Renteria and Marcus Goodson, a Nooksack language intern, 
have videotaped discussions in Halq'emeylem, written sentences and tests, and 
entered them into the computer language program. To demonstrate, Goodson opened a 
window on one of the computers, and the Halq'emeylem alphabet popped up on 
screen. Another window opened with a video of a man in a pink shirt. As the video 
played, the man mouthed the popped and guttural clicks of the coastal languages. 
Goodson echoed the words, speaking into a microphone, and the program played a 
recording of his pronunciation back-to-back with the man in the video.  

"You see it, you hear it, you say it," Goodson said.  
Tribal elders who grew up speaking the language are getting very 

old now – a problem shared by tribes around the country. For 
decades, their languages were forbidden at many white-operated 
schools, and tribal members began using English instead. "I would 
ask the elders in the 1970s, when I was working on the writing 
system, how technical should we be?" Galloway said. "And they said, 
write in all the tones because we may not be able to understand it 
now, but our grandchildren will go to college and they will 
understand it.       

"Sure enough, all the children use computers now." 
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PART IIPART IIPART IIPART II: : : : COMPUTER BASICSCOMPUTER BASICSCOMPUTER BASICSCOMPUTER BASICS    

 
    
THE COMPUTERTHE COMPUTERTHE COMPUTERTHE COMPUTER    
 
The world of computers is exciting and ever expanding. Real beginners often enter this 
world with trepidation. Our goal is to make this transition painless. In this section, we 
will introduce the basic parts of the computer. Learning the language of computers is 
the first step towards understanding how they work and what they can provide. Always 
remember that our goal is to acquaint beginners with the most basic knowledge, which 
will enable them to support Indigenous languages with technology.  Expanded 
definitions of technical terms can be found in the glossary at the end of this manual. 
 
HardwareHardwareHardwareHardware        
    
Hardware is any part of the computer you can physically touch. 
 
The computer consists of five main components: 

a) The Central Processing Unit (CPU) 
b) The monitor 
c) The mouse 
d) The keyboard 
e) The speakers 
 

 

a) 
b) 

c) d) 

e) 

Language choice is part of the 
right of Indigenous peoples to 
their own land, to autonomy, and 
to cultural and economic self-
determination.  
 
Hinton and Hale, The Green Book.(4) 
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The Central Processing Unit (CPU) 
 
You can think of the computer as being similar to a car. The ‘CPU’, otherwise known 
as the ‘box’ or ‘tower’, functions as the engine. It drives the computer. The CPU 
contains the operating systems for the computer. This includes the hard drive, 
connecting points for hardware like the keyboard, mouse, phone lines, microphones, 
connections for speakers and special ports for software like CD-ROMs or floppy disks 
and more.  
 
 
 
 

Back 

 

On the front of the CPU, you 
will see a port for a floppy disk, 
the access ports for CD-ROMs 
and the Power button. 

On the back of the CPU, there are 
the connecting points for hooking 
the monitor, keyboard, mouse, 
printer/scanner and phone lines to 
the computer. 

 

Front 
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The Monitor 
    
 The monitor is the display screen for the work you are doing on the computer. 
Think of it as the dashboard – the place where everything you need to know for your 
immediate job is displayed.  On the front, you will see an on/off button and other 
buttons, which allow for adjustments of contrast and brightness and sometimes more 
detailed changes. 
  
There are two types of monitors available today: traditional and flat screen 
 

Traditional 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Flat Screen 
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Points to ponder when buying a monitor: 

 
 The flat screen monitors will soon replace the 
older models because of special benefits. Monitors are 
evaluated based on their size, which is measured 
diagonally across the screen, like a TV.  The most 
popular size is usually a 17” monitor. Dot Pitch is the 
distance between each pixel (dot) on the screen--the 
more dots, the sharper the image.  You want to buy 
one with a .28 mm or less dot ratio. The refresh rate 
determines how quickly the monitor updates the image on the screen – higher rates are 
therefore better. The best have a refresh rate of 72 Hz (hertz = the number of times 
per second the monitor redraws the entire screen) or better.  
 Screen savers appear on the monitor when your computer is on but you haven’t 
used it for awhile. They were designed to prevent phosphor burn on early computers; 
now, phosphor burn is not usually a problem for newer monitors, but most people still 
enjoy have a screen saver.  
 

 
                                                                                             
 
    
    
    
    
    
    

 

The Mouse 
 

 The mouse is similar to a steering wheel – It steers you to the 
place you need to go on the monitor. It is an input device, which lets you 
‘talk’ to your computer. You can also use the keyboard sometimes in the 
same way, but once you get used to the Mouse, most people find it 
easier. The mouse is a hand control, which allows you to move and point 
the cursor    ––––    the blinking item on your screen.  The cursor is a place-marker, which 
you move by manipulating the mouse. As you hold the mouse and move your hand, an 
arrow will appear on the monitor and you can point it to the functions you wish to 
employ.  

Tribal Rebirth 
4/6/03 Stephen Magagnini - Bee Staff Writer - San Diego County 
 
At the Pechanga reservation pre-school, Indian boys and girls 

sing "Ten Little Monkeys Jumping on the Bed" in a language that's 
10,000 years old. Native languages die off yearly in the Americas, 
but the Pechanga Band of Luiseno Indians -- born again with casino 
profits -- is breathing life into Luiseno, a language on the brink 
of extinction. Preschoolers speak nothing but Luiseno in school. 
   
http://www.sacbee.com/content/news/projects/nations_within/story/640
8828p-7360908c.html 
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 The mouse has several controls, which will give you 
different options.  Users simply have to learn to ‘point and 
click’ –meaning choose a target for the arrow and then left 
click on the mouse to enter the program or to move items on 
the screen.  
 When you point the arrow to the menu item you want, 
you can then choose to make a right clickright clickright clickright click or a left clickleft clickleft clickleft click on 
the mouse. It is very important to understand how the mouse 
works and to know what the difference is between  ‘right’ 
click and  ‘left’ click functions.  

Using the mouse just takes practice! 
 

    

The Keyboard 
 
 
 
 
 
 
 
 
 

 The keyboard is another avenue you use to communicate with your computer. 
The keyboard functions primarily like a typewriter, but also contains lots of hidden 
functions.  Many of the functions you can achieve with the mouse can also be done 
through the keyboard.  Below is a short list of some main keyboard functions: 

 

 

Example from a single 
right click on a 

program icon 
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Special Keys Description and Functions 

AAAAltltltlt 

 

The ‘Alt’ key doesn’t work alone – it needs other keys to make 
things happen.  For instance, press the ‘Tab’ key while holding 
down the ‘Alt’ key causes the computer to switch between 
programs that are currently running. 

CCCCtrltrltrltrl    

    

The ‘Ctrl’ (control) key also work with other keys – If you press 
the ‘X’ key while holding down the ‘Ctrl’ key, you will cut 
whatever you have selected.  You can then press ‘Ctrl’ and ‘V’ 
and paste the material in a new location. 

F1F1F1F1    

 

The ‘F1’ key is the HELP key – if you press it, it will give you 
some help with whatever you are working on. 

EEEEscscscsc    

    

The ‘Esc’ (Escape) key allows you to change your mind – and 
escape or cancel what you are doing. 

EnterEnterEnterEnter    

    

The ‘Enter’ key is your command function – It tells the 
computer that it is OK to go ahead with whatever you have 
asked it to do 

TabTabTabTab    

    

The ‘Tab’ key works two ways: 1) just like on a typewriter, it 
jumps to the nearest tab stop you have set and 2) if you are in 
a dialog box (or online order form), it moves the cursor to the 
next field. 

Arrow keysArrow keysArrow keysArrow keys 

    

These move the cursor across the screen in the directions 
indicated 

DeleteDeleteDeleteDelete    

    

You can guess what this does – it erases what you tell it to 
erase (that is, anything you have selected) 

BackspaceBackspaceBackspaceBackspace    

    

This key erases anything to the left of where you are typing. 
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Page UPage UPage UPage Up/Page Downp/Page Downp/Page Downp/Page Down    

    

These keys move the entire view of the page up or down 
one screen. 

Home/End 

    

The ‘Home‘ key jumps to the beginning of the text line 
you are working on and the ‘End’ key, moves the cursor to 
the end of the text line you are working on. 

ShiftShiftShiftShift    

    

As on any word processor or typewriter, this allows you to 
make capital letters. 

Caps LockCaps LockCaps LockCaps Lock    

    

This key types all the letters as capital letters, without 
having to hold the ‘Shift’ key down. 

 

 
The goal of a language program must 
depend on the situation in which the 
language finds itself. 

 
Hinton and Hale, The Green Book. (5) 
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The Speakers and Microphones 
 

 Speakers are important to understand for the purpose of working with oral 
language on your computer. New computers have sound capability built into the 
motherboard; older computers relied on a sound card, which plugged into the 
motherboard. You will need to connect a pair of speakers or a set of headphones to 
your computer if you want to hear sound.  
 The sound capability on your computer (whether it uses a sound card or not) 
allows for two things:  it plays and records digital sounds.  When you are working 
with languages, you can either enter the sound directly using a microphone, in which 
case the sound can be saved on the computer as a digital sound file, or you can import 
(enter) sound from an outside source such as an older cassette tape. You have some 
choices about how to digitize older tapes (see section on digitization below).  
 Sound ports (or jacks) are sometimes confusing because they all look similar. 
The following table should help: 

 

 
 

    
    
    
    
    

    
 

 

Port or Jack Description 

Speaker  

The place to connect your speakers or headphones. 

Microphone  

Connection for a microphone to record sounds or to use 
speech recognition software. 

Line Out  

This lets you listen to your computer through your home 
stereo system. 

Line In  

You can record a cassette audio CD or radio by plugging 
in a stereo system into this port (jack). 

Exercise 1: 
1. Study the main components of your computer  

2. Identify, open and close the ports on the front of the ‘CPU’ 
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OOOOther Hardware to Knowther Hardware to Knowther Hardware to Knowther Hardware to Know    
 

Modem 
    
 Virtually every new computer has a built-in internal modem. A modem translates 
computer information into audio tones so that it can be transmitted over phone lines to 
other modems.  Modems can be internal or external. 
 Internal modems are cheaper than external modems and usually come built into 
the computer. 
 External modems plug into the computer’s serial port. New broadband modems 
usually plug into the USB or Ethernet port. These are different than traditional, older 
modems in that they transmit information directly, without having to convert it into 
audio tones, and are therefore much faster. The most common types of broadband 
connections are DSL or Cable.   
 

Hard Drive 

 
 The hard drive    is the computer’s main storage area. This is hidden in the CPU – 
you can’t see it but you can usually hear it running when you start the computer. 
External hard drives are also available and normally plug into a USB port. Think of the 
hard drive as a giant file cabinet with all the files neatly saved in folders. The main 
hard drive is labeled ‘C’ on your computer (so when someone refers to the ‘C’ drive, 
which is where most information is stored and saved). Other hard drives are labeled ‘D’ 
and ‘E’ – these support the storage of additional information if needed and connect to 
information provided for the computer on CD’s. The ‘A’ hard drive is designated for 
floppy disks.  Modern hard drives can store anywhere from 20 GB to 250 GB (GB = 
Gigabytes) – which is simply a HUGE amount of information.  
 

Floppy Drive 
    

Most desktop computers have a floppy drive, though many 
laptops have dropped them. The floppy drive is labeled as the 
‘A’ drive on most computers. The floppy drive reads the 3 ½ -
inch floppy disks (which aren’t really soft or floppy!). These 
store much less information than a CD, but are still useful for 
transferring and storing small documents. Though they will soon 
be considered relics of the past, they are really cheap and easy 
to use and transport. 
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CD-ROM Drive 

    
The CD-ROM drive is usually labeled as the ‘D’ drive on most computers.  Uses for a 
CD-ROM drive include: 

1) Installing new programs: new program software frequently comes in the form of 
a CD-ROM because of the large storage 
capacity. 

2) Running CD-ROM programs:  CD-ROMs offer 
high quality, multimedia content including music, 
videos and animation. They are easily searchable 
and offer     vivid displays. 

3) Playing audio CD’s: Just like using your home 
stereo, your computer’s CD-ROM drive will play 
you latest, favorite CD while you work! 
 

                                  
CD-ROMS 

    
 CD-ROM    (Compact Disk-Read Only Memory), are played through the CD-ROM 
drive and holds a lot of information. Those you want to play, the same as you play in 
your home stereo, are ‘read only’ – you can not re-record on these. Others, known as 
CD-R (Compact Disc Recordable) and/or CD-RWs (Compact Disc Re-Writable) can be 
written on or burned, as the terminology goes. These are the most important to learn to 
use for the purposes of working with Indigenous languages. Once the native language 
information is ‘burned’ onto a CD-RW, then it can be permanently produced as a CD-
ROM, which can’t be written over. 
 
Remember: 
 CDCDCDCD----ROMROMROMROM:::: Read only, no new information can be added. 
 CDCDCDCD----RRRR:::: New information can be written or burned, but it is permanent and can’t 
  be changed or erased. 
 CDCDCDCD----RWRWRWRW:::: Can be written to many times and can be modified and erased if you 
  choose to do so. 
 

DVD Drive 

    
Newer computers contain DVD (Digital Versatile Disk)(Digital Versatile Disk)(Digital Versatile Disk)(Digital Versatile Disk) Drives. A DVD can hold as 
much as seven times the information of a CD-ROM. Like CD-ROMs these come with 

Top view of an opened 

CD-Rom Drive 
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options for read-only (DVD-ROM), DVD-R (Recordable) and DVD-RW (Re-Writable) 
which you can use if you have a DVD-ROM drive on your computer.  
 
 

 
 
 
 
 
 
    
    
    
    
    
    
    
    

    
SoftwareSoftwareSoftwareSoftware    

 
 Software refers to anything that instructs the hardware how to operate or 
perform. There are two very basic types: operating systems, like Windows XP or 
Windows 2000 and application systems, like Excel or PowerPoint, which have very 
specific tasks to do.  New software comes out periodically and it is sometimes hard to 
keep up with the latest version. Whether you use a PC or a Macintosh, today most 
software is compatible with both. The software that we have found to be most helpful 
for work with languages includes: Microsoft Word, PowerPoint, FrontPage and Adobe 
Photoshop. For work with sound files, we support the use of Audacity, a free download 
from the internet. There are many sophisticated software products, which are worth 
exploring as your skills with computers increase.  We will be discussing specific 
additional software which supports work with language in Part IV. We will also discuss 
how to save files independent of specific software programs so that you will not lose 
data when switching computers or when updating your own system. 
    
    
    
    

Yet more technology for Indigenous languages…Big databases 
By Tom Nugent, Special to the Tribune/ October 12, 2003. 

 
EAST LANSING, Mich. -- Drop by Professor Helen Roy's Native 

American linguistics class at Michigan State University … and you'll 
probably find her drilling a dozen students on difficult-to-
pronounce words such as bmijigoe. "I'm teaching a language, but I'm 
also teaching a way of life," Roy said. "If we lose the [Ojibwe] 
language, the danger is that we'll also lose the culture to which it 
belongs. I don't think anyone one wants that to happen, and that's 
why we work so hard in class every day.” As a Native American, she 
is engaged in a passionate struggle to save her tribal language, a 
Michigan version of the Algonquin-family language, Ojibwe, from 
vanishing within the next few decades. But teachers such as Roy face 
an uphill battle, said Wayne State University linguistics expert 
Anthony Aristar, who is directing efforts to build a nationwide, $2 
million database aimed in part at preserving dying languages. 
Aristar and other researchers say that at least half of America's 
200 remaining native languages will vanish within the next century.                                                                                                                                                                                 
 
http://www.chicagotribune.com/news/nationworld/ 
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The Desk Top 
 
 The desktop is the window, which appears as you open a Windows program. 
The desktop screen has the main items that dictate how the computer will operate or 
perform at the user’s discretion. The icons and text indicate what software is available. 
The user just needs to learn to ‘point and click’ on whatever is needed to put the 
computer to work. On very old computers, the information was text only. Today, 
pictures (images are known as icons or graphical user    interfaces) are displayed for users 
to ‘point and click’ on to open a window or program. 

 

     
                                                                                                                        f)f)f)f)    

    
 
The bottom of the desktop screen:    

    

                                                                    
    

 
    
    
    
    
    
    

a) My computera) My computera) My computera) My computer    
    

b) Arrow or pointerb) Arrow or pointerb) Arrow or pointerb) Arrow or pointer    
        

c) Foldersc) Foldersc) Foldersc) Folders    
    

d) Recycle Bind) Recycle Bind) Recycle Bind) Recycle Bin    
    

e) Start Menue) Start Menue) Start Menue) Start Menu    
    

f) Items at bottom rightf) Items at bottom rightf) Items at bottom rightf) Items at bottom right 

a)a)a)a)    

 
 

 
 

c)c)c)c)    
 

 
 

 
 

 
d)d)d)d)    

 
 

 
e)        e)        e)        e)        

b) 

Internet    Outlook  QuickTime Volume   Mouse    Printer Clock 

Explorer   Express  
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Programs 
    
 If you would like to know what software is installed in your computer, left click 
on the ‘Start‘Start‘Start‘Start’ menu and then click on ‘ProgramsProgramsProgramsPrograms’. You can then select the program you 
want and right click, at this point, choosing ‘Open’‘Open’‘Open’‘Open’ to enter the program.    
    

 
 
 
 
 
 
 
 
 
 
 
                                                                                                                            
    
    

    
    
    
    
    
    
    
    
    
    
    
    

Exercise 2 

1. Explore the desktop – and do the following: 
 
� Point and click on the ‘Start’ button and study what programs are on the 

computer you are using. 
� Point to a program and open it  
� Close the program by pointing and clicking on the ‘File’ menu--, scroll 

down to ‘Exit’ or ‘Close’… and click. Some items do not contain a ‘File’ 
menu – in this case, close the window by clicking on the ‘X’ in the upper 
right hand corner of the window. 

� Try opening and closing other programs 
� Optional: Try moving icons around on the desk top by clicking on and then 

dragging the icon. 

 

Programs 

Open 
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Exercise 3 
  

� Point and click on the ‘My Computer’ icon on the 
desktop or on the ‘Programs’ menu.  

� Study the features included here. 
� Experiment with opening and closing some of the 

icons. 
� Open the ‘Display’ icon on the ‘control panel’. Here 

you can control the picture chosen for your desktop 
or for the change any settings.  

� Choose a screen saver  
 

Exercise 4 
 

You can choose to either right or left click on the ‘Program’ menu. When you ‘left’ click, 
you access the list of available programs; when you ‘right’ click, you have a different, but 
very useful set of options. Try this… 
� Right click on ‘Program’ menu 
� Point and click on ‘explore’:  This will show you all the items contained in the 

program  you are looking at. As you begin to work more with your computer, you will 
find that this is a  very useful way to see and organize the materials in your files. 
Items displayed here can be  moved from one side of the screen to the other, or shifted 

within the same window.  

Technology is a tool 
 

The term ‘technology’ can refer to a computer, a video camera, a digital or tape recorder. 
The goals for using technology will differ with each community’s situation and technology 
can be used in conjunction with other community language revitalization efforts.  
     ___________________________________________ 
     

     How will you use technology in your community? 
   _____________________________________ 
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PART IIIPART IIIPART IIIPART III: : : : DEVELOPING MULTIDEVELOPING MULTIDEVELOPING MULTIDEVELOPING MULTI----MEDIA LANGUAGE LESSONSMEDIA LANGUAGE LESSONSMEDIA LANGUAGE LESSONSMEDIA LANGUAGE LESSONS    

    
 

 
     
 
 
 

  
 
 

 
This section is devoted to a discussion of the programs beginning users need to 

know in order to create effective multimedia language lessons.  Each section addresses 
only those parts of the computer programs, which lend themselves to the presentation of 
language work for teaching, learning or documenting indigenous languages.  The 
computer software we will include are the Internet, creating your own email using 
‘Hotmail’, Microsoft Word 2000, Audacity, Adobe PhotoShop, PowerPoint, MaxAuthor, 
FrontPage and CD creation software. Some of these may not be on tribal library 
computers but are recommended for use with indigenous languages. Each of the 
programs presented have multiple uses. Our focus is on how these software programs 
can support language revitalization; additional tutorials are recommended in Part IV.  
 
MEET THE WORLD WIDE WEB!MEET THE WORLD WIDE WEB!MEET THE WORLD WIDE WEB!MEET THE WORLD WIDE WEB!    

    
Learning to use the World Wide Web (WWW), also called the Internet, opens up 

unlimited possibilities for sharing and enhancing work with indigenous languages. Many 
tribal communities offer web pages for their communities and their languages. These 
web pages illustrate everything from dictionaries to multimedia interactive language 
lessons. The Internet offers you the opportunity to view what others have done and to 
share your own work. We will focus on four things: 

  
1. Knowing the Language: CyberSpeak1 
2. Internet Safety & URL Resources 
3. Hoaxes, Etiquette & File Extensions   

                                                 
1
 http://www.ftc.gov/bcp/conline/pubs/online/sitesee.htm#CYBERSPACE#CYBERSPACE 

“I think that an important human purpose is the fullest use of the mind 
in creating intellectual wealth or products of intellectual labor. An 
enabling condition for this is linguistic and cultural diversity, since it is 
that condition above all others that permits the exploration of the widest 
range of paths of creation…thus, the loss of a language is a certain 
tragedy for the human purpose, not just locally but the human purpose 
in general.  And the loss of a language, if it can be prevented, must be 
prevented.” 

 
Dr. Ken Hale, speaking to a congressional committee in support of the  

Native American Languages Act  in 1992.  (Arnold 47). 
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4. Establishing a personal email account 

CyberSpeak CyberSpeak CyberSpeak CyberSpeak ––––    Learning the LanguageLearning the LanguageLearning the LanguageLearning the Language    

You don't have to be a computer expert to book a trip into Cyberspace, but it certainly 
helps to know a few words of cyber-speak. Before long, you'll sound like a native and 
get around like an experienced traveler. 
 
BOOKMARKBOOKMARKBOOKMARKBOOKMARK – an online function that lets you access your favorite web sites quickly.  
 
BROWSERBROWSERBROWSERBROWSER – special software that allows you to navigate several areas of the Internet 
and view a web site. 
  
BULLETIN BOARD/NEWSGROUPBULLETIN BOARD/NEWSGROUPBULLETIN BOARD/NEWSGROUPBULLETIN BOARD/NEWSGROUP – places to leave an electronic message or share 
news that anyone can read and respond to. Marketers or others can get your e-mail 
address from bulletin boards and newsgroups. 
 
CHAT ROOMCHAT ROOMCHAT ROOMCHAT ROOM – a place for people to converse online by typing messages to each 
other. (Once you're in a chat room, others can contact you by e-mail. Some online 
services monitor their chat rooms and encourage children to report offensive chatter. 
Some allow parents to deny access to chat rooms altogether.). 
 
CHATTINGCHATTINGCHATTINGCHATTING – a way for a group of people to converse online in real-time by typing 
messages to each other. 
 
COOKIECOOKIECOOKIECOOKIE – when you visit a site, a notation may be fed to a file " known as a 
"cookie" in your computer for future reference. If you revisit the site, the "cookie" file 
allows the web site to identify you as a "return" guest — and offer you products 
tailored to your interests or tastes. You can set your online preferences to limit or let 
you know about "cookies" that a web site places on your computer. 
 
CYBERSPACECYBERSPACECYBERSPACECYBERSPACE – another name for the Internet. 
 
DOWNLOADDOWNLOADDOWNLOADDOWNLOAD – the transfer of files or software from a remote computer to your 
computer. 
 
EEEE----MAILMAILMAILMAIL – computer-to-computer messages between one or more individuals via the 
Internet. 
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FILTERFILTERFILTERFILTER – software you can buy that lets you block access to web sites and content 
that you may find unsuitable. 
 
INTERNETINTERNETINTERNETINTERNET – the universal network that allows computers to talk to other computers in 
words, text, graphics, and sound, anywhere in the world. 
 
ISPISPISPISP (Internet Service Provider) – a service that allows you to connect to the Internet. 
When you sign up (it takes special software and a modem), you'll be asked to enter a 
screen name, a secret password and your credit card number. Usually, online charges 
are billed to your credit card. Most providers allow you to review your monthly 
expenses online instead of sending you a separate itemized bill. If you note unexpected 
charges from your ISP, call for an explanation. If you're not satisfied with the 
explanation, or think you may be the victim of fraud, write a letter to your credit card 
company and your state Attorney General. 
 
JUNK EJUNK EJUNK EJUNK E----MAILMAILMAILMAIL – unsolicited commercial e-mail; also known as "spam." Usually junk e-
mail doesn't contain the recipient's address on the "To" line. Instead, the addressee is a 
made-up name, such as "friend@public.com." Or the address on the "To" line is identical 
to the one on the "From' line. 
 
KEYWORDKEYWORDKEYWORDKEYWORD – a word you enter into a search engine to begin the search for specific 
information or web sites. 
 
LINKSLINKSLINKSLINKS – highlighted words on a web site that allow you to connect to other parts of 
the same web site or to other web sites.  
 
LISTSERVLISTSERVLISTSERVLISTSERV – an online mailing list that allows individuals or organizations to send e-
mail to groups of people at one time.  
 
MODEMMODEMMODEMMODEM – an internal or external device that connects your computer to a phone line 
and, if you wish, to a company that can link you to the Internet. 
 
ONLINE SERVICEONLINE SERVICEONLINE SERVICEONLINE SERVICE – an ISP with added information, entertainment and shopping 
features. 
 
PASSWORDPASSWORDPASSWORDPASSWORD – a personal code that you use to access your account with your ISP.  
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POPUPSPOPUPSPOPUPSPOPUPS – advertisements which are like commercials that will direct you away from 
the site. Pop-up ads are a form of online advertising on the World Wide Web intended 
to increase web traffic or capture email addresses. It works when certain web sites open 
a new web browser window to display advertisements. 
    
PRIVACY POLICYPRIVACY POLICYPRIVACY POLICYPRIVACY POLICY – a statement on a web site describing what information about you 
is collected by the site, and how it is used. Ideally, the policy is posted prominently 
and offers you options about the use of your personal information. These options are 
called opt-in and opt-out. An opt-in choice means the web site won't use your 
information unless you specifically say it's okay. An opt-out choice means the web site 
can use the information unless you specifically direct it not to. 
 
SCREEN NAMESCREEN NAMESCREEN NAMESCREEN NAME – the name you call yourself when you communicate online. You may 
want to abbreviate your name or make up a name. Your ISP may allow you to use 
several screen names. 
 
SEARCH ENGINESEARCH ENGINESEARCH ENGINESEARCH ENGINE – a function that lets you search for information and web sites. 
Using a search engine is like accessing the main card file in a library, only easier. A 
few keywords can lead you almost anywhere on the Internet. You can find search 
engines or a search function on many web sites. 
 
URLURLURLURL (Uniform Resource Locator) – the address that lets you locate a particular site. 
For example, http://www.ftc.gov is the URL for the Federal Trade Commission. All 
government URLs end in .gov. Non-profit organizations and trade associations end in 
.org. For example, http://www.naag.org is the URL for the National Association of 
Attorneys General. Commercial companies now end in .com, although additional suffixes 
or domains may be used as the number of businesses on the Internet grows. Other 
countries use different endings. 
 
VIRUSVIRUSVIRUSVIRUS – a file maliciously planted in your computer that can damage files and disrupt 
your system. 
 
WEB SITEWEB SITEWEB SITEWEB SITE – An Internet destination where you can look at and retrieve data. All the 
web sites in the world, linked together, make up the World Wide Web or the "Web."  
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ActivityActivityActivityActivity 1 1 1 1: Internet Safety & URL Resources. : Internet Safety & URL Resources. : Internet Safety & URL Resources. : Internet Safety & URL Resources.     
 
Getting to know Internet Explorer. Dou Dou Dou Double Clickble Clickble Clickble Click on the Internet Explorer on the Internet Explorer on the Internet Explorer on the Internet Explorer icon  icon  icon  icon 
on the screen. on the screen. on the screen. on the screen. This will open the Internet Browser and will connect to the 
World Wide Web.    
    

Uniform Resource Locator (URL)Uniform Resource Locator (URL)Uniform Resource Locator (URL)Uniform Resource Locator (URL)    
    The address of a Web page allows people to find a page on the Internet. A Web 

page address is called a URL; that is an acronym that stands for uniform 
resource locator. 

    
In the Address, type In the Address, type In the Address, type In the Address, type http://pbskids.org/license/http://pbskids.org/license/http://pbskids.org/license/http://pbskids.org/license/  this is also called an URL Address  this is also called an URL Address  this is also called an URL Address  this is also called an URL Address. . . .     

  
Hit the enter key on the keyboard, located on the right side or use the mouse 

and click on the green arrow that is next to GO at the end of the Address box.     

You’ll be getting your Web License. You’ll be getting your Web License. You’ll be getting your Web License. You’ll be getting your Web License. This is designed for kids, but adults need to 
know this information too and monitor internet usage for their children. Just like 
visiting a new city there are places one needs to be aware of.    

Address 
box 

  

First thing we learn about 
navigating the internet is to 
READ all the screen. As you 
get more familiar with the 
internet, your navigation skills 
will increase. For this activity, 
you’ll enter in your name and 
learn some basic safety rules.  
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These rules are for my safetysafetysafetysafety. I will honor them when I go onlineonlineonlineonline. 

� I can go online at ________ (time of day) for _________ (how long?) 
� It's ___ OK ___ not OK for me to go online without a parent. 
� I understand which sites I can visit and which ones are off limits. 
� I won't give out information about myself or my family without permission 

from my parents. 
� My password is my secret. I won't give it to anyone.  
� I will never agree to meet an online pal, or send my picture, without 

permission from my parents.  
� I know an advertisement when I see one. I also know that animated or 

cartoon characters aren't real and may be trying to sell me something or to 
get information from me. 

� I will follow these same rules when I am at home, in school, or at the 
library or a friend's.  

 
Now youNow youNow youNow you are ready  are ready  are ready  are ready to use a search to use a search to use a search to use a search 
engine! engine! engine! engine! Type in one of the following 
Addresses 
 

� www.google.com  
� www.yahoo.com 
� www.msn.com 

 
Using the search engine, type in “your 
tribe’s name”.   
 

� What do you see?  
� Do you agree with the information? 

 
Add another keyword “language” to your search inquiry. 
 

� Is the information the same 
 
Type in your name. 
 

� Are you on the World Wide Web? 
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Most search engines have advertisments and the first listed web page could be 
there because the company paid for that spot. Google lables the paid sites as 
“Sponsored Links” and are located in a column to the right of the web page. 

    
    

    
    
    
    
    
    
    
    
    
    
 

Activity 3Activity 3Activity 3Activity 3: Hoaxes, Etiquette & File Extensions: Hoaxes, Etiquette & File Extensions: Hoaxes, Etiquette & File Extensions: Hoaxes, Etiquette & File Extensions    
 
 Before we sign up for an Email account we need to learn some 
etiquette and common hoaxes that come with email. In this activity we will 
also learn about file extensions. 

 We’ll use the Google 
Search Engine. Type 
“google.com” in the Address 
box. In the Google Keyword 
box type “hoaxes”.  
    
    
    
    
    
    
    
    
    
    

Activity 2: Book Mark your Favorite Sites. Activity 2: Book Mark your Favorite Sites. Activity 2: Book Mark your Favorite Sites. Activity 2: Book Mark your Favorite Sites.     
 

Go to the toolbar click on Favorites and then click on Add to Favorites. 
 

•••• Explore the Internet by visiting the following sites: 

- Cree for Kids: http://www.creeforkids.ca/frontintro.htm 

- Kumeyaay Site: http://www.kumeyaay.org/ 

- Indigenous Languages and Technology: 

http://www.u.arizona.edu/~cashcash/ILAT.html 

- Sealask Heritage Institute: http://www.sealaskaheritage.org/flash/my_house.swf 

- The Tulalip Tribes: http://www.tttculturalresources.org 

- Technology-Enhanced Language Revitalization: 

http://projects.ltc.arizona.edu/gates/TELR.html 

� Hit the Google 
Search bar. 

� Click on the link 
HOAXBUSTERS 

� Read: What Are 
Internet Hoaxes 
and Chain 

Letters? 
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Now use the search engine to type in the keywords: “email etiquette”. Read the 
links and click on one. Reliable sites usually have an file extension of .edu or gov.  
 
Tell Tale signs: File Extensions on URL addresseTell Tale signs: File Extensions on URL addresseTell Tale signs: File Extensions on URL addresseTell Tale signs: File Extensions on URL addressessss    
    
 These File Extensions are the tale end of the home of a URL address. They tell 
us if the hosting site is supported 
 

� .gov 
� .com 
� .net 
� .us 

 
 

Can you think of more? 
 

� Go Here to learn more:   http://www.skeeterbytes.com/glossary1.htm  
� Or use your new skills and keyword in a search engine “file extensions 

glossary”. 
 
    

    
    
    
    
    
    
    
    

    
    
    
    

Activity 4Activity 4Activity 4Activity 4: Establishing a personal email account: Establishing a personal email account: Establishing a personal email account: Establishing a personal email account    
    
 Email is a way to connect with people in remote areas, exchange research, share 
information, and create cultural exchanges between people globally. In this section we 

Never 

divulge your 

user name 

or password 

to others. 
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will learn about Email Etiquette, Email Attachments, File Extensions and sign up for 
your own email account. 
 
Email EtiquetteEmail EtiquetteEmail EtiquetteEmail Etiquette    
    

� Immediately delete email with attachments from senders you do not 
recognize. It is most likely "spam". Do not click open web links in messages 
from unknown sources.    

� Never run an executable file (e.g., .exe) from an email. The university has 
security precautions in place for most of these situations, but computer 
hackers are getting more sophisticated all the time.    

� Do not forward personal email without the author's knowledge and permission    
� Do not forward chain letters. Delete them.    
� Keep acronyms to a minimum. They can be confusing to your readers.    
� Delete unwanted messages to conserve space.    
� Never answer "spam". Your response will confirm your email address. Delete 

the message instead.    
 

Tell Tale signs: File Extensions on attachmentsTell Tale signs: File Extensions on attachmentsTell Tale signs: File Extensions on attachmentsTell Tale signs: File Extensions on attachments    
    
    Be cautiousBe cautiousBe cautiousBe cautious when opening any attachment, especially if you don’t know who the 
sender is. Attachments and images can inform the sender that an email address is good 
and that you opened it. With a little knowledge about what the file is you can see if 
you can read/open the attachment that your friends and family sends you. The next 
exercise will be a short quiz to test what you might already know! 
 
File extensions can tell us what software program we need to view a file such as: 
 

� Adobe Photo Shop *.psd 
� Adobe Acrobat *._____2 
� *.jpeg or *.jpg 
� *.gif 

 
Which file extension opens an image file? _____3 
 
 
 

                                                 
2
 *.pdf 

3
 Adobe Photo Shop, *.psd 
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Which file extension opens a sound file?  
 

� *.avi _____4 
� *.mp3 _____5 

 
 Do not worry if you are not familiar with the file extensions, this is just to 
increase your awareness of file types. For the most part, the computer will find the 
correct program to open your attachments.  
 
Techie skills:Techie skills:Techie skills:Techie skills:    
    
 These are what us 
nerds call, “keyboard 
shortcuts”. They are 
designed to be used 
when the mouse is not 
convenient for you. 
Remember there are 
many ways to navigate a 
computer. Your input tools (input tools are ways to interact with the computer) are the 
mouse and the keyboard. You can also set up a computer for verbal commands which 
assists people with vision problems or Star Trek fans.  
 

    
    
    

    
    
    
    
    
    
    
    

                                                 
4
 Audio Video Interleave  

5
 audio 

Expand Your Techie Skills: 
 
Windows Keyboard Shortcuts 

� CTRL+Z: Undo  
� CTRL+C: Copy 
� CTRL+V: Paste 
� F1: Help 
� CTRL+ESC: Open Start menu 
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ESTABLISHING AN EMAIL ACCOUNTESTABLISHING AN EMAIL ACCOUNTESTABLISHING AN EMAIL ACCOUNTESTABLISHING AN EMAIL ACCOUNT    
    
    We will use the search engine, www.yahoo.com, to create your own email 
account in ‘Yahoo’. Follow these steps: 

 

1. Double-click on the Internet Explorer icon. 
2. Type www.yahoo.com in the dialogue box and you will get the following screen. 
3. Click on ‘Mail’, (follow the arrow!) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click on  ‘Sign up!” 
5. This is the page that will open each time you log in to Yahoo! Mail…only the 

next time, you will need to use your Yahoo ID and password to ‘Sign In’… 
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6. On this screen, fill in the required information:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7. At the bottom 

of that screen, 
click on “I 
agree”….  

 
 
 
 
 
 
 
 

 
8. The next screen welcomes you to 

Yahoo! Mail…. If you want to read 
your mail, click on ‘Inbox’ on the 
left of the screen. To create an 
email, click on ‘Compose’.  
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9. Type and Send a message to someone (the address below won’t work  ☺) 
 

     
  
 

That’s it! You are ready to join the world of email!! 
 

 
 

 
 
 

 
Important Email Addresses: 
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________    
 
 
 
 
 
 

    
    

    

“To never hold any book of his language: 

    the grammar a thesis, never published, 

      the words still slips, not a dictionary…  

 

        Dell Hymes, In Vain I tried to tell you. (210) 

 

Exercise 1: Compose a Message 

 

Give it a try: 

Compose a message and send it to a friend  

Copy it to yourself! (Put your own address under the line marked as Cc:) 
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MICROSOFT WORD 2003MICROSOFT WORD 2003MICROSOFT WORD 2003MICROSOFT WORD 2003    
 
This program, Microsoft Word, is the most widely used document-producing 

program for PC’s.  For the purposes of working with language, you can use Word to 
write a language using special symbols found in the Unicode chart, you can create 
lessons and include pictures, you can write dictionaries or word lists, you can publish 
these documents to a web page and you can make your own language-advocate 
newsletter using a Word template!  In short, you can create any document you need to 
support your efforts toward language instruction or documentation.   
    
Step 1: Open Microsoft WordStep 1: Open Microsoft WordStep 1: Open Microsoft WordStep 1: Open Microsoft Word    
                                                                                                                                

� Click the START menu 
� Click on Programs      
� Scroll to Microsoft Word and click 
 

 
 
 
 
 
 
 
 
 
 
 

Main  
Tool Bar 
 
Format  
Tool Bar 
 
 
 
 
 
 
 
Drawing  
Tool Bar 
 
Page  
Status 
 

Minimize 
Maximize 
Close 
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Main Tool Bar in MSWord:Main Tool Bar in MSWord:Main Tool Bar in MSWord:Main Tool Bar in MSWord: 
 
 
 

 
 
 
 

    
    
Format Tool Bar:Format Tool Bar:Format Tool Bar:Format Tool Bar:    
    
    

    
    
    
    
    
Let’s begin to write!Let’s begin to write!Let’s begin to write!Let’s begin to write!        
    
    
    
    
    
    
    
    
    
    
    

    
    
    
    
    
    
    

Exercise 1: Saving 

� Open Microsoft Word from the Start Menu  (you may have an icon already on 
the desk top).  

� Select ‘Start’, left click on ‘Programs’ and then left click on ‘Microsoft Word’ 

� Point and click on the ‘new document’ icon  when the Word window is open. 
(Note: You can also click on ‘File’ and then ‘New’.) 

� Type in some text of your own on the new blank document 
� Click on the disk icon to ‘Save’  
� Locate the box at the top of the 

window marked “Save in.”  
� Click the small arrow on the right 

to bring down the menu of choices.   
� Give the document a name by 

typing in the ‘File Name’ box then 
click ‘Save’. 

 
                                                File  
     Type 

New   Open   Save              Print  Print        Spell                        Undo    Redo    Insert    Tables           Drawing  Document   Zoom     Help 

                                                      Preview  Check                      Typing               Hyperlink                                   Map 

                              Format                              Insert 
Cut   Copy  Paste  Painter                              Tables  Columns        Show/Hide 

      Styles                    Font                 Font      Bold   Italic  Underline         Line Spacing      Indenting 

                                                            Size                                                                             

                         Font 
    Text Alignments   Numbering   Bullets      Borders   Color 
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• If you do not like the changes or made a mistakeIf you do not like the changes or made a mistakeIf you do not like the changes or made a mistakeIf you do not like the changes or made a mistake, , , , go to ‘Edit’ and click on the 
first menu item, “UndoUndoUndoUndo”. Or, you can also click (illustrate).    
    
    

    
    
    
    
    

Exercise 3: More Formatting 

 
� Highlight one question from Exercise 4 by: 

- placing the cursor at the end of the question,  
- left clicking and holding the button while you drag  

the cursor over the question 
- release the mouse button when you have highlighted 

the entire question 
� Experiment with the format toolbar:   

- ‘B’ – bold, ‘I’ – italic and ‘U’ – underline 

 
- Fonts allow you to change the style of type 

- You can also change the font size 
� Save your changes 

Exercise 2: Formatting 
 

� Open a new word document   
� Study the ‘format’ tool bar by moving the cursor over the 

different icons.    
� Click on the ‘Format’ menu and scroll down to 

‘Background’ 
� Choose a background color for your document 
� Type in several questions you would like to raise about 

language revitalization! 
� Save your document 

 

Exercise 1: continued 
 
Look for ‘Save as Type’:  
� For language work especially for those of you working with languages which 

have varied symbols, click on the small arrow on the right hand side of this box 
and then click on ‘Rich Text Format’ (RTF file) – this will save your work so that it 
is easily transferable to other formats. 

� For English documents, simply saving as a ‘Word Document’ is ok for most use.  
You might also consider the value of saving as a ‘plain text’ document which will 
make your text readable for the HTML files used on web pages. 

 

 

    

BE FEARLESS!BE FEARLESS!BE FEARLESS!BE FEARLESS!    

    

If you do not like the If you do not like the If you do not like the If you do not like the 

changes or made a mistake, changes or made a mistake, changes or made a mistake, changes or made a mistake, 

go to ‘Edit’ and click on the go to ‘Edit’ and click on the go to ‘Edit’ and click on the go to ‘Edit’ and click on the 

first menu item, “Undo”. Or, first menu item, “Undo”. Or, first menu item, “Undo”. Or, first menu item, “Undo”. Or, 

you can also click on the you can also click on the you can also click on the you can also click on the 

undo iconundo iconundo iconundo icon    
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Writing Your Language with Microsoft Word 

   
 Microsoft Word is quickly becoming one of the 
most widely used word processing programs today.  
However, as many of you are well aware, representing an 
indigenous language in a word document still remains a 
daunting challenge.  
Why is this?  A common fact is that most indigenous languages in the Americas 
possess their own unique set of sounds that often require a unique set of characters to 
represent them.  This is coupled with the fact that “font” makers, or those people who 
make character sets for others, simply do not take into account the character needs of 
small minority languages.    
 

UNICODEUNICODEUNICODEUNICODE    
 

 This is where “Unicode” comes in.   
 Unicode is a system of encoding that allows the representation of a language in a 
Word document.  For example, take a look below at the following two letters.  
 

 [^]  [Ł] 
 

 These two characters are common in many indigenous languages of the 
Northwest Coast and interior, however, they are very unfamiliar and hard to find in any 
font set that may be contained in a word processing program.   
 Thus, Unicode is a system of encoding that provides the ability to “encode” the 
characters of the world’s languages.  What this means for many indigenous languages is 
that the possibility exists that Unicode will have some, most, or all of the characters 
needed to represent the full spectrum of sounds and how they are represented in a text 
document.   
 

"Immerse yourself totally in your own language and you'll get culture 

as a byproduct, ….The soul and culture of a people are reflected in 

their language." 

(Calvin Fast Wolf, Sioux language teacher at Stanford University, quoted in Sioux 

language at Stanford by Lyn Dearborn (lyn@anchor.esd.sgi.com) Wed, 3 Mar 1993 12:11:07 -0800) 
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Unicode in Microsoft WordUnicode in Microsoft WordUnicode in Microsoft WordUnicode in Microsoft Word    
 
 Unicode is usually present in Microsoft Word in at least the two following 
“fonts.” 

� Arial Unicode MS  
� Lucid Sans Unicode  

 
 The means of accessing these “fonts” is pretty straight forward.  Give it a try.   
 
Step OneStep OneStep OneStep One    
 

� Open Microsoft Word and a new document.  From 
the “Insert” menu select “Symbol.” 

� Once this is done, a menu will appear like the one 
below.   

 

      
  
Step TwoStep TwoStep TwoStep Two    
 
 Now search to see if “Arial Unicode MS” or “Lucid Sans Unicode” is listed.  If 
they are, choose Arial Unicode MS to start with.  Once you have selected Arial 
Unicode MS, a full range of characters will appear.  On the right side scroll bar, scroll 
down to see what is contained in this set of characters.         
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Step ThreeStep ThreeStep ThreeStep Three    
 
 Once, you have found a desirable “character,” just click on it (it will enlarge and 
be highlighted in blue) and then click the “Insert” button to enter it into your Word 
document.  That’s it!  So every time you need a special character just repeat the above 
steps. 
 
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

    
 
 Another choice for working with fonts for indigenous languages is the use of 
Navajo Fonts described below by Gilbert Brown (Navajo) Ph.D. student at the 
University of Arizona. 

    
Using NaUsing NaUsing NaUsing Navajo Fontsvajo Fontsvajo Fontsvajo Fonts    
    
 The Navajo font is from Chinle Unified School District’s #24 for PC users only. 
The font is free and downloads by the following the instruction after the ‘log on’ to the 
Chinle School District’s web address: http://www.chinleusd.k12.az.us/NavajoTR. 
 The Chinle School District is located in the central part of the Navajo Nation 
near Canyon De Chelly National Monument. The park has many cultural connections, 
and attracts visitors locally and nationally.  Chinle School District has seven schools and 
4000+ students and is the largest school district in the Navajo Nation. Chinle School 

 
Exercise 4: Unicode      
 

Haa’7sh2’ Din4k’ehj7 b4eso dab7zhi’ b7dahwiidiil’11[.Haa’7sh2’ Din4k’ehj7 b4eso dab7zhi’ b7dahwiidiil’11[.Haa’7sh2’ Din4k’ehj7 b4eso dab7zhi’ b7dahwiidiil’11[.Haa’7sh2’ Din4k’ehj7 b4eso dab7zhi’ b7dahwiidiil’11[.    
 

� Open a new Word document 

� Try typing a word in your native language—are 

special symbols needed? 

� Click on ‘Insert’  

� Click on ‘Symbol’ on the drop-down menu 

� Explore this window: Try different fonts to access a 

different range of symbols. 

� Click on the symbol you want and then on ‘Insert’ 

at the bottom of the window, to add the symbol to 

your word. 
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District supports and encourages Navajo language maintenance and their students take 
Navajo language and culture. One of the primary goals of the district is to increase the 
Navajo language and culture into all curriculum areas of their school district.  
 To download Chinle Navajo font, go to their web site listed below, find the 
Navajo Font button for PCs, and follow the instructions. 
http://www.chinleusd.k12.az.us/NavajoTR 
 It is recommended that if you do not have a directory named "downloads", you 
create one on your drive when you down load this file, then use it for future 
downloads as well. Download Navajo Font File for Windows to "Downloads” directory"Downloads” directory"Downloads” directory"Downloads” directory.  

Click on the left window to return to the drive where you want to make a 
download directory. Use the middle icon on the right to create a new directory.  

Select this directory as where you want to put the downloaded font file.        
Once the file has downloaded, then do the following steps to install it.     

1. Go to StartGo to StartGo to StartGo to Start    
2. Control Panel Control Panel Control Panel Control Panel     
3. FILEFILEFILEFILE (Pull Down Menu, Upper Left)  
4. INSTALL NEW FONT INSTALL NEW FONT INSTALL NEW FONT INSTALL NEW FONT     
5. Select FontSelect FontSelect FontSelect Font by using the windows to select the disk and directory where you 

downloaded the font. The name of the Navajo Font should appear in the upper 
window when you find the correct directory.  

6. Click on the font nameClick on the font nameClick on the font nameClick on the font name to highlight it.  
7. Make sure the option "Copy Fonts to Font Folder""Copy Fonts to Font Folder""Copy Fonts to Font Folder""Copy Fonts to Font Folder" at bottom of page is checked.  
8. Click on OK Click on OK Click on OK Click on OK     
9. When installed, close all Windows!When installed, close all Windows!When installed, close all Windows!When installed, close all Windows!    
10. To use the Navajo Font, go into a word processing application and select the 

Navajo Times Roman Font and the type size. Begin typing in Navajo! 

 
 
 
 
 
 
 

Adding Graphics To Your Language Lesson! 
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There are a number of ways to add graphics (pictures or drawings) to your 
documents. The exercises below will include how to add graphics using the drawing 
tool bar and how to import graphics from web-based sources. We will also explore how 
to create boxes for text or graphics within a document. You can include your own 
artwork later by scanning it into your computer and then importing it into your 
documents.  Let’s go! 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
                                                                                                                                                                                                                                                    
 
 
 
 
 
 
 
 

 
Exercise 5: The Drawing Toolbar 
 

� Open a new document  
� If the drawing toolbar is not on your screen  

- click on ‘View’ 
- scroll down to ‘Toolbars’ 
- click on ‘Drawing’   

� Explore the drawing toolbar by clicking on each icon 

 

    

    

Click on ‘AutoShapeClick on ‘AutoShapeClick on ‘AutoShapeClick on ‘AutoShapes’ s’ s’ s’ 
for extended choices on for extended choices on for extended choices on for extended choices on 
the drawing tool bar.the drawing tool bar.the drawing tool bar.the drawing tool bar.    
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Exercise 6: Importing a Picture 
 

� Open a new document  
� Create a text box using the drawing menu: 

- Click on the ‘Text Box’ icon  on the 
Drawing Tool Bar, or click on ‘Insert’ 
on the main formatting menu and 
then ‘text box’.   

- Place your cursor where you want 
the image to be 

- Left click and hold the button down 
while you move your mouse over the 
screen – make the box as small or 
as large as you want 

- Release the button and the text box 
should appear 

• Insert Word Art – Put the cursor inside the text box, click, and type a word in 
your language.  Highlight the word and click on the ‘Word Art’ icon       . You can 
now choose from a variety of different word art styles.  

• Select a style then click ‘OK’ 

• Type in your own text on this window 

                     

 
    

    

    

    

    

    

    

 

    

Insert Clip Art 
 

� Put your cursor inside the text box again and click on the ‘Clip Art’ icon.  
� You can now search for various types of clip art. You can even look online for 

many more images. 
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“How are you?” (Mohave) 

 

 

Exercise 7:  More Clip Art from the Web…                                     

� Open Internet ‘Explorer’ from the desktop 
� Type www.msn.com or www.google.com  
� Type in ‘Clip Art Images’ and search. 
� Search for an image (drawing or picture) of your choice 
� Select the picture by clicking on it.  
 

- For the copy/paste menu, right click on the mouse 
- On the ‘File’ menu, click ‘Save As’ and put your picture into 

your own ‘Folder’ titled ‘ (your name) pictures’. Or, if you 
want to copy something directly from the Web into your 
document, and not save it in a picture file, you can ‘right 
click’ –Choose ‘Copy’  

 
� Return cursor to your WORD document and ‘Paste’ the picture in 

Create a borderCreate a borderCreate a borderCreate a border – While your cursor is inside the text box, click on the ‘Line 

Style’ icon      and choose the size of your border.  You can also choose a 

color for your border by clicking on the ‘Line Color’ icon         . By clicking 

on the small arrow to the right of this icon, you can access many more 

border colors. 
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Exercise 8: Scan in your own pictures! 
 

� Set up the picture in the scanner 
� On the ‘Insert’ menu, click on ‘Picture’ 
� Then, click on ‘From Scanner’ 
� Choose ‘Web Quality’ if you want to publish your 

document on the Web (this lowers the resolution- 
needed for online sources) 

� Choose ‘Print Quality’ if you want to publish your 
document in a hard copy printed version (this 
allows for higher resolution). 

� Edit your picture using Adobe Photoshop if 
needed 

 

Exercise 9: Inserting a picture into a document 
 

� Open a new Word document and type a sentence or two about a picture you would like 
to use. 

� Click the cursor on the place, within the document, where you would like the picture to 
be. 

� Point to ‘Picture’ and click ‘ From File’ on the ‘Insert’ menu 
� Locate the picture you want 
� Double-click on the picture to insert it. 

 

 

Let us put our minds together and see what  

kind of life we can make for our children. 
 

---Sitting Bull (Oglala Sioux Chief, 1834-1890)--- 
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    Inserting hyperlinksInserting hyperlinksInserting hyperlinksInserting hyperlinks    into a document. You can use the same process. If you want 
to send a Word document as an email attachment or publish it on a Web page, you can 
insert links into the document so the reader can ‘click’ on them and connect to the 
Web site directly. 

 

          

            

 

    

          

    
    
    
    
    
    
    
    
    
    
                                
    
    
    
    
    
    
    
    
    

Exercise 10: Inserting Hyperlinks into Word documents  
    

� Click Insert > Hyperlink  on the Standard toolbar.   

� Under Link to File or URL, click Browse. 
� Double-click on the file you want to link to and click ‘OK’. 
� When the ‘Save As’ HTML dialog box appears,  
� Type a name in the ‘File Name’ box and then click Save. Note that the text is now 

underlined, showing that it is a hyperlink. 
� Move your pointer over the hyperlink. When the hand appears, click to go to the linked 

document. 
  

 
       

 



 71 

Using MSWordUsing MSWordUsing MSWordUsing MSWord Dictionary functions with Native Languages Dictionary functions with Native Languages Dictionary functions with Native Languages Dictionary functions with Native Languages    

    
 
 
    

 
 
 
 
  
 
 
 
 
 

Remember, Microsoft Word is the most widely used text creation and editing 
software.  Built into MSWord are many functions to assist with the creation of accurate 
documents.  Among these features is the Spelling and Grammar checkingSpelling and Grammar checkingSpelling and Grammar checkingSpelling and Grammar checking function.  It 
can be accessed under the ‘Tools’ drop down menu from the MSWord toolbar. We will 
show here how to enable the MSWord spell check dictionary to recognize native 
language terms.  This will only work if the native language being targeted is written 
using a standard alphabet, without extra diacritics.   
 When using the Spell checker, words that are not in the dictionary provided by 
MSWord will be shown in a popup window and will be as illustrated below.  
Suggestions for correct spelling of the term are given in a window at the bottom of the 
popup. If the correct choice is in the Suggestions, it can be highlighted and the Change 
button on the right side of the popup will replace the incorrect with the correct 
spelling. 
 To the right of the popup, there is 
also a choice of ‘Add to Dictionary’.  
This function is one way to create the 
ability of MSWord to include Native 
Language terms in the spell check 
dictionary.  When the option is chosen 
when using spell check, the highlighted 
word is added to the ‘custom’ dictionary 
in MSWord.   
    

“What is the word for dog in Mohawk?’ 

E-rar. It is the sound of a dog’s bark 

“What is the root of the word?” 

The sound of the bark is the root.  

“What do you think of the word dog?” 

Woof, woof! 

“Is there a word for coyote in Mohawk?” 

Not that I know of, so I’ll make one up: 

        Ko-ko-ko-io-ti 
 

Okwehonweronon, Kaienwaktatsie “Ko-ko-ko-io-ti” in Coyote’s Journal. 

  



 72 

    There are two possibilities:There are two possibilities:There are two possibilities:There are two possibilities:    
    

1.     

    

    

    

    

    

    

    

    

    

    

    

2.     

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    
    
    
    

    

 

Have a vision not clouded by fear.  
 

                           --Cherokee Proverb-- 

 

Exercise 11 

 
� With the spell check window open, click on the ‘options’ button.  On the 

screen that appears, there will be a drop down window labeled ‘custom 
dictionaries’.  The default custom dictionary is titled CUSTOM.DIC.  
When the ‘Add’ choice is made with the spell checker, the highlighted 
term is added to the CUSTOM.DIC dictionary file.   

� To create a native dictionary for spell checking in MSWord, run the spell 
checker and click on the ‘Add’ option for each term. (While this method 
will work, it could be time consuming if the number of terms is large.) 

Exercise 12 
 
� Create a text file containing all the native terms  
� Import it into the MSWord spell checker, any number of native terms 

could be included using this method. The first and hardest part of this is 
to collect the terms to be used, taking into consideration that the spelling 
that is used for these terms will be considered the correct spelling by 
MSWord.  

� Open Notepad to create the text file that will be used. 
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 If the terms are already in electronic format 
they should be copied into a Notepad file.  If they 
are not in electronic format but only in print, they 
can be scanned and Optical Character Recognition 
(OCR) software can be used to convert the text to an 
electronic format.  
 
            
NOW TRY THIS!NOW TRY THIS!NOW TRY THIS!NOW TRY THIS!                         

                                 
   
                                                            

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Exercise 15: 
         
� Open ‘notepad’      
� Create a list of words as in the above example. Notice that the file is named 

Mojave.dic.  The file must have the ‘.dic’ file name. 
� Save it to the folder where the installation of MSWord has stored the CUSTOM.DIC 

file.  (To find out where this is, go the ‘options’ area of the spell checker and click on 
‘dictionaries’. )  

� Click on ‘Add’ from this window.   
� Click on the down arrow to locate the file path where the CUSOM.DIC file is stored. 

(Figure 3 shows that in our installation the file is stored on a folder called ‘Proof’ that 
is five folders in from the root folder. The location may vary with installation of 
MSWord.  Make a note of the exact folder location for your installation.)  

� With the location of the folder noted, save the Notepad file with the .DIC extension 
to this folder.   

� From MSWord, return to the spell check options area, choose dictionaries, 
� Chose ‘Add’ and click on the .DIC file that you created.  
� Click on ‘OK’. The .dic file should now be in the “Custom Dictionary” window. 
� Make sure that the box next to the new file is checked. Click on OK.  
 

The custom dictionary is now active in the spell check for MSWord 
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AUDIO ELEMENTS IN LAAUDIO ELEMENTS IN LAAUDIO ELEMENTS IN LAAUDIO ELEMENTS IN LANGUAGE REVITALIZATIONGUAGE REVITALIZATIONGUAGE REVITALIZATIONGUAGE REVITALIZATIONNNN    

    
The Basics of SoundThe Basics of SoundThe Basics of SoundThe Basics of Sound    
 
 We are immersed in a world of sound.  What our ears hear as sound is simply 
the detection of vibrations and changes in air pressure in the surrounding air or what is 
otherwise known as a sound wavesound wavesound wavesound wave.  Our inner ear converts this information into 
impulses which we then perceive and interpret as sound.  Thus, from our own 
experience in hearing the world around us, we know that the human ear is an 
extremely sensitive and complex instrument. 
 Human hearing is concerned with two primary sound elements: its frequency and 
its pressure level.  The measure of frequency in the amount of change in a sound wave 
is called its hertzhertzhertzhertz (Hz).  Similarly, the measure of the air pressure level present in a 
sound wave is called its decibeldecibeldecibeldecibel (dB).  Each of these elements can be measured as a 
single unit of sound called a signalsignalsignalsignal.   
 
 
 
 
 
 
 
 
 
 Acoustically, the human ear is capable of hearing sound in the range of 20 to 
20,000 Hz.  Human speech, on the other hand, occupies a much smaller range in this 
sound continuum and extends from 500 to 3,000 Hz.  As sounds carry through the air, 
the frequency and decibel levels constantly change to reflect the signal variation.  This 
signal variation can be visualized as a waveformwaveformwaveformwaveform, the plotting of a sound’s values across 
time.      
    
Sound Considerations in Language RevitalizationSound Considerations in Language RevitalizationSound Considerations in Language RevitalizationSound Considerations in Language Revitalization    
 
 Our interest in the basic characteristics of sound is important when we consider 
that one of our fundamental language documentation goals is to represent the varieties 
of human speech as accurately as possible.  This includes the reproduction of live 
speech as digitized sound.  This section looks at the basic steps that are needed to 
capture and represent sound in a digital environment.   
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Analog SoundAnalog SoundAnalog SoundAnalog Sound    
 
 Recording live speech commonly employs technology such as a microphone and 
some type of recording device such as a cassette tape recorder or a reel-to-reel recorder.  
The input of live sound is captured by the microphone as a continuous electrical 
pulsation in the form of a sound wave.  Recording sound in this manner is called 
analog recordinganalog recordinganalog recordinganalog recording and the recording devices are simply referred to as analog recording 
technology.  The sound is later replicated for playback by means of a magnetic tape or 
as grooves in a vinyl record.   
 Because analog sources are typically transferred onto a physical, tactile medium 
(such as a tape), they are vulnerable to deterioration and degradation.   
 
Digital SoundDigital SoundDigital SoundDigital Sound    
 
 The modern alternative to analog recording is digital recording.  When sound is 
digitally recorded, the originating sound wave is converted from its analog form to its 
digital equivalent.  Rather than capturing sound as a continuous electrical pulsation, 
digital recording replicates a sound wave in discrete chunks called bitsbitsbitsbits, the basic unit of 
digital data.  The manner in which these bits are replicated is a process is called 
samplingsamplingsamplingsampling.   
 
 
    
        
 
 
 
 

    
Digitizing Sound from AnaloDigitizing Sound from AnaloDigitizing Sound from AnaloDigitizing Sound from Analog Sourcesg Sourcesg Sourcesg Sources    
 
 Transferring an analog recording to digital format is called analog-to-digital 
conversion.  Analog-to-digital conversion is a three part process involving 1) the 
playback of the analog source recording or “live” speech event, 2) the sampling of the 
analog input, and 3) the creation of a new analog-to-digital audio recording.  This three-
part process can get complex very quickly, so it is always advisable to obtain technical 
advice both before and during your analog-to-digital conversion.   
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SteSteSteStep 1.  p 1.  p 1.  p 1.  In our first step, we can capture and digitize audio from two 
sources: playback or as a “live” audio signal.  To do this, we must first 
capture and “sample” the electrical impulse that underlies the audio 
signal itself.  This is done by interconnecting the analog recording 
device or a microphone directly to a computer with a cable plug.    
 Capturing an analog sample or playback from a tape recording is 
possible with bare minimum computer equipment, however, it is best to 
obtain additional devices (audio mixer and/or advanced sound card) that 
are designed specifically for this purpose.    
 Capturing “live” recorder speech, however, is much easier to obtain with only 
minimal equipment such as a microphone and a desktop or laptop computer.  For 
purposes of recording speech for language documentation and language teaching, we 
highly recommend that you download Audacity (http://audacity.sourceforge.net), a free 
audio software.  Once this software is in place and your internal record settings 
properly set, plug in a microphone and you are ready to record “live’ speech.   
 
Step 2.  Step 2.  Step 2.  Step 2.  Sample or assign values to the input audio signal.  Sampling the audio input 
places a set of numeric values to the originating audio input.  These numeric values 
indicate the sampling rate that is to be assigned to a raw audio signal.  Keep in mind, 
the higher the sampling rate the better the sound.  At the same time, higher sampling 
rates also mean bigger audio file sizes.  Make sure you have dedicated storage space on 
your computer for your audio files.    
 When you are using the digital recording for language documentation purposes, it 
is desirable to maintain a high sampling rate in order to preserve the quality of the 
speech input.  However, when you use a digital recording for multimedia or web-based 
applications, a high sampling rate is disadvantageous because of their large file size.  It 
is desirable to apply a compression value which reduces the file size but maintains a 
reasonable quality of sound.   
 One such compression value is the MP3 standard.  When applied to an audio 
signal or recording, the MP3 standard eliminates the overall redundancy of unnecessary 
sound frequencies contained in an audio signal.  The result is a compressed audio 
sample that perceptually similar to the original but the file size is dramatically smaller.   
  
Step 3.  Step 3.  Step 3.  Step 3.  Create a new audio file.  Once an audio signal is ready for capturing and a 
sampling rate chosen for the input signal, you are ready to create a new digital 
recording.  If you are capturing audio from an analog source, operation of both the 
playback device (i.e. analog tape player or other recording device) and the audio editing 
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software (i.e. Audacity, SoundForge, etc.) must be timed to coincide with the start and 
end of the audio data that is being captured.  Once the audio input signal is recorded, a 
new digital audio file is created.   
 A brief note on file types:  Recorded sound is simply a digitized, audio 
recording of an actual sound.  As mentioned previously, a digitized audio recording can 
be formatted in several file types.  The most common audio file types are often 
represented by their file extensions .aiff .aiff .aiff .aiff (or .aif.aif.aif.aif), .au.au.au.au, .wav.wav.wav.wav, and .mp3.mp3.mp3.mp3.  AIFF (Audio 
Interchange File Format) is the default uncompressed audio format for the Macintosh 
computer.  AU is the default audio format for the Sun Microsystems computers and is 
widely recognized by most computer systems and browsers.  WAV (Windows Wave 
Format) is the default audio format for Windows-based computers.  The .wav format is 
the format of choice worldwide and is a common feature in most audio editing 
software.  Finally, as mentioned previously, .mp3 is a compression standard that 
eliminates redundant sound frequencies from a .wav file or audio signal and creates 
smaller file sizes.  In all likelihood, you may encounter each of these file types as you 
begin to create your own digital recordings whether they are recorded from analog 
sources or from “live” speech.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

State's Indians uncover the past 
Mon, 14 Jun 2004 - By Jack Chang - CONTRA COSTA TIMES 

 
BERKELEY - In front of hundreds of Indigenous people and 

linguists from around the world, California Indian Bill Combs held a 
sheet of paper in front of him Friday and nervously spoke the lost 
language of his ancestors. While his cousin Norma Yeager translated, 
he read the Wintun words for frog, deer and other animals, complete 
with the glottal stops, or deep-throated clicking sounds, that he 
had practiced all week. 

The 34-year-old man wearing a T-shirt and shorts finished his 
presentation by looking up at the audience gathered in UC Berkeley's 
Pauley Ballroom and telling them in Wintun what he had recently 
learned to do after being denied the opportunity all his life. 

"I am speaking my language." 
For many "Breath of Life" conference participants, the experience 

has been emotional as they dig through the university's archive of 
language recordings to find traces of their lost tongues. In some 
cases, they have come across recordings of grandparents and other 
family members speaking their languages decades ago into the 
microphones of UC Berkeley anthropologists. Some have become the 
first people to speak their ancestral languages since the early 20th 
century. 

Some Nomelaki words: Transcribed by California Indian Norma 
Yeager and UC Berkeley graduate student Jenny Lederer. Nomelaki was 
spoken among Northern Californian natives. 

 
tree -- mee  deer -- nopoom  flowers -- kalal 

bear -- waymahl jaybird -- chiek-chiek rabbit -- patkeelee 
 

http://www.contracostatimes.com/mld/cctimes/news/8913180.htm1 
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AudacityAudacityAudacityAudacity    
 

An Introduction 

 
 Audacity is open-source audio editing tool for creating multi-track digital sound 
recordings.  As a free audio editing tool, Audacity can play an key role in supporting 
endangered language documentation and revitalization by recording and capturing “live” 
speech.  Audacity can be downloaded onto any computer with a Mac OSX or Windows 
operating system.  Just go to http://audacity.sourceforge.net/ to download.     
 Audacity can be used to record, play, and import audio sources such as: WAV, 
AIFF, and MP3 files.  It can also be used to edit your digital sound recordings using 
Cut, Copy and Paste, mix tracks as well as apply sound effects to your recordings. 
   

Audacity Screen ShotAudacity Screen ShotAudacity Screen ShotAudacity Screen Shot    
    

 
 

 When you first launch Audacity, the Audacity Control Toolbar is prominently 
displayed.  The Audacity Control Toolbar is the main control which governs the 
playback of your audio file as you listen to and edit sound data.  In this introduction, 
we will briefly look at the most basic elements in Audacity beginning with Audacity’s 
Control Toolbar which will enable you to begin editing an audio sample.   
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The Audacity Control ToolbarThe Audacity Control ToolbarThe Audacity Control ToolbarThe Audacity Control Toolbar 

 
 

  The Selection Tool  Cursor   Play   Record  Pause  Stop  Cursor  
                       to Start      to End   
                         

� The Selection Tool Selection Tool Selection Tool Selection Tool is the main tool you use to select audio data in an 
opened audio file.  You will notice that when you move your mouse pointer 
over a waveform, the selection tool automatically appears.  Click inside a 
track to position the cursor, or click and drag to select a segment of audio.  

� The Cursor to Start Cursor to Start Cursor to Start Cursor to Start button places the cursor at the start of an audio file.  
�  Pressing the green PlayPlayPlayPlay button will play back the sound in an opened audio 

file.  Playback will always start wherever the cursor is positioned.  When a 
segment of audio is selected, playback will only play the region selected.  

� Pressing the red RecordRecordRecordRecord button will record the input of “live” sound using 
the computer’s sound input device.  Input can be recorded in stereo or mono 
and can be set at various sampling rates with 44100 Hz being the most 
common sampling rate.   

� Pressing the blue PausePausePausePause button will pause the playback of an open audio file.  
Press the PausePausePausePause button again to continue from the current position.   

� Pressing the yellow StopStopStopStop button will stop the recording or playback of an 
open audio file.  The cursor will return to its original position prior to 
recording or play back.    

� The Cursor to End  Cursor to End  Cursor to End  Cursor to End button places the cursor at the end of an open audio file.   
    

                    Audacity Mixer ToolbarAudacity Mixer ToolbarAudacity Mixer ToolbarAudacity Mixer Toolbar    
 

            
                
         Output Volume       Input Volume   Input Source 

    
� The Mixer ToolbarMixer ToolbarMixer ToolbarMixer Toolbar shows three controls, these are the Output Volume, the 

Input Volume and the Input Source.  The Output volume is the volume heard 
during playback.  The Input Volume is the volume that determines the input 
level of an audio signal.  The Input Source determines how an audio signal is 
recognized in Audacity.  For recording purposes, simply choose 
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“Microphone” and, to obtain a clear signal, set the Input Volume in the “+” 
range.    

    
Audacity Edit ToolbaAudacity Edit ToolbaAudacity Edit ToolbaAudacity Edit Toolbarrrr    

               
 

� Audacity’s Edit ToolbarEdit ToolbarEdit ToolbarEdit Toolbar offers a visual access point to basic editing functions 
found in Audacity’s dropdown Edit menu.   

 
Audacity Edit Dropdown MenuAudacity Edit Dropdown MenuAudacity Edit Dropdown MenuAudacity Edit Dropdown Menu    

 
 
 Editing in Audacity is the process of manipulating and adjusting audio data using 
various editing actions.  The primary editing actions are Cut, Copy, and Paste.    

 
Using Cut Cut Cut Cut allows you to select audio data and remove it from an open audio file.  
The “cut” audio data is placed inside the clipboard.     
 
Using PastePastePastePaste allows you insert cut or copied audio data into an open audio file. 
Paste inserts whatever is in the clipboard to the current cursor position.    

 
Using CopyCopyCopyCopy copies the selected audio data and places it into the clipboard.  It 
does not remove data from an open audio file.    
 
Using TrimTrimTrimTrim deletes everything outside of the selected audio data. 
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Using SilenceSilenceSilenceSilence erases any section of selected audio data and replaces it with 
silence. 
 
Using UndoUndoUndoUndo will undo the last editing action you performed on any segment of 
audio data.  A unique feature of Audacity’s Undo is that it supports unlimited 

Undo until it reaches the last time the audio file was saved.   
   
Using RedoRedoRedoRedo will redo any editing action you performed on any segment of audio 
data that was taken using Undo.  Redo is limited only to current editing actions.   

 
Using the ZoomZoomZoomZoom tools are not really editing actions.  They are simply actions that 
apply to how your audio data is viewed within your work area.   

 
 Some additional functions are graphically represented here: 
 
                                     
 
 
 
 Once you become more familiar with recording and editing audio in Audacity, 
you will notice that Audacity has a internal file format which stores some audio files in 
a project “data” folder with audio files labeled as .aupaupaupaup.  This type of formatting is 
unique to Audacity and is designed to allow highly optimized audio editing.  Typically, 
Audacity’s .aup file type cannot be read or “played” outside of Audacity and it is 
necessary to export finished edited samples by using the “Export as WAV” or “Export 
as MP3” commands in the File dropdown menu.      
 Audacity also has a number of editing effects which allow you to manipulate an 
audio sample in various ways.  Effects editing is simply the process of reconstructing 
the sound of an audio sample to obtain a desired effect.  You can find the editing effect 
options in the “Effects” dropdown menu in Audacity as well as descriptions of each 
effect in the “Help” menu dropdown menu.     
 
 
 
 
 
 
 

Draw tool 
Envelope tool 
  
Multi-tool tool 
Time-shift tool 

Selection tool 
Zoom tool 
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WORKING WITH GRAPHICSWORKING WITH GRAPHICSWORKING WITH GRAPHICSWORKING WITH GRAPHICS    
 

Multimedia Graphics 

 
 Multimedia graphics refers to the technology and process of creating, modifying, 
and displaying 2-dimensional images in digital form.  Graphics play a vital role in 
almost all multimedia environments because they not only allow for the display of 
visual information but forms the core framework for multimedia design and presentation.   
 2-dimensional images come in many forms.  At the start, we must distinguish 
between non-digital vs. digital images.  Non-digital images typically consist of 
photographs, drawings, and illustrations on paper.  Digital images are computer-based 
images stored as an array of pixels, short for “picture element,” which are simply a 
series of points in a digital image.  When a digital image is presented in a computer 
display monitor, these tiny pixels are arranged in rows and columns each containing 
their own color value.  Because pixels are the building blocks of a graphic image, the 
general rule is that the more pixels there are the better the image quality.     
 
ResolutiResolutiResolutiResolution and Bit Depthon and Bit Depthon and Bit Depthon and Bit Depth    
 
 Resolution refers to the way in which an image depicts fine, spatial detail.  
Resolution is measured as the number of dots per length, such as dots per inch (dpi).  
This is also referred to as pixels per inch (ppi).  Bit depth refers to the number of bits 
(binary digit) a pixel can store.  For example, pixels in a bi-tonal image will store 1 bit 
per color.  A grayscale image pixel will contain 2 to 8 bits while a color image pixel 
will typically contain 24 bits or more.   
 
True Image FormTrue Image FormTrue Image FormTrue Image Formatsatsatsats    
 
 True image formats accurately store image values for future editing and use.  The 
most common true image file formats are TIFF (Tagged-image File Format) and PNG 
(Portable Network Graphics).  These two file formats are intended to replace the older 
BMP (Bitmap) and PICT (Macintosh-based format) true image file formats.  Generally, 
true image file formats are bigger in file size due to the retention of all original image 
values.  This is called ‘lossless data compression’.   
 
Compressed Image FormatsCompressed Image FormatsCompressed Image FormatsCompressed Image Formats    
 
 Compressed image formats refer to the ways in which an image file is reduced 
in size with minimal image distortion. The most common compressed image file formats 
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are JPEG (Joint Photographic Experts Group) and GIF (Graphic Interchange Format).  
The compression consists of abbreviating the number of bits contained in an image 
using a standard compression algorithm. This is called ‘lossy compression’.  This file 
format is ideal for creating graphics for the web, multimedia, and word documents due 
to their reduced file size and image quality.  
 
AAAAdobe Photoshopdobe Photoshopdobe Photoshopdobe Photoshop 7.0 7.0 7.0 7.0    

 
 Using graphics to support language lessons provides for a richer learning 
environment. While many graphics can simply be imported through Clip Art, using your 
own art work or working with actual photos is best done with Adobe Photoshop. The 
Photoshop topics covered here are the most basic. This is a powerful program capable 
of very sophisticated graphics work. Here we are most interested in establishing the 
fundamental choices you might need to make your image more interesting in terms of 
color, texture or size. First, here are some examples of the changes photos can undergo 
in Photoshop. 
 

1. Cropping Cropping Cropping Cropping = Selecting the part of the photo you wish to use. 
 

 
 
 
 
 

2.2.2.2. Rotating the imageRotating the imageRotating the imageRotating the image    
 
 
 
 
 
 

3.3.3.3. Adjusting levelsAdjusting levelsAdjusting levelsAdjusting levels    
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4.4.4.4. Changing art stylesChanging art stylesChanging art stylesChanging art styles    
    
    
    
    
    
    
    
Understanding the Photoshop ScreenUnderstanding the Photoshop ScreenUnderstanding the Photoshop ScreenUnderstanding the Photoshop Screen: : : :     
    
    
    Main Tool BarMain Tool BarMain Tool BarMain Tool Bar        Work AreaWork AreaWork AreaWork Area                PalettesPalettesPalettesPalettes                                                                                                                                        

 

 
    
    
Main Tool Bar:Main Tool Bar:Main Tool Bar:Main Tool Bar:    
    

            
    

Photoshop       Photoshop       Photoshop       Photoshop       
toolstoolstoolstools    
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Working with an image:Working with an image:Working with an image:Working with an image:    
    
 To practice with the following exercises, you will have to have a picture scanned 
into a file and saved as a .JPG. .JPG files work with Power Point. Be sure you know 
where you saved your picture! If you can’t remember, use the ‘Find File’ function 
which you can locate by using ‘Help’ on the main menu. 
    
StStStStep 1: Create a folder for your workep 1: Create a folder for your workep 1: Create a folder for your workep 1: Create a folder for your work    
    
First, create a folder on your desktop in which to keep your work. First, create a folder on your desktop in which to keep your work. First, create a folder on your desktop in which to keep your work. First, create a folder on your desktop in which to keep your work.     

    
� Right click while on desktop to get this menu: Right click while on desktop to get this menu: Right click while on desktop to get this menu: Right click while on desktop to get this menu: ClickClickClickClick    

‘New’‘New’‘New’‘New’    
� On this menu, click on ‘Folder’ and give it the name On this menu, click on ‘Folder’ and give it the name On this menu, click on ‘Folder’ and give it the name On this menu, click on ‘Folder’ and give it the name 

‘Work’. ‘Work’. ‘Work’. ‘Work’.     
    
    
    
    
    
    
Step 2: Scanning inStep 2: Scanning inStep 2: Scanning inStep 2: Scanning into Photoshopto Photoshopto Photoshopto Photoshop    

    

 Key terms: 
 
DPI = Dots Per Inch. DPI means how much information is packed into every square inch of the 
image you scan. Computer monitors see everything at 72 DPI. Therefore, if you scan an image 
at 300 DPI, it will appear larger on the screen than the actual size. If you scan an image at a 
high DPI, then the file size is likely to be larger than you desire. 
 
USB = Universal Serial Bus. The USB was developed to create a better serial port. Newer 
machines have these ports on either the back or front or both.  
 
SCSI = Small Computer System Interface. Pronounced ‘scuzzy’, this is one of the oldest and 
fastest ways to transfer information on a personal computer. The machine should always be 

turned off before you plug an SCSI device in. 
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Note:Note:Note:Note:    The scanner should be turned on and connected. It is important that the 
connections are correctly in place. Unplug and re-plug if you have to. Re-boot if you 
are not using a USB.     
 Your images should be clear images. The size of your image is important. 
Factory defaults are 800 x 600 so keep your images below 760 x 450. The is 
particularly true if you want to use the images on a website. 
    
Checklist before beginning:Checklist before beginning:Checklist before beginning:Checklist before beginning:    
    
    Is the computer on? 
 Is the scanner connected? 
 Is the power to the scanner on? 
 Do you have materials to scan? 
 Are you ready to scan?    
    
    Remember, there are many different types of scanners. The steps here are very 
general and you may have specific requirements for your particular scanner. Flatbed 
scanners are the best for use with graphics. 
 
To start scanning: 
    

� Open Photoshop 
� Start Menu > Programs > Adobe Photoshop 
� Click on ‘File’  
� Choose ‘Import’ 

 
    
    
    
    
This will connect your computer to the scanner…This will connect your computer to the scanner…This will connect your computer to the scanner…This will connect your computer to the scanner…Your 
scanner may have selections for you to choose from 
such as: Scan to Adobe Photoshop or MSWord, etc. Be 
sure to check the scanner for options. Your image 
should appear in the work area of the    Adobe Photoshop 
screen.    
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Now the fun begins!Now the fun begins!Now the fun begins!Now the fun begins!    
    

Step 3: Within Photoshop 
Click File on Main menu  
Click Open 

                      
 
 
Step 4:  

SAVE this first image in your ‘WORK’ 
folder on the desktop.  
 

 

Coloring with  
Photoshop using 

the paint bucket 
 
Illustrations from 
the Mohave 
Coloring book, 
compliments of the 
CRIT Library 

Step 5: 

Three things are important for creating a Three things are important for creating a Three things are important for creating a Three things are important for creating a 

picture that you will use in a document.picture that you will use in a document.picture that you will use in a document.picture that you will use in a document.    
  
Size- set in pixels, inches or others. 
Background- transparent, colored or white 
Resolution- this determines how much 
               information is in your document 
 
 
FOR CREATING NEW IMAGES (not those 
imported from a scanner): 

    
Click on File > New to get this window 
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Photoshop Tools: Photoshop Tools: Photoshop Tools: Photoshop Tools:     
 
 This tool bar will allow you to work with many aspects of your image. It is a 
very, very dynamic system. Notice the small arrows on the bottom right of some of the 
symbols. If you click on those, you will be given additional tool choices.  
 
 
 
 
             
    
 
 
 
 
 
 
 
 
 
 
 
 
 
               
 
 
    
    
    
    
    
    
    
    
    
    
    

    
    Marquee tools:Marquee tools:Marquee tools:Marquee tools:    Make geometric 

selections 
 

    Lasso tools:Lasso tools:Lasso tools:Lasso tools:    Make freehand 
selections 
 

    Crop tool:Crop tool:Crop tool:Crop tool:    Trims images for size  
 

 Healing Brush tool:Healing Brush tool:Healing Brush tool:Healing Brush tool: Repairs 

imperfections in images 
 

 Clone Stamp tool:Clone Stamp tool:Clone Stamp tool:Clone Stamp tool: Paints with a 
sample of the image 
 

 Eraser tool:Eraser tool:Eraser tool:Eraser tool:    Erases pixels and 
restores the image  

 

    Blur tool:Blur tool:Blur tool:Blur tool: Blurs hard image edges 
 

    Path Selection tools:Path Selection tools:Path Selection tools:Path Selection tools: Shows start 

points and direction lines 
 

 Pen tools:Pen tools:Pen tools:Pen tools: Draw smooth-edged 
paths 
 

    Annotation tools:Annotation tools:Annotation tools:Annotation tools:    Makes notes and 
audio notations that can attach to an 

image 
 

 Hand tool:Hand tool:Hand tool:Hand tool:    Moves an image within 

its window 
 

Select foreground colorforeground colorforeground colorforeground color,,,, set 
background colorbackground colorbackground colorbackground color    

    Move tool:Move tool:Move tool:Move tool:    Moves selections and layers 
 

 Magic Wand tool:Magic Wand tool:Magic Wand tool:Magic Wand tool: Selects similarly 

colored areas 
 

 Slice tool:Slice tool:Slice tool:Slice tool:     Creates slices 
 

 Brush tool:Brush tool:Brush tool:Brush tool:     Paints brush strokes 
 

 History brush tool:History brush tool:History brush tool:History brush tool:    Paints a copy into 

current window 
 

    Gradient tools:Gradient tools:Gradient tools:Gradient tools: Blends between colors 
 

 Dodge tool:Dodge tool:Dodge tool:Dodge tool:    Lightens areas in an image 
 

    Type tools:Type tools:Type tools:Type tools:        Creates text on an image 
 

    Rectangle tools:Rectangle tools:Rectangle tools:Rectangle tools:    Draws a rectangle 
 

    Eyedropper tool:Eyedropper tool:Eyedropper tool:Eyedropper tool:    Samples colors in an 

image 
 

    Zoom tool:Zoom tool:Zoom tool:Zoom tool:    Magnifies or reduces view 
of image 

Choose Standard ModeStandard ModeStandard ModeStandard Mode or Quick Mask Quick Mask Quick Mask Quick Mask ModeModeModeMode    
    

Edit with standard screenstandard screenstandard screenstandard screen 
Edit with full screen and menu barscreen and menu barscreen and menu barscreen and menu bar 

Edit with full screenfull screenfull screenfull screen    
 

Jump to ‘Image‘Image‘Image‘Image----Ready’Ready’Ready’Ready’ (an image editing 
program which comes with Adobe 

Photoshop)  



 89 

Things you can do:Things you can do:Things you can do:Things you can do:    
    
Manipulate your pictureManipulate your pictureManipulate your pictureManipulate your picture    
        
Crop:Crop:Crop:Crop:    Cropping is used for selecting the portion of your image you want to work with. 
This tool helps you control the content of your image. 
 

Steps: 
 

1. Open your picture within Adobe Photoshop 
2. Click on the crop tool icon  
3. Using your mouse, click on the place in your picture where you would like to 

begin capturing your picture content 
4. Hold the left click button down and drag the tool across the picture. You will 

see the selected portion outlined in dotted lines 
5. Right click on the mouse and you will see this small menu  
6. Left click on ‘crop’  if you like your selection     

    
         1)         3) 

 
                         

 
                                                     

 
 
 

          
       2) 

    
    
    

Rotate   Rotate   Rotate   Rotate       
                         

Steps:  
 

1. Click ‘Image’ on main tool bar 
2. Scroll to ‘Rotate Canvas’ 
3. Choose the degree and direction 
 CW = Clockwise 
 CCW = Counter Clockwise 
 Arbitrary allows for finer tuning    
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Rotating allows you to change 
the direction of your image or 
scanned document    
    
    
    
Use toolsUse toolsUse toolsUse tools 
  
 Photoshop tools allow you to make many changes in your image. Don’t be afraid 
to experiment…you can always undo.  
    
    
    
    
    
    There are many tools and some have additional hidden menus. For instance, the 
‘Paint Bucket’ in Photoshop is hidden under the gradient tool. To access these tools, left 
click on the small arrow at the bottom right corner of the tool. 
    

                                
    
    
    
AdjustmentsAdjustmentsAdjustmentsAdjustments    
    
 It is very useful to understand some basic adjustments. These will help you 
control brightness and contrast and more.  
 

Steps: 
 

1. Click on ‘Image’ on the main tool bar 
2. Select ‘Adjustments’ 
3. Choose ‘Auto Level’ for quick clarity of your image 
4. Experiment with brightness and contrast 

    
    
    
    
    

EDIT…EDIT…EDIT…EDIT…UndoUndoUndoUndo    

Do not forget this function!  Every step you take in Photoshop 
can be undone.  You can also use the key combination of ‘control’ 

and ‘Z’ to undo your work. 

 

 

 

 

 

 

Illustrations from 
the Chemehuevi 
Coloring Book, 
CRIT Library 
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FiltersFiltersFiltersFilters    
    
 Working with just one of many possible layers in Photoshop, you can affect 
many artistic changes in your image. The changes below are just a small sample of 
what is possible when you use the ‘Filter’ option on the tool bar.  
 Remember, as you experiment with these, to ‘Undo’ after each filter change. 
Otherwise, you will be placing a filter upon a filter—but then, that can be fun too!  
The ‘Filter’ option gives you the following menu of choices. Note the arrows on the 
right. Each of these options can be expanded. 

 
    
    
    
    
    
    
                     Texture Change: Stained 
Glass    
    
               
    
 
 
 
    
                                                                                                                                                                                                                                        

 
 You can use this same sequence to create other changes in your picture. For 
instance, if you choose FilterFilterFilterFilter and then SketchSketchSketchSketch and then Torn Edges,Torn Edges,Torn Edges,Torn Edges, you can create a 
‘torn-edge’ effect. 
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Embossing 
 
 
    

Outlining  
 
 
 
  
 
Liquify Liquify Liquify Liquify     
    
 One very interesting effect is called ‘Liquify’. Begin with ‘Filter’ on the main 
tool bar. This window will open.    
                                                                                                                                                                                                     
    
    
    
    
    
You can choose the size of the brush stroke. 
Once you do, drag your cursor over the image 
to create the liquify effect. The result looks 
like this: 
 
 
 
 
      Small brush stroke                                                                                                                                                                                    Large brush stroke    
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                    text  direction font     bold/italic    font size   appearance  position   color  bend      
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

Text and FontsText and FontsText and FontsText and Fonts    
    
 Be aware that text in Photoshop 7 behaves differently 
than it does in earlier versions. It is now postscript and is 
equivalent to Adobe Illustrator or Quark in printed appearance. 
It now behaves more like a word processor. 
 

Adding Text: 
    

1. Close any existing pictures 
2. Open a new one that is 72 resolution, 250 x 600 pixels 

and has a transparent background 
3. Select the ‘TEXT’ tool on the tool bar      
4. Click on the picture 
5. Type something 
6. Select the layer your text is on 
7. Select the text to be edited 
8. Change the color of the text 
9. Change the ‘font type’ 
10. Apply a bend 
11. Move the text 
12. Click on ‘OK’ - the check mark 
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Saving Documents in Different FormatsSaving Documents in Different FormatsSaving Documents in Different FormatsSaving Documents in Different Formats    
    

Formats: 
 

� .psd.psd.psd.psd – PhotoShop format which preserves layers 
� .jpg.jpg.jpg.jpg – For the Web and PowerPoint 
� .gif.gif.gif.gif  – For the Web, but best for text 
� .tif   .tif   .tif   .tif   ----  A cross platform format that preserves all quality for printing 
� .pct.pct.pct.pct – Another good format for print and cross platform    

    
Steps: 

 

1. OpenOpenOpenOpen your picture using Menu > File > Open to navigate to the 
document, click once on ‘OK’ 

2. Save itSave itSave itSave it as Work.psd in a folder on the desktop 
3. SavSavSavSave ite ite ite it again as Work.jpg 
4. Try Menu > File > Save asMenu > File > Save asMenu > File > Save asMenu > File > Save as – Now change the name and save to a 

different desired location (For instance, save as ‘My documents’. 
5.5.5.5. Click ‘OK’Click ‘OK’Click ‘OK’Click ‘OK’    

Printing Printing Printing Printing YYYYour our our our FFFFileileileile    
    

Steps: 
1. Open your Work.jpg file 
2. Go to the Menu > File > Page Setup. 

When the window opens, make sure 
that the document will print to the 
printer of your choice 

3. Choose ‘portrait’ or ‘landscape’ 
depending on how you want to orient 
your picture 

4. Click ‘OK’ 
5. On the same menu, choose ‘Print’ and 

Click ‘OK’ 
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Saving for the WebSaving for the WebSaving for the WebSaving for the Web    
 

Steps: 
 

1. Open your Work file 
2. Go to Menu > File > Save for Web. This opens a 

new window 
3. Click on the 4-up tab.  This option creates 4 

images. The upper left image is your original and 
the others are examples of options. 

4. What is most important is the format setting! 
Choose .jpg for image or .gif for text, then set 
quality and ‘OK’. The options should be practiced 
as the effects are many. Basically you must 
balance the file size with quality and format type. 
Quality is a combination of the numbers of colors 
and the quality setting.  

    
 

 

                      

Exercise 1: Let’s practice saving for the Web 
 

� Open Work.psd 
� Go to Menu > File > Save for Web 
� Save a .gif that is 100k with the name of Work01.gif in your 

workshop folder 
� Save the .gif in the ‘Work’ folder on  your desktop 
� Save a .jgp  or 75k or smaller to the same folder. Name it 

Work01.jpg. 
� Now go to your desktop folder and make sure the files are there. 

    
Even if you don’t plan to have your own web page or to publish your work on 
the web, it doesn’t hurt to learn to save picture files in a variety of formats to 

insure quality reproduction. 
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 When you feel you have mastered working on one layer, you might want to try 
bringing in more. Here are just a few pointers. See Part IV for recommended online 
tutorials for more advanced work with Adobe Photoshop. 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On the layer palette, 
there are several useful 
features. One is the 
locking feature. At the 
top of the layer palette, 
notice several boxes with 
icons. Checking the boxes 
will lock features of 
layers on the active 
picture. 
 
The features on the right The features on the right The features on the right The features on the right 
make editing easier and make editing easier and make editing easier and make editing easier and 
help prevent common help prevent common help prevent common help prevent common 
mistakes.mistakes.mistakes.mistakes.    

                             

 

 

      

PreservesPreservesPreservesPreserves    transparency 

 
PaintsPaintsPaintsPaints    

 
Position:Position:Position:Position: prevents 
moving things 

 
Locks AllLocks AllLocks AllLocks All: makes 

editing impossible 
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MMMMaking Videos with Your Camcorderaking Videos with Your Camcorderaking Videos with Your Camcorderaking Videos with Your Camcorder    

    
 Language revitalization and preservation are greatly enhanced by the use of 
video. For those languages with few speakers it is so very important to video all levels 
of language use especially just everyday conversation. These tips for using a video were 
contributed by Julie Rackow who worked on the CRIT project. However, you don’t 
have to be a professional videographer like Julie to capture great video moments that 
can help preserve and inspire language use. Please see the segment on our website, 
http://projects.ltc.arizona.edu/gates/TELR.html, showing Johnny Hill’s amazing homemade 
video of Chemehuevi.   
 

Video Shots: Tips to make shooting with your camcorder easier 

� Remember to take the lens cap off.Remember to take the lens cap off.Remember to take the lens cap off.Remember to take the lens cap off. (Eh?) No, really, we’re serious. In the 
rush of setting everything up for a shot you would be surprised at the 
number of people who set the camera recording with the lens cap still on. 
Even the pros can do it –  

� Always record 5 seconds before and after the shot you wantAlways record 5 seconds before and after the shot you wantAlways record 5 seconds before and after the shot you wantAlways record 5 seconds before and after the shot you want. Editing decks 
need a bit of space to get the signal properly (called pre-roll) and they can 
muck their edits up if you don't have enough pre-roll.  

� Use manual focus if at all possibleUse manual focus if at all possibleUse manual focus if at all possibleUse manual focus if at all possible. Autofocus hunts for stuff to focus on, so 
if someone walks through the shot it will try and focus on them, getting your 
subject out of focus. Autofocus also uses up a lot of battery power, so using 
manual focus and push focus (a button you can press for autofocusing) makes 
your batteries last longer. Whatever, make sure your subject is in focus. To 
be absolutely sure, zoom in on the subject, focus, and zoom out. 

� Leave that zLeave that zLeave that zLeave that zoom rocker switch alone!oom rocker switch alone!oom rocker switch alone!oom rocker switch alone! See that button that rests just 
underneath your fingers when you hold the camera? That's your ticket to bad 
film-making. Its sitting there, nuzzling you saying 'Hey press me! Zoom in, 
go on. Now zoom out! Smart'. Unfortunately when you come to watch your 
film most of your audience will be sick because the zoom is constantly 
tromboning in and out. There are only two occasions when it is OK to use 
the zoom during a shot. 

1. You are interviewing a man who has just seen his daughter run down by 
a steamroller. Understandably its a heart-wrenching moment. So Mr. News 
Cameraman zooms in really slow (you barely notice it) so we capture that 
first tear perfectly (how they can do this I do not know). 
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2. Cheesy 70's cop movie. We have just ended the last car chase scene and 
we want to establish that they are now back in the cop shop. 

EXT. POLICE HQ - DAY  
FAST ZOOM IN on window of building. 

CUT TO - INT. POLICE HQ OFFICE - DAY 
SUPERINTENDENT ROBERTS is chewing the two rookie cops asses off who have 

just flunked the car chase. He's angry, he's mean and he's got huge sweat rings 
under his armpits. 

OK, so you get the picture. Zoom for effect - not because the button is 
forcing you to. By all means use it to set up a shot when the camera's not 
rolling, but leave it at that. 

� Use a tripod - If you want a steady shot then stick your camera on a stand (or a wall 

or something). 
� Don't use a tripodDon't use a tripodDon't use a tripodDon't use a tripod - (umm...bit of a contradiction here - oops!) - If you want 

to give your film some energy dump the tripod, setting your camera up on 
sticks takes too long anyway. To keep it steady-ish, get as close to your 
subject as possible and shoot as wide-angle as possible to minimize shake. If 
you can, keep both eyes open (instead of just squinting down the viewfinder) 
so you can adjust the camera to follow your subject. 

� Check your white balanceCheck your white balanceCheck your white balanceCheck your white balance, especially if you are in mixed lighted rooms. 
(White Balance? Mixed lighting? Eh?) White balance is essentially what color 
your camera thinks is white. Some cameras have buttons for this i.e. indoors, 
outdoors etc. Other cameras sort this out automatically (although they can 
make a botch job of it) and some allow you to set it manually (by sticking a 
piece of white card in front of it and saying 'Hey, this is white you dumb 
camera'. This all matters because not all light is the same color. Lights have 
different color temperatures. Sunlight is kind of bluey, artificial light (like 
light-bulbs and stuff) is orangey and fluorescent strip lights are greeny. Your 
eyes can sort this information out, but the camera tends to make everything 
look all one color if its on the wrong setting. Checking your white balance is 
okay if you've got a color viewfinder but you'll need to wire the camera into 
a TV if you haven't. Failing that sure the preset is right and hope its OK.  
So remember:So remember:So remember:So remember:    

Sunlight Bluey 

Artificial Light Orangey 

Fluorescents Greeny 
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� Avoid BacklightingAvoid BacklightingAvoid BacklightingAvoid Backlighting - This is where your subject is standing with the sky or a 
window or white wall behind them. The camera goes 'Hey, loads of white I 
better set my exposure to that', so when you come to look at your footage all 
you can see it a silhouette of your subject and you can hardly see their face. 
Solution - turn around, and use the light from the wall/window to light your 
subject (Some cameras might have a BLC - Backlight Compensation button, 
but these tend to on the whole suck). 

� Try not to appear in your own filmTry not to appear in your own filmTry not to appear in your own filmTry not to appear in your own film - Unless of course you are Hitchcock or 
your actor has called in sick and you're having to play the role yourself you 
want to try and avoid appearing in your film as...the camera operator! Avoid 
fingers near the lens or long hair draping into shot. Equally be careful when 
shooting through glass, mirrors or shiny objects not to catch a view of 
yourself. Use a polarizing filter to cut down on any reflection. 

� Switch the camera on before you take the lens cap offSwitch the camera on before you take the lens cap offSwitch the camera on before you take the lens cap offSwitch the camera on before you take the lens cap off - I don't know where 
I heard this, but apparently you can damage the camera's CCD chip if you 
take the cap off then switch it on – you know, cap off, light streams in, chip 
gets frazzled. Equally don't point your camera at really bright lights i.e. the 
sun, nuclear explosions etc 

� Check your soundCheck your soundCheck your soundCheck your sound - Most cameras have headphone sockets so you can 
monitor what the camera is picking up. Recording without checking your 
sound is like shooting and not looking down your viewfinder. Remember: 
your ears are great (they can filter out all that extra noise and focus in on 
just one voice) - your camera isn't, it'll pick up on every squeak and rumble. 

� Use an external miUse an external miUse an external miUse an external micccc if possible if possible if possible if possible - To get better sound get your hands on an 
good external microphone that plugs into your camera. This should cut down 
on operating noise from the camera (inside whirring etc.) and you can pick a 
mic for the job at hand. Doing street interviews? Get an unidirectional mic 
(y'know, the ones that look like ice creams) to cut down on all that traffic 
noise (if your camera has any kind of handle tie your flex around this, so if 
your interviewer yanks on the cord the mike isn't pulled out). Drama? Try a 
super-cardoid mic and mount it on a old broom and get a mate to stand there 
and dangle it in front of your actors. 

� Gag your microphoneGag your microphoneGag your microphoneGag your microphone - If you know you're going to be shooting in a windy 
place get a wind gag for your mic. Wind gags are basically furry things that 
fit over your mic (in the wild they can live up to 70 years), that cut down 
on the roar you will hear if filming in wind. The other day I stuck my 
camera out of a car window and the sound I got was like ground zero at a 
nuclear blast! 
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� Protect your equipmentProtect your equipmentProtect your equipmentProtect your equipment - You've got to keep it safe from two things - the 
environment and from it getting nicked. Keep your gear clear from dust and 
dirt (use a cover to protect it from the rain) and screw on a skylight filter to 
protect the lens. Clean the lens/filter and viewfinder using blower brushes, air 
jets etc. Security! Keep your camera close to you, make sure its insured and 
know its serial number if it does get pinched. 

� Tape CareTape CareTape CareTape Care - Always use the best quality tape you can afford (usually metal 
evaporated). You can only capture an event on tape once. The great thing 
about tape is that you can record over stuff but be careful you may need 
footage again in the future. Remember, keep all your rushes!  

� BatteriesBatteriesBatteriesBatteries - Always carry fully-charged extra batteries, otherwise you can bet 
that you will lose power halfway through the most important shot of your 
film. Bear in mind that batteries have a shorter lifespan in the cold. Hug 
them to keep 'em warm (and show them that you love them). 

� Shoot loads!Shoot loads!Shoot loads!Shoot loads! - Tape is cheap. Use it. When you get around to editing you 
might just need a certain shot, so shoot everything. Shoot plenty of cutaways 
(shots to cut in at any point – close-ups, buildings, reactions of other people). 
Don't tell your actors, but shoot practice takes (you might need to put a bit 
of gaffer tape over the recording light) sometimes they are the best, most 
natural take. 

� Shoot with both eyes openShoot with both eyes openShoot with both eyes openShoot with both eyes open -- like the news cameramen do. It takes some 
practice but it allows you to see what's going on in the viewfinder as well as 
around you. (Jonathan Lewis) 

� Avoid the horns of Satan!Avoid the horns of Satan!Avoid the horns of Satan!Avoid the horns of Satan! - Try to keep an eye on what is in the background 
of your shot. You want to try and avoid potted plants sprouting from people’s 
heads etc., not to mention trees & telephone poles.  Especially steer clear of 
backdrops where there's visually exciting stuff going on - a videogame 
running in the background as you can guarantee that your audience will end 
of paying more attention to this than what the person is saying or doing. 
There's a classic clip I've seen where two policemen are talking about what a 
quiet night it had been with no arrests. Behind the officer, in the background, 
are two lads beating each other to a pulp. 

� Other things you may need for the shoot?Other things you may need for the shoot?Other things you may need for the shoot?Other things you may need for the shoot?  Boom mike’s, windsock for the 
mikes, lights, several heavy duty extension cords, more batteries for the 
camera, batteries for the mike’s, any props, back drops; this can be as simple 
as a black or colored bed sheet, and think of other things may you need?  
Better to be over prepared that to have to scratch a shoot due to lack of 
preparation. 
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� Watch films of all sorts. Watch films of all sorts. Watch films of all sorts. Watch films of all sorts. Films from the 50s to the mid 70s play to a more 
intelligent audience. Older films rely more on plot and character development 
than on special effects to get the point across to the viewer.  Watch for 
creative pacing and character development, things that are lacking in most of 
the contemporary film.  Avoid Hollywood block buster films, for the most 
part they are not artistic and without special effects do not have much else to 
offer. Watch PBS, NOVA, the Discovery Channel, A & E, the History 
Channel, and documentaries,  critically analyze how the pro’s use the camera 
to help tell the story?  How do they frame the subject matter to draw the 
viewer in?   How do they highlight things by using audio or supplemental 
footage; use music or silence to accent the tone, pace and tension in the 
scene.   

� And finally, have funhave funhave funhave fun!!!! 

 The Videomaker Handbook is a selection of excellent articles that explain all 
aspects of video production in depth. Although very technical at times this is a really 
useful book for anyone looking to get the most out of their video camera, covering 
everything from scheduling your shoot, through all aspects of production to distributing 
your finished video. From the writers of the USA's Videomaker magazine so you know 
it comes from the experts. 
   

Julie R. Rackow 
Edited by - dale@exposure.co.uk 
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Swinomish youth pick up cameras, tell their own stories 
Sun, 23 May 2004 - Tina Potterf - Seattle Times staff reporter 

 
Native American youth are aware of the stereotypes that taint 

their heritage. Ask a group of Native kids from the Swinomish tribe 
near La Conner, Skagit County, about what it means to be an American 
Indian, and you may be surprised by their candor and insight: 

"You probably think I'm another stoned Indian. Well, you're 
wrong. I'm going to become a lawyer."… 

[About] Native Lens. Later this month, the short digital films 
created by Swinomish youth will be available for viewing online at 
www.911media.org. … Through Native Lens, Cladoosby said, "People can 
learn more about our culture." 

Robert Williams was one of only a few participants with prior 
experience in shooting and editing videos. "I've tried sports, 
basketball and baseball, and it didn't work out," Williams said, "So 
I picked up a camera." 

Williams, 21, has a penchant for short documentaries, mostly of 
his buddies playing basketball or hanging out, set to an underground 
hip-hop soundtrack. He hopes to build on and pass along the 
experiences gained through Native Lens, a program he said "gives us 
a chance to go back to the tribe and tell them what we have learned 
and what we've done." 

Getting the youth to think critically and creatively, and to 
empower them to share their stories with others, is ultimately what 
Native Lens is about. 

"These kids are really good storytellers... ," said Tracy 
Edwards, Swinomish education director. "I hope that they continue 
with what they learned here and bring it back to the tribe. 

"And if they have a story to tell, they can get it out to the 
community." 



 103 

To use language, 

the speaker has to know 

its real bones, guts, blood, 

spirit, mind, heart. 

He has to know its pain 

and its joy. 

He has to know its 

creation. 

And the only way he can  

is to know 

he is being created 

as he speaks it. 

He is a creator then 

of that language. 

 

Simon Ortiz, After and 

Before the Lightening, 1994 

POWERPOINT 2003POWERPOINT 2003POWERPOINT 2003POWERPOINT 2003        
 
 For beginners working with indigenous languages,  
PowerPoint allows for the creation of effective 
multimedia language lessons incorporating audio, graphics 
and text. Beginning students, sometimes affectionately 
called ‘newbies’, need very little training in computers 
before creating visually exciting slides which can support 
either oral language learning, literacy or both. 
Individually created slides are then organized into a full 
presentation or language lesson. 
 We see two important applications for PowerPoint 
for those who work with indigenous languages:  
 

1. for language advocates to use as a support for 
public presentations   

2. as a format for multimedia language lessons.  
 

 Best of all, PowerPoint is really easy to learn. Here is a brief overview of what 
PowerPoint has to offer: 
 

� Presentations consisting of a series of slides you create which can be 
projected or used to create overhead transparencies. 

� Handouts, outlines and notes can also be generated from these slides giving 
you dynamic language learning materials in hard copy. 

� You can import audio files you have created in your language into a 
PowerPoint slide. 

� You can import text files from MSWord – using Unicode or other fonts 
appropriate for indigenous languages. 

� You can add graphics – from your own scanned-in drawing, or from clip art 
or from web-based sources.  

� You can upload your presentation to the web, save it to a CD or send it to a 
friend. 

 
 We will start by showing you an example of a single multimedia slide. This 
single slide is part of a larger language lesson on animal names in Mohave. This slide 
was created by importing a sound file of a Mohave speaker (Robert Martin, 1969 tape 
recording), a picture from the Mohave coloring book and text from the Mohave 



 104 

dictionary: (If you were to click on the sound icon    , you would hear the Mohave 
word.) 

 
 

                         

    
    
    
    
    
    
Let’s Begin!Let’s Begin!Let’s Begin!Let’s Begin!    
 
Step 1Step 1Step 1Step 1: Opening the program.: Opening the program.: Opening the program.: Opening the program.    
 
There are two ways to open the PowerPoint program on your computer: 
 

1. Double click on the Microsoft PowerPoint icon on the desktop OROROROR 
2. Click on Start --> Programs --> Microsoft Power Point 

  
When the program opens, you will see this window:When the program opens, you will see this window:When the program opens, you will see this window:When the program opens, you will see this window:    
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Choose one of the following, each for a different purpose: 
 

1. ‘Open…‘Open…‘Open…‘Open…’ ’ ’ ’ if you are looking for an existing Power Point OROROROR    
2. ‘Create a new presentation’‘Create a new presentation’‘Create a new presentation’‘Create a new presentation’ if you want to make a language lesson or a public 

presentation.      
 
Note: If you have already been working on a presentation select the  ‘Open….’ button – 
Then select your presentation – and then click on OK – your named and saved 
presentation should be there!  
 

 
 
Step 2:Step 2:Step 2:Step 2: Choose ‘ Choose ‘ Choose ‘ Choose ‘Create a new presentation’ Create a new presentation’ Create a new presentation’ Create a new presentation’ to begin constructing your multimedia to begin constructing your multimedia to begin constructing your multimedia to begin constructing your multimedia 
language lesson.language lesson.language lesson.language lesson.        
    
This window opens automatically 
when you choose ‘Create a new Create a new Create a new Create a new 
prespresprespresentation’ entation’ entation’ entation’ button. 
    

. 
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Step 3:Step 3:Step 3:Step 3: Choose a Slide Layout Choose a Slide Layout Choose a Slide Layout Choose a Slide Layout    

 
 
For Example, if you choose ‘Blank presentation’‘Blank presentation’‘Blank presentation’‘Blank presentation’, the following screen will appear: 

 
 
 
 
 
 
 
 
 

 
 
You can then scroll up and down with 
the menu on the far right of the screen 
to choose a layout.  If you choose 
‘From design template’ ‘From design template’ ‘From design template’ ‘From design template’ different choices 
will appear in the menu on the far right 
of the screen:     
 

 
 
 

 

This menu is located on the far 

right of your screen.  It provides 

information and previews of your 

presentation.  This window gives 

you some formats to choose from. 

Just click one of the layout images 

and the menu will change to show 

different layouts that you can 

choose.  
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Step 4:Step 4:Step 4:Step 4: Apply a design template or background color Apply a design template or background color Apply a design template or background color Apply a design template or background color    
    
 Applying a design template is an easy way to make your lesson(s) colorful. To 
apply a template, click on one of your choice.  It will then be posted on the screen.  If 
you want to change the template simply click on the next one of your choice.  If you 
want to use the template for all of your slides, move your pointer to the right of the 
template design and click on the down arrow.  A small drop down menu will appear 
where you can select ‘Apply to All Slides’.‘Apply to All Slides’.‘Apply to All Slides’.‘Apply to All Slides’. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
Apply a background color:    
    
If you want a different color 
scheme, click on the ‘Color ‘Color ‘Color ‘Color 
schemes’ schemes’ schemes’ schemes’ button and choose your 
colors by clicking on your 
choice:     
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To create different color schemes, click on ‘Edit color schemes’‘Edit color schemes’‘Edit color schemes’‘Edit color schemes’ which is located at the 
bottom of the Slide Design 
menu. 
 
First, the Edit Color Schemes 
box will appear, then, click on 
the ‘Change color’‘Change color’‘Change color’‘Change color’ button.  The 
Background color box will appear 
as shown above.  Then, you can 
choose between a Standard color 
or a custom color. 
 
The background of your 
presentation can also be changed 
with ‘Fill Effects’‘Fill Effects’‘Fill Effects’‘Fill Effects’.  Choose FormatFormatFormatFormat from the menu bar, then click on ‘Backg‘Backg‘Backg‘Background…’round…’round…’round…’.  
The screen below will appear and you can adjust Gradient, Texture, Pattern and Picture. 
 

 
 
    
    
    
    
    
    
    
    
    
    
    
    
You now have many, many ways to make your slide bright and engaging You now have many, many ways to make your slide bright and engaging You now have many, many ways to make your slide bright and engaging You now have many, many ways to make your slide bright and engaging –––– GO FOR  GO FOR  GO FOR  GO FOR 
IT!IT!IT!IT! 
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Step 5:Step 5:Step 5:Step 5:  Understanding the PowerPoint Screen from the   Understanding the PowerPoint Screen from the   Understanding the PowerPoint Screen from the   Understanding the PowerPoint Screen from the NorNorNorNormal Viewmal Viewmal Viewmal View    
    
 
  Standard toolbar   Formatting toolbar 
 
          Common Tasks  

    
                                                                                
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

    
    
    
    
    
    
    
    
    
    

    

Exercise 1:  Time to Practice! 
 

� Open Power Point 
� Choose ‘Create new presentation’ 
� Apply either a ‘design template’ or a background color 
� When you want to add another slide, click on ‘Insert’ and this menu will appear  

 

                
 

� And you are ready to build your presentation or language lesson! 

Menu toolbar 
 
 
 
 
 
Outline window 

View Choices 
 
Slide Status 
 

Drawing toolbar    Notes window   Slide window 
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There are two ways to access views of your slides:There are two ways to access views of your slides:There are two ways to access views of your slides:There are two ways to access views of your slides:                

        
        
    

                    
    
             [normal]      [normal]      [normal]      [normal]      [slide sorter]  [slide show] [slide sorter]  [slide show] [slide sorter]  [slide show] [slide sorter]  [slide show]    
    
    

                    
                                                                                                                                                                                                                                                                            
    
    
    
            
    
    
Click the Click the Click the Click the Slide Show Slide Show Slide Show Slide Show button on main tool bar to view the complete show on the full button on main tool bar to view the complete show on the full button on main tool bar to view the complete show on the full button on main tool bar to view the complete show on the full 
screen!screen!screen!screen!    
    
 
    
                                                                                                                                                                            
    
    
    
    
    

Remember:  BE FEARLESS!Remember:  BE FEARLESS!Remember:  BE FEARLESS!Remember:  BE FEARLESS!    

    

As in Microsoft Word, there is always the command, “ Edit…..Undo” . This process will reverse 

your mistakes, so don’t be afraid to try anything… 

                                                                                                                                        

Slide Sorter View:Slide Sorter View:Slide Sorter View:Slide Sorter View: Slides can be 
ordered and sorted from this screen. 
Just click on a slide to select it and 

drag it to where you want it placed. 

Click ‘Edit’ 

 

Select ‘Undo…’ 

� Click on ‘View’ on the main tool bar which 
gives you this menu 

� Choose a symbol from the bottom left 
corner of the PowerPoint screen 

 

Normal View: Normal View: Normal View: Normal View: This view shows 
the presentation outline on the 
left, the slide in the main 
window and allows for notes at 
the bottom. 
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Step 6:Step 6:Step 6:Step 6: Inserting a Gr Inserting a Gr Inserting a Gr Inserting a Graphic Elementaphic Elementaphic Elementaphic Element    
    
 There are many sources which can be used to bring graphics (pictures, drawings, 
even videos) into a PowerPoint slide. Using Adobe Photo shop, you can enter your 
own pictures or drawings and scan them to your computer. You can then import them 
into PowerPoint. You can also use ‘clip art’clip art’clip art’clip art’ already handy on your computer or 
available from a number of online sources. You will need to become familiar with the 
‘insert’ menu:             
    

    
    
Let’s begin by inserting a picture from ‘Clip Art’ locateLet’s begin by inserting a picture from ‘Clip Art’ locateLet’s begin by inserting a picture from ‘Clip Art’ locateLet’s begin by inserting a picture from ‘Clip Art’ located on the drawing tool bard on the drawing tool bard on the drawing tool bard on the drawing tool bar    
 

 
 
Notice that there is also ‘Word Art’Word Art’Word Art’Word Art’ available 
 
 
 
 
 
 
 
 
 
 

Resizing Pictures: 

 

Pictures and other graphic elements are marked by small boxes 

on each side. You can resize pictures by clicking on these boxes 

and dragging them – a double arrow will appear. A Plus sign, + , 

means you can move the whole image. 
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Step 7:Step 7:Step 7:Step 7: Inserting Text Inserting Text Inserting Text Inserting Text    
 
PowerPoint allows you to type directly into a slide by inserting a ‘Text Box’. Go to 
‘Insert’ on the main menu and select ‘Text Box’. Using the mouse, put your cursor 
where you want the text to appear and click within the box to begin typing. You may 
also import text material from other software programs like Microsoft Word, see 
exercises below. 

Exercise 2: Working with Clip Art 
 

� Open a new slide under ‘Insert’ on the menu tool bar                     

                         
� Locate the cursor on your open slide where 

you would like to insert a picture 

� Click on ‘Insert’ on the menu tool bar 

� Choose ‘Picture’ (You may have to extend the 

menu) 

� Choose ‘Clip Art’ 

� Select a picture (NOTE: you can choose a 

picture available on your computer or select 

to go online to find more clip art.)                             
 
 

� Click on a picture and it will be inserted into 

your slide.  

– You can resize the picture if you select it 

once it is inserted  

– You can also move it if you are working 

with a blank slide.   
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Step 8:Step 8:Step 8:Step 8: Inserting Sound Elements Inserting Sound Elements Inserting Sound Elements Inserting Sound Elements    
    
There are several ways to bring sound into a PowerPoint slide: 
 

� You can create a sound file using PowerPoint itself 
� You can create sound files on other software, like Audacity, then import the 

sound files to your PowerPoint lesson. 

Exercise 3:        Type directly or insert Word Art    

 

� Type a word or sentence on your slide related to the 

picture you chose. 

� Exercise 3a: Import from Microsoft Word 

� Minimize your PowerPoint presentation 

� Open Microsoft Word 

� Highlight whatever you typed 

� Right click and choose ‘Copy’‘Copy’‘Copy’‘Copy’ 

� Minimize your Word document  

� Maximize your PowerPoint presentation      

             

 

 

 

� Place the cursor where you want the text to appear then Right click and choosRight click and choosRight click and choosRight click and choose e e e 

‘paste’‘paste’‘paste’‘paste’ 

 

This seems like a lot of extra work, but if you have created a Word document using 

Unicode or other fonts, you will want to import the document! 

 

                          
                                 

      Navajo PowerPoint contributed by Benny Hale 
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� You can import sound files from outside sources, like old tape recordings. In 
this case, you need to bring them into Audacity, for instance, and create 
wave files to save for use in language lessons. To use files from outside 
sources like audio tapes, see the section of these materials using Audacity 
software. 

 
 Using PowerPoint as a recording source for sound files Using PowerPoint as a recording source for sound files Using PowerPoint as a recording source for sound files Using PowerPoint as a recording source for sound files    

    
        
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

Exercise 4: PowerPoint for sound files 

    

� Place your cursor anywhere on the slide you are working on 

� Click on the ‘‘‘‘Insert’’’’ menu  

� Click on ‘‘‘‘Movies and Sound’      

 

 
� Click on ‘‘‘‘Record Sound’  

 

                                     . 
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Inserting Sound from filesInserting Sound from filesInserting Sound from filesInserting Sound from files    
 
 If you have been working with Audacity or any other sound software, you can 
add your saved sound files to your PowerPoint.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 4 (cont.): 

� You will now have a small window which looks and acts like a tape recorder.  

 

 
 

� Point and click on the red button and ‘‘‘‘Record’ a word to match the picture you 

have chosen 

� Click on the center button to ‘Stop’ 

� Click on the left arrow to ‘‘‘‘Play’’’’ 

� A sound icon        will automatically appear on your slide 
 

Exercise 5: Sound from PowerPoint files 

    

� Click on the ‘Insert’ menu 

� Select ‘Movies and Sound’ 

� Click on ‘Sound from File’     

 

 

                                                  

� And you will see a list of the sound files you have saved as wave files    

� Select the file you want and click ‘OK’  
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As PowerPoint pulls sound into your slide, you will see this window.  
    

            
    
 You are given the choice of hearing the sound automatically or of having to 
‘click’ on the icon to hear it. For language lessons, either mode can be interesting and 
engaging. Although, making the user ‘click’ makes it more interactive. 

 
NOTE:NOTE:NOTE:NOTE: Video clipsVideo clipsVideo clipsVideo clips can be inserted into PowerPoint slides in much the same way: 

Just choose ‘Movie from File’‘Movie from File’‘Movie from File’‘Movie from File’ to import your own movie, once it has been 
captured. 
 

                                              .  
                     

  

The resulting slide will show a sound icon which you can then place near the text or 

picture if you want by clicking and dragging.                

 

                                    
                                 Mohave PowerPoint slide contributed by Amelia Flores 
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 Once you select ‘Movies from File’Movies from File’Movies from File’Movies from File’, you will get a window like this. Choose the 
file you need then click on ‘OpenOpenOpenOpen’. Once you are into your file of videos, select the 
specific one you need and click on ‘OK’‘OK’‘OK’‘OK’.  
 
Step 9:Step 9:Step 9:Step 9: Adding Animation! Adding Animation! Adding Animation! Adding Animation!  
    
        
    
    
    
    
    
    
    
    
    

     
 To use Custom Animation, choose ‘Slide Show’ from the menu tool bar and the 
screen below will allow you to create a number of exciting effects to animate and add 
unique sounds your slide!  
 

 
                                                         

Exercise 6: Animation! 
 

� Create a new slide 

� Add a graphic element of your choice 

� Click on the ‘Animation Schemes’ link 
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Congratulations!Congratulations!Congratulations!Congratulations!  You have just made a multimedia slide for use in a language lesson! 
 
Here are some reminders from PaHere are some reminders from PaHere are some reminders from PaHere are some reminders from Part I about creating language lessons:rt I about creating language lessons:rt I about creating language lessons:rt I about creating language lessons: 
 

- Think of a single lesson only in the context of a larger unit of study 
- Be sure the data is accurate 
- Plan carefully before beginning 
- Think ‘Immersion’ – use the native language as much as possible 
- Make it bright, active and fun! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    
 
 
 
 

Once-dying Chinook language finds future  
in voices of children 

Tue, 8 Jun 2004  -  Nancy Bartley  - Seattle Times staff reporter 
 
GRANDE RONDE RESERVATION, Ore.  
 

To Tony Johnson, the Chinook jargon widely spoken by his 
ancestors was not just a second-class language used for trade but a 
language of tribal rituals, family gatherings and courtship. Until 
recently, it was almost extinct. 

Now, due largely to the 33-year-old Johnson, who regards each 
word of his ancestral tongue as an heirloom, the jargon also known 
as "Chinuk-wawa" has become a language of the future. In the seven 
years he has worked for the Confederated Tribes of the Grand Ronde 
to revitalize the language, Johnson, who grew up in Raymond on 
Willapa Bay, has developed a teaching program that has become a 
model for tribes around the region. 

What makes the program successful is the traditional 
master-and-apprentice approach, in which students learn from elders, 
then become teachers themselves. That's coupled with the more 
modern-day concept of language immersion, in which students speak 
Chinuk-wawa in and outside the classroom. …Now the Grand Ronde 
program is so successful…, children here use Chinuk-wawa to keep 
secrets from adults. 
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PowerPowerPowerPowerPoint examples:Point examples:Point examples:Point examples:    
 
These first few examples show how PowerPoint can be used to support public 
presentations about language.  
 
 
 
 
 
 
         
 
 
 
 
 
 
 
 
 
                                                                  Maureen Salzer 

 
 
 
      Phil Cash Cash 
 
 
 
 
 
 
 
 
 
                                        

Susan Penfield 

 
 

Mohave Sentence
S

NP VP

V

1st person    subject        verb stem    tense

inye--ch matapoi=k

inyech matapoik

I am hungry

 

Subject Marker on phrase
• Morphemes: small units of meaning

- ny = the

- kw ..ny= [one] that  (like adding –er)

- ch = subject marker

- k /-m =  verb marker 

• Humar poshny kwa’aavnych Joe iyuum

child   cat   that   heard     Joe    sees

The child that heard the cat sees Joe
 

CREATING A LANGUAGE 

LESSON PART ONE

Lessons, Audience and 

Purpose

Prepared for Colorado River Indian Tribes by 

Maureen Salzer, Technical Advisor to the

University of Arizona’s Gates Grant for 

Indigenous Language Revitalization

March 2003

  Overview: Creating a Language 

Lesson for Your Community

This presentation will try to help you 

answer these questions:

What is a lesson?

Who is your audience?

What is your purpose?

What are some ways of designing effective 

lessons?
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Below are sample slides done by CRIT participants and students from the American 
Indian Language Development Institute. Most have audio files attached. Active samples 
can be seen on our website at www.        
 

                        
                        
    
    
    
    

                    
 

   
 
 
 
 
            
 
 
 
 
 
 
 
 
 
         
 
 
 
 
 
Vangie Warwick, White Mountain Apache 
 
 

 

 

 

Ka Ka Pï`äpäPï`äpä `o `o Hawai`iHawai`i

A, E, I, O, U

H, K, L, M, N, P, W, `

 Ka Ka PPïï`̀ääppää `o `o Hawai`iHawai`i

shark

 

Candace K. Galla, 

Hawaiian 

ashdla’ hashk’aan

 

Kim Matheson, 

Couer d’Alene 

Amelia Flores, Mohave 
Delphine Tsinajinnie,  

Navajo 

Tracy Williams, Oneida Lonnie Wilder, Hualapai          
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Arlene Joyce Hughes, 
Akimel O’odham and a teacher at Gila Crossing School in Arizona created 

this original art and story to support an Indigenous language lesson. 

 
 
 
        
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Simple Commands
• Come Here.

• Oig ‘i-him

 

 

Rhonda Antone, Cathy Ross and Yolanda 
Two Two worked together to create a 
presentation for teachers new to their 
community and to the Tohono O’odham 
culture and language. 
      

Nora Vasquez, 
Chemehuevi 
Art by Ryan Smith  
scanned in from the 
Chemehuevi Coloring 
Book. 

♦ This w as p roduced  by th ree  O ’odham

teachers  du ring  the  A ILD I 2004  session  a t 

the  U niversity o f  A rizona .  It is  a  v isua l and 

aud io  in troduction  o f the  Tohono O ’odham

language  and  a lphabet sound  system .  T h is 

is  fo r the  new  teachers com ing  in to  Indian  

O asis-B aboqu ivari U nified  Schoo l D istric t 

40 .

Tohono O ’odham A lphabet Sounds

 

Revised by:Revised by:Revised by:Revised by:

Kristen R. Walker and Joycelene Kristen R. Walker and Joycelene Kristen R. Walker and Joycelene Kristen R. Walker and Joycelene 
JohnsonJohnsonJohnsonJohnson

Reillustrated by Jason DillonReillustrated by Jason DillonReillustrated by Jason DillonReillustrated by Jason Dillon

Original version:Original version:Original version:Original version:

Written by, Jack L. CrowderWritten by, Jack L. CrowderWritten by, Jack L. CrowderWritten by, Jack L. Crowder

Illustrated by, Christina A. Illustrated by, Christina A. Illustrated by, Christina A. Illustrated by, Christina A. 
CrowderCrowderCrowderCrowder

 
Kristin Walker, a teacher 
from San Carlos Apache 
schools worked with a 
tribal elder, Joycelene 
Johnson and illustrator 
Jason Dillon to revise 
this earlier book by Jack 
L. Crowder. It presents 
seven Apache verbs 
acted out by ‘Cactus Boy’ 
and supported by oral 
language only. 

Teaching on the Tohono 
O’odham Nation
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MMMMICROSOFT PUBLISHER 2003ICROSOFT PUBLISHER 2003ICROSOFT PUBLISHER 2003ICROSOFT PUBLISHER 2003        
 
 Microsoft Publisher is a desktop publishing application from Microsoft.  This 
entry level desktop publishing application provides the user to create a variety of 
materials, such as books, brochures, business cards, calendars, certificates, newsletters, 
invitations, and much more.  Publisher 2003 is bundled with Microsoft Office 2003 
Small Business and Professional Editions.  
 For this exercise, Creating a Storybook, you will learn how to create a book that 
can be printed at your home, office, or school setting to be reproduced at your leisure, 
without the hassle of trying to find a publisher who will not compromise your story. 
 
Exercise: Creating a StorybookExercise: Creating a StorybookExercise: Creating a StorybookExercise: Creating a Storybook    
 
Setup 
 
Step 1: Open Microsoft Publisher 

� Click on the Start menu 
� Click on Programs 
� Scroll to Microsoft Publisher and click 

Step 2: Open a New File 
� Under the File menu, choose New. 

Step 3: Page Setup for a Booklet Layout 
� Under the File menu, 

choose Page Setup (A 
Page Setup screen will 
appear) 

� Click on the Layout tab 
and under the publication 
type, click Booklet.   

Step 4: Click OK 
� Under Printing Options – 

Orientation, click on 
Landscape.  Set the width 
to 5.5” and Height to 
8.5”. 

Step 5: Layout Pages 
� Once you have completed your page setup, this dialogue box will appear.  

Click Yes to automatically insert 3 pages. 

 

Don’t forget to 

 save your work 

periodically! 
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� At the bottom of your screen, you will see this page 
layout. 

� It is recommended that when you add pages to your book, that you add 
pages in multiples of four.   
o Try this exercise – Take a piece of paper and fold it in 

half.  Starting with the front page, number it page one 
and continue until page four. You will notice that from 
each folded sheet of paper, you are essentially creating 
four pages total.  

Step 6: Adding Pages 
� We want our book to have 8 pages 

total (remember we need to add 
pages in multiples of four), so we 
need to add 4 additional pages.   

� Go to the Insert Menu and click on 
Insert Page (An Insert Page screen 
will appear). 

� Type in the number 4 into Number 
of New Pages.  For this example, 
we will indicate that we want to 
insert blank pages after the current 
page.  

� You will now see this page layout at 
the bottom of your screen.  

 

Inserting Text and Graphics 
 
Step 7: Inserting Text 

� To insert text, click on the textbox icon         (found on the vertical 
Objects toolbar to the left of your screen)  
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handles 

� Now, click anywhere on the page where you would like 
your text. 

� A text box will appear on your page.  In the text box, you will see 
a blinking cursor.  Begin typing your text.  

� To resize your text box, position the mouse 
pointer over one of the handles (small shapes 
displayed around an object when the object is 
selected) and then drag the mouse. 

� TIP: If part of your text does not appear in the 
text box,  

� Enlarge the text box larger 
� Change the text size 
� Delete some of the text 

Step 8: Inserting Graphic Objects 
� To insert a graphic object, click on the Insert menu, find Picture, 

and then click on Clip Art… or From File… (see section on Microsoft 
Word and/or PowerPoint) 

 
Printing & Finishing Touches 
 
Step 9: Printing 

� Once you are done editing, it is time for you to print your storybook.  
Depending on the capabilities of your printer, you may be able to do duplex 
printing (printing on both sides of a sheet of paper).  You will need to 
review your printer manual.  If your printer is not capable of duplex 
printing, you can print out each page one by one and manually feed your 
printer.  This may take some trial and error, but it will be worth it. 

� Go to the File menu and click on Print (a Print screen will appear). Click on 
Properties.  Again depending on the capabilities of your printer, you may or 
may not find an option that allows you to do duplex printing.  If you do, 
click on it and click OK until you are back to the Print screen. 

� If your printer allows for duplex printing, a screen may appear that will 
guide you through your printing process and may require additional steps. 

Step 10: Finishing Touches 
� Once your storybook has been printed, fold in half and bind using a long 

reach stapler. 
 

Enjoy reading your storybooks to friends and family! 
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MMMMAXAUTAXAUTAXAUTAXAUTHORHORHORHOR 

________________________________________________ 
 

 
 

Under the direction of Scott Brill and in conjunction with the Critical Languages 
Program, the University of Arizona Computer Aided Language Instruction Group 
(UACALI) has made freely available for non-commercial use its MS-Windows and 
Internet based multimedia CALL authoring system.  MaxAuthor has been under 
development for 14 years and was used by authors nationwide to create the recently 
published Critical Languages Series CD-ROMs.  Without any programming, MaxAuthor 
lets you create language instruction courseware for Chinese, Japanese, Korean, and 44 
other languages, including several Native American languages.  MaxAuthor requires 
Windows 95/98/NT/2000/Me/XP, 486 (or better), 16MB RAM minimum, SVGA (or 
better), sound card, speaker, 9MB disk space, microphone recommended. In this section, 
you will be introduced to the basic MaxAuthor capability.  For more information, see 
the full description of MaxAuthor at www.cali.arizona.edu. 
 
Capabilities:Capabilities:Capabilities:Capabilities:    

 
MaxAuthor works just like a text editor with tools that add audio and exercise 

material; there is no programming or scripting necessary. The author records separate 
audio for both sentences and words and has the option of recording audio in the 
training language only, but can also record translations or paraphrases. The author 
selects one of the 5 authoring views: Word, Sentence, Multiple Choice, Footnote, or 
Cloze (Vocabulary Completion). The tools within MaxAuthor let you play, record, or 
edit recordings. When the Record All menu choice is selected, MaxAuthor sequentially 
records each word or sentence. Once you record audio for your lesson, the student can 
immediately use MaxBrowser, Listening Dictation, Pronunciation, Vocabulary 
Completion, and Audio Flashcards without further customization. By adding more 
information to the lesson such as multiple choice questions, multimedia footnotes, and 
custom Vocabulary Completion blanks, you can enhance the richness of the student's 
interaction with the lesson. It's up to you, the instructor, to decide how much time you 
want to invest in your new lesson. 
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MaxAuthor treats lesson text as a collection of sentences, words, footnotes, 
multiple choices, and cloze blanks.  The instructor records separate audio for both 
sentences and words to allow the student to hear the contextual differences between 
words spoken in isolation, and words spoken in sentential context.  MaxAuthor differs 
from other multimedia authoring packages in that it is specifically built for teaching 
languages: there is no scripting language; you graphically attach exercise elements to 
specific parts of the text and there are no programming languages to learn.    
 The Indigenous languages currently supported by MaxAuthor include Navajo, 
Chemehuevi, Southern Paiute, Yaqui, O’odham, Luisedo, Nahuatl, Ojibwe (Chippewa), 
Hupa, Lummi and Mohave. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Let’s begin! 
 
 To access Max Author and to begin construction of language lessons, open 
‘Internet Explorer’ and type www.cali.arizona.edu  in the dialog box.  
 
       
 
 
 
 

 

“All over the world, all peoples have their language. And 

anyone who has no language is lost….There are some people 

who have their own language, but they do not love it. And 

those people become nothing. We do not want to end up like 

that. We want to carry forth our language and make it grow. 

There are some people who rejoice at speaking their 

language. And from this, these people do great things.” 
        

Leonzo Knight Julián, International Journal of the Sociology 

 of Language 132, 1998, pp. 183-184. 
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Tutorial 1:Tutorial 1:Tutorial 1:Tutorial 1: CCCCreating your first lesson with MaxAuthorreating your first lesson with MaxAuthorreating your first lesson with MaxAuthorreating your first lesson with MaxAuthor    
    
Step 1:Step 1:Step 1:Step 1:    
    

� Select File > New from the MaxAuthor main menu to bring up the Create 
New Max Project dialog. 

� Type in a project name (less than 8 characters with no spaces or file 
extensions), pick English as the written language for your first lesson, and 
select a directory for the new project (MaxAuthor creates a new directory for 
each project).  

� Then click OK to bring up the Enter New Lesson Information dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2: Step 2: Step 2: Step 2:     
    

� Type in your name, a short 
lesson description, and add an 
audio language (American 
English) that you will record 
later. 

� Then click OK to start editing 
your new    lesson. 

 
 
 
 
 
 

 

 



 128 

 

 

 

Step 3: Step 3: Step 3: Step 3:     
    

� Type in one sentence for your 
lesson: "The brown dog likes 
the beach."  MaxAuthor acts 
like a text editor that has 
several layers (or views) of 
information. Initially, you will 
be in Word View. For non-
English text, you can click Help 
> Keyboard Mapping to see 
how to type characters in the written language of the current document.  

 
Step 4:Step 4:Step 4:Step 4:  
 

� Add a text footnote to your 
lesson by clicking on View > 
Footnote Segments on the main 
menu. This switches you to 
Footnote View, and you will 
notice that the green F button 
is now depressed on the 
toolbar.  (Tip: you could also 
have just clicked on the F 
button directly to switch to footnote view). 

 
Step 5Step 5Step 5Step 5: 
  

� Then, highlight the word 
“beach”, and choose Segment > 
New from the main menu, and 
for the type of footnote, choose 
A text footnote. A window will 
appear where you can type your 
text footnote: “Most towns 
permit dogs on the beach”. 

� When you are finished, click the 
“Close Window” box    on the 
upper right hand corner of the footnote window.  
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� Test your lesson to see what the student will see. Make sure your new 
lesson is the active window. Click on Test > Student Max on the main 
menu. You will be prompted to first save your lesson, click OK. 

    
Step 6: Step 6: Step 6: Step 6:     
    

� The MAX Student 
application then starts up 
using your new file. 

� You will see your text 
footnote underlined in green, 
and when you click on it, 
your footnote text appears at 
the bottom of the screen.  

� Click on File > Exit to leave 
the student view and return 
to MaxAuthor: Don't forget 
that each MAX application (MAX Student, Dictation, etc.) has extensive help 
available from the main menu. 

 
 
 
 
 
 
 

    
    
    
    
    
    
    
    
    

    

Preserving Languages 
Sunday, May 16, 2004 - By W. JAMES HONABERGER - For The New Mexican 

Santa Fe, New Mexico 
 

Despite the seemingly vibrant demonstration of Indigenous 
languages, the idioms are in danger of being lost. According to 
linguists, if tribal members -- most especially the youngest 
generation -- do not learn to speak their languages, the next 60 
years might see the silence of more than 150 of the remaining 175 
Indigenous languages in the United States.  

"Many people are using the computer to create tutorial programs, 
and 
we're finding that those are very powerful tools," said Inee Yang 
Slaughter, institute director.As Native Americans fluent in their 
language grow older and take Tewa, Hawaiian or Choctaw to their 
graves, efforts to cultivate younger speakers are helping. 

[Tessie] Naranjo said language and culture have a symbiotic 
relationship."Behavior is embedded in the language; language 
reflects what the values of your community are," she said. "If you 
don't know your language, you won't learn how to be a good Tewa 
person ... or a good anything person." 
 
http://www.santafenewmexican.com/main.asp?Search=1&ArticleID=44796&S
ectionID=2&SubSectionID=&S=1 
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Tutorial 2Tutorial 2Tutorial 2Tutorial 2::::     Add audio to your MAX lessonAdd audio to your MAX lessonAdd audio to your MAX lessonAdd audio to your MAX lesson    
 
Step 1:Step 1:Step 1:Step 1:    
    

� MaxAuthor provides an easy way to record audio for each word and each 
sentence of your lesson. Although audio recording is optional, it is highly 
recommended. First, you need to delineate the boundaries of words and 
sentence segments.  

� Switch to View > Word from the main menu or click on the W toolbar 
button.  

� Highlight the first word of the lesson using the mouse or the cursor keys 
while holding down the shift key. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2:Step 2:Step 2:Step 2:    
    

� Click on Segment > New 
(or click on the Add 
toolbar button). The word 
now becomes underlined 
red with dots to show 
you that it is an 
unrecorded word segment. 
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Step 3:Step 3:Step 3:Step 3:    
    

� Do the same for the next word. Note that you can double click on a word to 
highlight it. There are two cursors in MaxAuthor, the text cursor (a blinking 
vertical line) and the segment cursor (a heavy black horizontal line). The 
segment cursor may not be visible if the text cursor is not on top of a 
segment. 

� If you misplace a segment's boundaries, you can remove it by clicking once 
on it and selecting Segment > Delete and trying again. You can also tweak a 
boundary by using Segment > Boundaries. Note that segments of the same 
type must not be overlapping. 

  
 
 
 
 
 
 
 
 
 
 
Step 4:Step 4:Step 4:Step 4:    
 

� A quick way to segment is to highlight an entire section of text and choose 
Automatic Segmentation. MaxAuthor provides its best guess for the segment 
boundaries that you can later fine tune.    

� Highlight the rest of the sentence that is not segmented so far and click on 
Segment > Automatic Segmentation. 
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Step 5:Step 5:Step 5:Step 5:    
    

� To record the word 
segments in your 
lesson, make sure your 
microphone is working, 
click on the first 
segment and choose 
Audio > Record All 
Segments. 

� The MAX Audio 
Recorder dialog box 
will pop up.  

� Click on Record to start recording the underlined word segment. Recording 
continues until you click ‘Stop’ Then, ‘Play’ your recording, re-record it, or 
‘Save’ it. After you have saved it, you will automatically be prompted to 
record the next word, and so on. 

 
Note: on some versions of Windows, the Windows Taskbar can obscure the MAX 
Audio Recorder and other input windows.  We recommend that you set your taskbar 
option to Auto Hide. 

 
Step 6:Step 6:Step 6:Step 6:    
    

� When you are about to 
record a word that has 
already been recorded, 
MaxAuthor plays the already 
recorded word and you can 
elect to Borrow the previous 
recording or record a new 
one. 

 
Note that the segment changes from a 
dotted line to a solid one once you 
have recorded it. 
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Step 7:Step 7:Step 7:Step 7:    
    

� Switch to View > Sentence Segments and create the sentence segment. You 
should include trailing punctuation as a part of the sentence. When you create 
a sentence segment, you are 
prompted for Dictation 
Presentation Order (starting 
from 0). In this way, you can 
control the order of presentation 
for each sentence in the 
Listening Dictation Exercise, or 
choose  ‘Don’t Use’ if a 
sentence is too long, too short, 
or otherwise not appropriate for 
a listening dictation exercise.  

� Click OK. 
� Record the sentence segment by clicking once on it and choosing Audio > 

Record All Segments. 
 
Step 8: Step 8: Step 8: Step 8:     
    

� Click on Test > Student 
Max to test your lesson. The 
student has 3 views of the 
lesson text: Word, Sentence, 
and Footnote. When in 
Word View, the student can 
click on your words to hear 
them.  Note that the 
Dictation, Flash card, and 
Pronunciation exercise 
buttons are now enabled because word and sentence recordings have been 
created.  Try out these exercises to see how they utilize your recordings. 

� Select File > Exit from Student Max, returning you to MaxAuthor.  
 
 
 
 
 

 

 

NOTES:_______________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________ 
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Tutorial 3:Tutorial 3:Tutorial 3:Tutorial 3:    Add a multiple choice exercise to your MAX lessonAdd a multiple choice exercise to your MAX lessonAdd a multiple choice exercise to your MAX lessonAdd a multiple choice exercise to your MAX lesson 
 
Step 1:Step 1:Step 1:Step 1:    
    

� MaxAuthor provides 
an easy way to add 
an optional multiple 
choice exercise to 
your lesson.  

� Click on View > 
Multiple Choice orororor 
click on the M 
toolbar button, and 
highlight the word 
“beach”. 

 
We are attaching the multiple choice to this word because we want to draw the 
student's attention to the word when we ask the multiple choice question 

 
Step 2:Step 2:Step 2:Step 2:    
    

� Click on Segment > New and the Multiple Choice Edit dialog box appears. 
�  In the Optional 

Multiple Choice 
Question Prompt box 
type “what is the color 
of the beach?”  

� This is the question 
that will be asked of 
the student.  This 
question can be written 
in the target language 
or in English. 
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SteSteSteStep 3: p 3: p 3: p 3:     
    

� Click on the ‘Add’ button 
and type “Red” and click on 
OK, then add “Brown”, 
“Green”, and "Unknown".  

� Now click on “Unknown”  
and then ‘Select Answer’, 
and you will see the A 
designator move to it.  This 
is the correct answer that 
the student will hopefully 
select.  

� Click on OK to dismiss the dialog box.  
 
Step 4:Step 4:Step 4:Step 4:    
    

� Now, test your lesson by 
choosing Test > Multiple 
Choice.  

� Select OK to save your 
lesson. 

� Click on File > Exit to 
return to MaxAuthor.  

 
Note that the student can keep trying 
the ones incorrectly answered until 
they are all correct.  

 
Step 5:Step 5:Step 5:Step 5:    
    

� To further edit your multiple 
choice question, either click once 
on the segment and select 
Segment > Properties, or simply 
right click on the multiple choice 
segment to bring up the Multiple 
Choice Edit dialog box again. You 
can right click on almost any type of segment (footnotes, word, sentence, 
etc.) in MaxAuthor to view or change the segment's properties. 
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Tutorial 4Tutorial 4Tutorial 4Tutorial 4:::: Add a fillAdd a fillAdd a fillAdd a fill----inininin----thethethethe----blank (Cloze) exercise to your MAX lessonblank (Cloze) exercise to your MAX lessonblank (Cloze) exercise to your MAX lessonblank (Cloze) exercise to your MAX lesson    
 
Step 1: Step 1: Step 1: Step 1:     
    

� MaxAuthor lets you add an optional Fill-in-the-blank exercise to your lesson. 
This is also called a 'Cloze' or 
'Vocabulary Completion' exercise. 
The student's job is to type in the 
correct character(s) for each blank 
or, alternately, select the proper 
answer from a choice list. 

� Click on View > Cloze Segments 
or click on the C toolbar button. 

� We could use automatic 
segmentation to place Cloze 
blanks every Nth word, but in 
this case, we will place the segments manually. To create your first Cloze 
Segment, highlight the word “dog”. This is going to be the word we 'blank 
out'. 

 
Step 2:Step 2:Step 2:Step 2:    
    

� Click on Segment > New which 
brings up the Cloze Segment 
Properties dialog box.  

� There are two properties of a 
Cloze segment that can be 
changed, the Question Format and 
the Answer Judging.  The 
Question Format is either 
<<student types in answer>> (the 
default) or the name of a choice 
list that the student will pick 
from. Choice lists can be shared 
between Cloze segments, which 
can save a lot of typing 

� For this segment, we will just accept the defaults, so just click on OK.                   
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Step 3Step 3Step 3Step 3::::    
 

� For the next cloze segment, 
we are going to present the 
student with a few choices 
that they can select from, so 
they don't have to type in the 
answer directly. 

� Highlight the word “brown”, 
and click on Segment > New, 
and in the Question Format 
box, click on the ‘Edit’ button.  

� In the Cloze Question Format dialog box, click on the ‘New’ button.  
 
Step 4: 
 

� In the List Name box, type 
“colors”. This name is only 
used for the author’s benefit, it 
is never shown to the student. 
Other list names could be: 
"nouns", "adjectives", etc. Notice 
that “brown” is already in the 
list because it is the correct 
answer and must be a choice 
that the student will have.  

� Click on ‘Add’ to add a new color (distractor) to the list, and type “red”.  
 
Step 5:Step 5:Step 5:Step 5:    
    

� Now click OK, and you will see that 
the “colors” choice list is now 
associated with the blank you’ve been 
working on.  

� Click on OK to dismiss the Cloze 
Question Format dialog box, and then 
OK to dismiss the Cloze Segment 
Properties dialog box. Test your lesson 
by choosing Test > Cloze and select OK to save your lesson.OK to save your lesson.OK to save your lesson.OK to save your lesson.  
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Step 6: Step 6: Step 6: Step 6:     
    

� The student is shown two blanks and if they click on the first blank they 
have to pick from two choices: red or brown.  If they click on the second 
blank, they have to type in the answer. 

� When they click on ‘Check’, the student's answers are compared to the 
correct answers and displayed. 

� Click on ‘Back’ to return to MaxAuthor. 
 
 

Student’s View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Food for thought:  

 

Does the language we speak shape the way we view the world?  

 

 “…Navajo classifies objects into a variety of categories, 

depending on such characteristics as shape and rigidity …for example, 

round object, long rigid object, long flexible object, flat flexible 

object…and so on. Therefore, the category to which an object belongs 

determines which verb stem is used in talking about it. [Therefore] the 

verb for ‘pick up’ will be different in sentences such as “I pick up a 

cigarette”, I pick up a blanket” and I pick up a rope.”  

 
 ( Silver and Miller, 1997:72) 
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Tutorial 5:Tutorial 5:Tutorial 5:Tutorial 5: EEEExport your MAX lesson to the Webxport your MAX lesson to the Webxport your MAX lesson to the Webxport your MAX lesson to the Web 

    
              
 

    
    
    
    
    
    
    
    
    
    
    
    
    
Chemehuevi Lesson, featuring Johnny Hill, Jr., on the web at Chemehuevi Lesson, featuring Johnny Hill, Jr., on the web at Chemehuevi Lesson, featuring Johnny Hill, Jr., on the web at Chemehuevi Lesson, featuring Johnny Hill, Jr., on the web at www.cali.arizona.eduwww.cali.arizona.eduwww.cali.arizona.eduwww.cali.arizona.edu    

    
Step1:Step1:Step1:Step1:    
 

� MaxAuthor lets you export many 
aspects of your lessons for web 
delivery so they can be used on PCs 
using Microsoft's Internet Explorer 
4.0 or greater.  (See cali.arizona.edu 
for examples and options are detailed 
in the MaxAuthor Manual available 
through the same website.) 

� Click on File > Export HTML and 
you will see this dialog box.  Now, 
click on the ‘OK’ button to convert 
your MAX lesson to HTML format.  Note that several HTML files are 
created in the same directory that your MAX lesson is in.  These files 
control the web delivery and should not be modified.  

� After MaxAuthor creates the HTML files for your lesson, you have the option 
of viewing the files in your default browser. If you say ‘Yes’, MaxAuthor 
instructs your browser to load the top level HTML file created for the lesson 
which in this case is the local file: c:\tempd\maxnet\eng\myfirst\myfirst.max.   
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Step 2: 
    

 You can try out all the lesson activities the student will see (except for Flashcards 
which must be accessed using an http: URL).The left hand frame is used for navigation and 
the right hand frame for the various views and activities of the lesson. Since the 
lesson's name was myfirst.max, the 
file to point your students to is 
myfirst.htm.  If you want to put the 
lesson files on your web server, copy 
(or FTP) the entire lesson directory 
to your server.  In this case you 
would copy the directory 
C:\tempd\maxnet\eng\myfirst to your 
web server.  
 Let's say your web server's 
name is http://myschool.edu/ and 
your subdirectory is me, and you 
copied your myfirst lesson directory 
and all files to me, then the URL of your lesson would be: 
http://myschool.edu/me/myfirst/myfirst.htm 
 
Note: Each lesson must remain in a separate directory (you can't copy more than one lesson's 
HTML files into one directory because of file name conflicts).   

  
 If your web server has 
case-sensitive filenames, you may 
need to set your FTP program so 
the filenames are forced to be 
lower case when transferred.  
Shown at right is the Options 
screen from WS FTP as an 
example. We hope you've enjoyed 
this tutorial!  Mail comments to: 
brill@arizona.edu    
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FFFFRONTPAGERONTPAGERONTPAGERONTPAGE 2000 2000 2000 2000    
    

If you are anxious to publish your materials on the Web, using FrontPage is a 
very easy way to do it. To begin, you need to contact your Internet provider. They will 
create an account and give you information about how to log in. You can also create 
your web page and files without publishing them. That is, you have a choice, within 
FrontPage, of working locally (the “C” drive) or working while connected to the Web 
(either Internet Explorer or Netscape). We recommend working while on the Web if 
possible.  
 
Ten steps to get you started Ten steps to get you started Ten steps to get you started Ten steps to get you started with FrontPage:with FrontPage:with FrontPage:with FrontPage:    
 
Step 1:Step 1:Step 1:Step 1: Open FrontPageOpen FrontPageOpen FrontPageOpen FrontPage 

� Go to ‘StartStartStartStart’ 
� Go to ‘Programs’‘Programs’‘Programs’‘Programs’ 
� Click on Microsoft FrontPageMicrosoft FrontPageMicrosoft FrontPageMicrosoft FrontPage  

 
 

 
 



 142 

Note:Note:Note:Note: Not all Internet Service Providers (ISPs) provide Web space and only select ones provide 
FrontPage extensions that allow you to work directly on the server.  If the server does not have 
FrontPage extensions, you can not drag and drop files on to the server.  You would have to 
use FTPs (File Transfer Protocols) to transfer files. 

 
 
 
Step 2:Step 2:Step 2:Step 2:  Work on the WebWork on the WebWork on the WebWork on the Web 

� Choose FileChoose FileChoose FileChoose File > Open WebOpen WebOpen WebOpen Web 
 
 
Note:Note:Note:Note: If you do not choose ‘Open 
Web’, you will be working locally 
and no one will see your page except 
you, unless you upload it. 
 
 
When the window opens, type in the URL of your Web Folder.type in the URL of your Web Folder.type in the URL of your Web Folder.type in the URL of your Web Folder. Then you will be 
asked for your username and password    
 
Step 3: Step 3: Step 3: Step 3:  Create ‘Index’Create ‘Index’Create ‘Index’Create ‘Index’ or ‘Default’ page or ‘Default’ page or ‘Default’ page or ‘Default’ page    
 

� Go to File File File File > NewNewNewNew > Page orPage orPage orPage or WebWebWebWeb 
    

    
    
    
    
    
    
    

    
    

Choose ‘Index’ or ‘Default’Choose ‘Index’ or ‘Default’Choose ‘Index’ or ‘Default’Choose ‘Index’ or ‘Default’ 
This is the basic page the Web browser will look for. 
If you do not have a page with either of these names  
on it, nothing will appear on the Web. 
FrontPage labels these pages as .htm.  
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Step 4:Step 4:Step 4:Step 4: Views of your page 
 
 There are several ways to view your page. It is important to understand the 
active editing views versus the online views. 
  
       a) Views Tool Bar       a) Views Tool Bar       a) Views Tool Bar       a) Views Tool Bar    

 
  
PagePagePagePage – actual editing page view 
  
 
FoldersFoldersFoldersFolders – what you have already saved 
 
 
ReportsReportsReportsReports – how many pages with broken links, folders that take too 
 long to load 

 
NavigationNavigationNavigationNavigation – charts for creating links and ways to organize your page
 information in a hierarchical fashion 
 
HyperlinksHyperlinksHyperlinksHyperlinks – shows graphically which files are linked to other files  
 (NOTE expanded + and - signs) 
 
Tasks Tasks Tasks Tasks – allows you to assign jobs to others working on the site 

 
 
 
 
     b) Editing View Tool Barb) Editing View Tool Barb) Editing View Tool Barb) Editing View Tool Bar    
    

  
 
 Normal ViewNormal ViewNormal ViewNormal View – view in active editing 
 
 HTML HTML HTML HTML –    to see the html code 
 
 PreviewPreviewPreviewPreview – shows how it will display  

on the web 

 

“It’s scary how important 

language is…If I only had 

someone from my school to help 

me, this is what I would do: 

Make a curriculum to benefit 

the students from kindergarten 

to eighth grade, speak just in 

my native language to the 

kindergartners, and repeat this 

system every year until the 

kindergarten children are in the 

eighth grade.” 
 

Bilingual teacher /AILDI participant. 

  

Teaching Indigenous Languages,  

Jon Reyhner, ed. 
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Step 5:Step 5:Step 5:Step 5: Internet Explorer and Netscape 

                                                    
 
To be sure that your page can be viewed through either of these browsers, 
         

� Go to Tools Tools Tools Tools > PPPPage Optionsage Optionsage Optionsage Options > 
CCCCompatibilityompatibilityompatibilityompatibility    

� Choose ‘Internet Explorer and Navigator’ Internet Explorer and Navigator’ Internet Explorer and Navigator’ Internet Explorer and Navigator’ 
by    Clicking on the downward arrow on 
the right    under ‘Browsers’    

� Choose Version 4.0 or laterVersion 4.0 or laterVersion 4.0 or laterVersion 4.0 or later ( ( ( (Do not 
worry about the bottom-checked boxes.)    

� Click on ‘OK’ Click on ‘OK’ Click on ‘OK’ Click on ‘OK’ (This prevents some tools 

from     showing that are not available in 
Netscape)     

 
    
    
Step 6Step 6Step 6Step 6:  Create a Page 
 

� Go back to File File File File > New New New New > PPPPage or Webage or Webage or Webage or Web 
� Choose ‘Index’‘Index’‘Index’‘Index’ if new 
� Choose ‘Blank Page’Blank Page’Blank Page’Blank Page’ 

 
You should be working in Normal Modeworking in Normal Modeworking in Normal Modeworking in Normal Mode.... 
  
To saveTo saveTo saveTo save the information, simply go to File > SaveFile > SaveFile > SaveFile > Save.  If you are working on the Web,  
the information will be instantly available. 
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Step 7:Step 7:Step 7:Step 7:  Designing your page 
 

There are several ways to do this. You can choose any of the following: Frames, 
Shared Borders or Tables. Here, we will use ‘Tables’ because it gives you more 
individual control and is easy to learn. 

a) Begin by going to Table on the main menu:  Go to Table > Insert > TableTable > Insert > TableTable > Insert > TableTable > Insert > Table 

 

 

  

 
 

    
Choose 1 Row and 1 ColumnChoose 1 Row and 1 ColumnChoose 1 Row and 1 ColumnChoose 1 Row and 1 Column for now 
Choose 0Choose 0Choose 0Choose 0 for borders 
Set at 100%Set at 100%Set at 100%Set at 100% - if the browser screen shrinks, your page will shrink with it. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 

 



 146 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

b) You have now created one row on your page.  
 
c) Type something, anything, within that row. Notice that if you hit ‘Enter’, it 

will drop two spaces (this is a FrontPage feature which treats each ‘Enter’ 
move as creating a new paragraph. This is good to do if you are formatting 
paragraphs differently. However, within the row you just created, if you want 
to single space hit ‘Shift – Enter’.     

 
d) Tables within tables    

 
���� To isolate items within your page, insert a table within the table you just 

created. 
���� You can center things within a given table field by using the page alignment 

menu on the Format tool bar.    
          
 
 

 
Your page design will be based on the changes in color, fonts and graphic 

images you put into your tables and on the way you choose to arrange your tables. 
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The pThe pThe pThe page below has two rows and two columns:age below has two rows and two columns:age below has two rows and two columns:age below has two rows and two columns:    
    
    
    
 
 
 
 
    
    
    
    
    
    
    
    
Step 8:Step 8:Step 8:Step 8: 
 
If you ‘right click’ you will bring up this menu: 
 

� Click on ‘Page Properties’ Click on ‘Page Properties’ Click on ‘Page Properties’ Click on ‘Page Properties’     
� You can also choose Table or Cell You can also choose Table or Cell You can also choose Table or Cell You can also choose Table or Cell 

propertiespropertiespropertiesproperties    
 
You can now make color background changes for 
your whole page, just the table or just a cell within 
the table.  
 
You can also choose colors for hyperlinks and fonts. 
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Step 9:Step 9:Step 9:Step 9:        Some things you might want to do: 
 

1.1.1.1. Create email contact: Create email contact: Create email contact: Create email contact:     
 
On your page, type in ‘contact (web page owner)’ 
Highlight what you just typed 
Go to ‘Insert’ > Hyperlink 

 
 
 
 
 

On the window, type the email address you wish to be contacted at in the bottom box. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

At left: 
 
Web page under 
construction showing 
hyperlink to owner as 
seen in ‘Normal View’  
for active editing. 
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2.  Upload documents from Microsoft Word or elsewhere.2.  Upload documents from Microsoft Word or elsewhere.2.  Upload documents from Microsoft Word or elsewhere.2.  Upload documents from Microsoft Word or elsewhere.    
 

� You must first send the information to the server. 
� MinimizeMinimizeMinimizeMinimize your FrontPage window 

- Open Windows ExplorerOpen Windows ExplorerOpen Windows ExplorerOpen Windows Explorer from the Start menu 
- Go to Programs then > Accessories   Programs then > Accessories   Programs then > Accessories   Programs then > Accessories    
- Select your fileSelect your fileSelect your fileSelect your file 
- Right click and choose ‘Copy’Right click and choose ‘Copy’Right click and choose ‘Copy’Right click and choose ‘Copy’ 
- Go back to FrontPage and click ‘Paste’Go back to FrontPage and click ‘Paste’Go back to FrontPage and click ‘Paste’Go back to FrontPage and click ‘Paste’ 

    
3. Create a hyperlink to another site. 

    
- JJJJust as you did to create an email contact:ust as you did to create an email contact:ust as you did to create an email contact:ust as you did to create an email contact:    
- Type in the URLType in the URLType in the URLType in the URL information for the link you want    
- Highlight the linkHighlight the linkHighlight the linkHighlight the link    
- Click on ‘Insert’ go to ‘Hyperlink’ Click on ‘Insert’ go to ‘Hyperlink’ Click on ‘Insert’ go to ‘Hyperlink’ Click on ‘Insert’ go to ‘Hyperlink’     

    
4.  Insert an image4.  Insert an image4.  Insert an image4.  Insert an image    

 
As in other Windows Programs, inserting a picture is done by 

 
-  Go to ‘‘‘‘Insert’ Insert’ Insert’ Insert’ on the main tool bar 
- Select ‘‘‘‘Picture’Picture’Picture’Picture’ > Choose ‘‘‘‘Clip Art’Clip Art’Clip Art’Clip Art’ 

or ‘‘‘‘From File’From File’From File’From File’ 
- Select your image 
- Click ‘Insert’‘Insert’‘Insert’‘Insert’ 

    
    
NOTE: Graphic files for Web pages are best if saved as a JPEG (.jpg) for quick 
downloading. Otherwise, it might take forever just to open your page! 
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Step 10:Step 10:Step 10:Step 10:        Save your work! Save your work! Save your work! Save your work!  
 

� Go to File > Save 

 

Recommendations: 
 

� If you are a beginner, avoid working with ‘navigation’ view. 
� Work on the Web if possible. If not, things saved in the local folder (working 

off line) can be uploaded to the Web in the same way as any other file by 
using Windows Explorer and dragging to the location 

� Although it is easy to write documents in MSWord and upload them, it is 
better in terms of html code levels to type right in FrontPage if you can. 

� Be aware that very savvy internet users can access your folders unless you 
put every thing that is sensitive to you into the folder marked -private.private.private.private. 

    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

 
 
 
 
 
 
 

 

Native Americans Strive to Retain Vanishing Heritage 
12 Jul 2004 - By Deborah Block - Browning, Montana 

 
For the Indigenous peoples of America, the Lewis and Clark 

expedition brought publicity that led to a massive influx of people 
into their native lands. The Blackfeet Indian nation of Montana is 
one of those native American tribes trying to teach its children 
about their language and culture, before the old ways completely 
disappear. 

Ernie Heavyrunner, says since so many Blackfeet no longer speak 
the language, efforts are being made to reach the children, even at 
a young age. "It's important for their identity," says the teacher. 
"It's important for them to know who they are, where they came 
from, and their language helps them to know this." 

The children sing in the Blackfeet language at a private 
elementary school on the Blackfeet reservation in Browning, 
Montana. The school, which is part of a non-profit organization 
known as the Piegan Institute, hopes to revitalize the language. 

Darrell Kipp "The fact is that our students come here and speak 
our language exclusively each day - English isn't allowed in the 
classrooms during the day. So all instruction is in our language," 
says Mr. Kipp. "Yet, our students are more articulate and better 
English speakers than their public school peers."  
 
http://www.voanews.com/article.cfm?objectID=C03EAA9D-8CB0-49BB-
88095305F37D3F85# 
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CD CREATIONCD CREATIONCD CREATIONCD CREATION    
 
If your work contains sound and images, you will want to save it on a CD. Here are 
two common ways to easily do that:  1) Windows Explorer and 2) Roxio Easy CD 
Creator. 
 
Burning CD’s in Windows Explorer 

 
 Among the currently available Windows operating systems, Windows XP is the 
first operating system to have a built-in CD writer that allows you to create or “burn” 
a data or audio CD (Compact Disc).  Writing or “burning” a CD is the process of 
optically recording data to a CD via a laser beam using a computer’s CD-ROM Drive.  
Once the data is recorded, the now portable CD is optically “read” and digitally 
transferred to your computer as stored files and folders.   
 

Steps: 
 

1. To begin, open My Computer (or Windows Explorer) and right click on the CD 
Drive.  

2. Once the menu appears, select Properties.  Properties.  Properties.  Properties.  Choose the AutoPlayAutoPlayAutoPlayAutoPlay tab, and make 
sure that Blank CDBlank CDBlank CDBlank CD is selected.  Also make sure that the button is selected in 
Prompt me each time to choose an actionPrompt me each time to choose an actionPrompt me each time to choose an actionPrompt me each time to choose an action.  This setup ensures that every time 
you insert a blank CD, you will be asked to choose an option such as “Burn 
CD” or “Open writable CD folder using Windows Explorer”.    
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3. Next, with your CD Drive (D:) Properties 
screen still open, choose the RecordingRecordingRecordingRecording tab, 
and make sure the Enable CD Recording Enable CD Recording Enable CD Recording Enable CD Recording 
on this drive on this drive on this drive on this drive option is turned on.  Now, 
click OK. 

4. Next click on your CD Drive (D:) to open 
and drag your folders or files that you wish 
to “burn” onto the open work space.  

 
 
 
 
 
5. Under the File menu choose Write these Write these Write these Write these 

files to CDfiles to CDfiles to CDfiles to CD.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. The CD Writing Wizard screen now opens.  Notice that you have the option of 
naming your CD.  Go ahead and do so and follow remaining instructions to 
complete this process. Creating or burning audio CDs follow a similar process as 
above.  This short tutorial assumes that you have created language-based sound 
files using Audacity and have created a sound in your ‘files’ folder.  

7. After inserting a blank CD, open Windows Media PlayerWindows Media PlayerWindows Media PlayerWindows Media Player. 
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8. Under the File menu, select Add to Media LibraryAdd to Media LibraryAdd to Media LibraryAdd to Media Library and navigate to Add fileAdd fileAdd fileAdd file.  
Locate your language sound files folder and click on a sound file to add.  Once 
you have added as many sound files as needed click on Copy to CD or Device Copy to CD or Device Copy to CD or Device Copy to CD or Device 
to view your sound files listing.  

 
 
 
 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
9. The sound files or songs listed under Music to CopyMusic to CopyMusic to CopyMusic to Copy are ready to be written to 

your CD.  Your playlist can be modified by checking or unchecking the box 
next to the title of your recording.   

10. Once you have a complete listing, you will notice that each recording has a 
StatusStatusStatusStatus report note such as Ready to CopyReady to CopyReady to CopyReady to Copy.  Next click on Copy MusicCopy MusicCopy MusicCopy Music button in 
the upper right.  All the tracks in your playlist will be written to CD.  
Congratulations, now you have an audio CD of your audio recordings!           
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Roxio Easy CD Creator 

    
 A commonly used software is Roxio Easy 
CD Creator. To ‘burn’ a CD using this program, 
just follow these steps. Easy CD Creator can also be used for music CD’s, but to copy 
material with language text, sound and graphics, make a ‘data CD’. 

 
 
 
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    
    

 

 

Steps: 
 

� Go to startstartstartstart button on 
bottom right of screen 

� Go to programprogramprogramprogram button 
� Go to CD writing softwareCD writing softwareCD writing softwareCD writing software 
� Go to Easy CD Easy CD Easy CD Easy CD CCCCreatorreatorreatorreator----    

This will open a window 
called ‘Select a Project’ 

� Choose to make a DATA Choose to make a DATA Choose to make a DATA Choose to make a DATA 
CD ProjectCD ProjectCD ProjectCD Project 
 

When the window appears, 
choose the folder that you want 
to copy 

 

� Click on Add Add Add Add button 
� Click on Record Record Record Record button 
� Click on Options Options Options Options button  
� Click button next to 

finalize session, not CDfinalize session, not CDfinalize session, not CDfinalize session, not CD. 
� If you do not want to add 

more to the same CD, go 
to options and click dot 
next to finalize CD finalize CD finalize CD finalize CD 

� Click on RecordRecordRecordRecord 
 

NOTE: NOTE: NOTE: NOTE: Use a CD-R or CD-RW with 
at least 24x or above for speed.    
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UUUUNIVERSITY OF ARIZONA TECHNOLOGY SUPPORT FOR INDIGENOUS NIVERSITY OF ARIZONA TECHNOLOGY SUPPORT FOR INDIGENOUS NIVERSITY OF ARIZONA TECHNOLOGY SUPPORT FOR INDIGENOUS NIVERSITY OF ARIZONA TECHNOLOGY SUPPORT FOR INDIGENOUS 
LANGUAGESLANGUAGESLANGUAGESLANGUAGES    
    
 There are two technologies which lend themselves to work with Indigenous 
languages now being used at the University of Arizona: 1) The MOO  and 2) the MBS 
or OLh board. 
 

1. The MOO: The MOO is largely text-based and can incorporate digitized tapes. It 
is asynchronous system designed to support class work online. However, the 
MOO is unique in that it has a split screen. One side is for typing text and the 
other is for the organization of objects (class room spaces and discussion topics). 
This space, however, also allows you to use anything that is on the internet. For 
working with Mohave, we used the MOO by putting a digitized tape in the 
Web-friendly side and then carrying on text-based discussions about this tape 
online between the U of A and the CRIT library. Tribal elders at the CRIT 
library could listen to the tape in segments at the same time as the linguist 
working in Tucson. They could then chat about the content of the tape. As well, 
the entire typed conversation can be recorded and archived. For those working 
on translating tapes, using a digitized segmented version is a big improvement 
over working with cassettes and constantly having to rewind even when not 
working online. 

  You are welcome to log on as a guest in the MOO and experiment with 
the environment. You can’t create objects this way, but you can get a feel for it. 
For more information about the MOO, contact Jean Kreis at the Learning 
Technologies Center (jeank@u.arizona.edu.) There is no cost associated with this 
and you may be able to use the MOO for your language work. Brief directions 
for MOO use are on the following page. 

2. The University of Arizona has also developed an online language lab. Please see 
our site at www.ole.arizona.edu. The MBS (Multimedia Board System) or OLh 
Board, is listed under ‘tools’.  This is an asynchronous system which allows for 
voice, video and text to be used online. There are several possible choices for 
working with this system. While it is still under construction, several people are 
working with it to support Indigenous languages. It will allow speakers from 
many different community locations to access oral language examples or language 
lessons online at their convenience. Information is posted much the same as one 
might do with email and can be opened at anytime. Tracy Williams, Oneida 
doctoral student in Language, Reading and Culture and Paul Lyddon, doctoral 
student in the Second Language Acquisition and Teaching Program have been 
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working together to design a number of online lessons in Oneida. Tracy has 
contributed the results of her work in the section below. We welcome others 
who would like to try this technology. For more information, contact Garry 
Forger, Assistant Director of the Learning Technologies Center at the University 
of Arizona at gforger@u.arizona.edu. 
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The MooThe MooThe MooThe Moo    
 
Steps: 
 

1. Logging on:Logging on:Logging on:Logging on: 
� Click your Start menu 
� Click on ‘ run’ 
� Type in the URL: http://oldpueblomoo.arizona.edu 
� Click on ‘connect’ 
� Log in as a guest  (Click on ‘log in’) 
 

The first page that comes up asks you for additional information  (you don’t need to 
give it…) 
 
2.2.2.2. What you will see:    

� The MOO has a split screen unlike all other programs. These define the virtual 

‘spaces’ in the MOO. The right side is web-based (anything from the Web can 
be put in this space; users can also create ways to organize this space.).   

� The left side of the page has two parts: The top part just explains what is 
going on within the MOO and tells you who else is on-line. The bottom part 
is the ‘chat’ window. 

3.3.3.3. To get around in the MOO:To get around in the MOO:To get around in the MOO:To get around in the MOO:    
� On the right side, click on objects which have an arrow beside them. You 

will move to wherever the arrow leads you… 
� On the left side, two commands are important:  

- @go@go@go@go and the name of the place (no space between @ and ‘go’). For 
example: @go the fountain. This also works for URLs @url  

 http://oldpueblomoo.arizona.edu 
- @join@join@join@join and the name of the person (no space again). For example: @go 

jeank or @go susanp 
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4.4.4.4. To ‘Chat’ in the MOO:To ‘Chat’ in the MOO:To ‘Chat’ in the MOO:To ‘Chat’ in the MOO:    
� On the lower right 

side, near the center of 
the screen, click on the 
‘say’‘say’‘say’‘say’ button. 

� Type what you would 
like to say and press 
‘enter’ 

� You can read peoples 
responses in the box 
on the upper right side. 

5.5.5.5. The ‘LOOK’ Button:The ‘LOOK’ Button:The ‘LOOK’ Button:The ‘LOOK’ Button: use 
to go back or to see 
where you are in the  
MOO.     
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The MBS Board System:The MBS Board System:The MBS Board System:The MBS Board System:    

    
URL: URL: URL: URL: http://ole.arizona.eduhttp://ole.arizona.eduhttp://ole.arizona.eduhttp://ole.arizona.edu    

 
    

 
 
    
Tracy Williams, Oneida:Tracy Williams, Oneida:Tracy Williams, Oneida:Tracy Williams, Oneida: 
 
 I am interested in online language lessons and teaching because it works across 
great distances.  I am a student in Arizona and my language is spoken primarily in 
Ontario, Canada, Wisconsin and New York.  I think this device is an important tool 
and is part of growing technological force that can be used to teach languages. 
 The above screen is the starting point for the Multimedia Board System (MBS).  
MBS is an asynchronous, interactive language teaching program with video, audio and 
text. Choose MSN or Google search engines and type in http://ole.arizona.edu. And 
click ENTERENTERENTERENTER....  The next page has information about Online Language Environments 
(OLh).  Then, click on TOOLSTOOLSTOOLSTOOLS.  
  
TOOLSTOOLSTOOLSTOOLS will take you to several choices for 
language teaching.  One is called the Ole 
Board; it is also referred to as the MBS. Both 
names are used on the website. 
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Click on OLClick on OLClick on OLClick on OLhhhh Board. Board. Board. Board.  This will take you to a new page with the Username/password 
dialog box.  You will have to obtain a Username and password from Gary Forger, 
Learning Technology Center, University of Arizona (gforger@u.arizona.edu) to enter the 
board. 
 

This is the login screen.  This login screen can be 
accessed using the Web URL: 
http://oradb.faccenter.arizona.edu/mbs5/mbsclient.html.    
 

 

 

 
 
 

 
There are two types of 
Usernames/passwords:  1) for use by 
instructor or 2) for use by student.  To 
the right is the instructor page 
Conference Listing.  A conference is the 
same as a class.  The instructor would 
then click on the correct Username. 
 
 

 
After clicking on your username, the 
next page allows you to ENTERENTERENTERENTER the 
class or check PERMISSIONS.PERMISSIONS.PERMISSIONS.PERMISSIONS.  
Permissions are set by the instructor 
for the student.  The permissions allow 
students to perform selected operations 
specified by the instructor.  The 
permission page is only accessible to 
the instructor. 
 
 
 
 
 



 161 

The instructor 
can select what 
kind of 
characteristics 
the student 
Messages will 
have.  For 
example, the 
instructor can 
specify a limit 
to the number of 
characters that a 
student can type 
in the text box.  
The instructor 
can also signify 
how long the 
audio and video 
response can 
last.  Once, the permissions are selected, click on SET click on SET click on SET click on SET PERMISSIONSPERMISSIONSPERMISSIONSPERMISSIONS and return to 
CONFERENCESCONFERENCESCONFERENCESCONFERENCES.  Below is what the student Conference Listing looks like.  The only 
difference is that the Username is identified in parentheses as student.  Then, click on click on click on click on 
the the the the USERNAMEUSERNAMEUSERNAMEUSERNAME for student access and then, ENTERENTERENTERENTER. 
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 After clicking ENTERENTERENTERENTER on either the instructor or the student conference listing, 
the above page will be displayed.  The topics or lessons to be used are listed and the 
instructor or the student can choose which ever one has been assigned.  The blue 
circles with the plus sign (+) next to it means that there are other choices located 
within that particular lesson.  When you click on the blue circle, the original lesson is 
displayed with video, audio and text (you can also use just audio and text ).  When 
you click on the plus sign (+), you can add responses to the lesson(s). 
 In order to create a new lesson, click on the capital letter ‘T’ that is located 
within a circle at the top of the screen.  This allows you to record new audio or video 
and type what you need in a text box. 
 A Flash 
Macromedia dialog 
box will automatically 
pop up.  Select the Select the Select the Select the 
ALLOWALLOWALLOWALLOW check mark.  
This will enable the 
audio and video.  
Once the new screen 
is ready, click on 
video or audio or 
both and then make 
sure to click on the click on the click on the click on the 
8KHZ8KHZ8KHZ8KHZ drop down drop down drop down drop down    
arrow and select arrow and select arrow and select arrow and select 
44KHZ44KHZ44KHZ44KHZ....        This will 
ensure the best sound 
recording.  When you are ready to record, click on the record button (the red button).  
It is possible to re-record as many times as needed.  At this point, the text box can 
also be utilized to represent what was recorded or to write messages to students.  
When the lesson is complete, click POST and the new lesson will be added to the 
choices in the conference listing.  Below is an example of a screen that is ready for 
recording. 
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I enjoyed working with this 
technology and I think it is 
very promising.  I will use it 
as a supplement or support 
for language immersion 
lessons.  One of the main 
reasons I like it so much is 
that the student can hear and 
see language lessons as many 
times as they want or need 
and, as the instructor, I can 
develop lessons that pertain to 
my student’s needs.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  
 
 

 

 

This is the first 

lesson in Oneida 

language taught by 

Tracy Williams, Ph.D. 

student in Language, 

Reading and Culture 

at the University of 

Arizona from 

Oneida, Wisconsin.  

The video, audio and 

text are displayed.  

The student can 

replay this lesson as 

many times as they 

want. 
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PART IV: RESOURCESPART IV: RESOURCESPART IV: RESOURCESPART IV: RESOURCES    

    
    
    
        
    
    
    
    
    
    
    
    
    
    
 
This section offers:  
 

1. Software Resources 
2. Selected online tutorials 
3. Selected Website 
4. Funding Sources 
5. Suggested Current Readings on Language Revitalization 

  
 There are many avenues of inspiration and support. We hope that you will 
continue your efforts to use technology in support of language and that these resources 
help you in that journey.  
 
 
 
 
 
 
 
 
 
    
 

In the introduction to her book, Bead on an Anthill, Delphine Red Shirt writes: 

 

These stories are told through the eyes of my childhood but from an adult 

perspective. They are what I remember, “Weksuye” meaning “I remember”, 

“Ciksuye” meaning, “I remember you”, “Miksuye” meaning “remember me.”  

In the process of writing these stories, I felt great satisfaction in reconnecting 

to my native language, Lakota… It came alive for me and brought back all the 

feelings I felt as a child when I first heard those words spoken. I was not sure what 

would come across to the reader. How effective it would be to use my native 

language to capture the essence of what my culture means to me and of what I 

wanted to convey about it to the reader. I know now that my writing was richer for 

its use…I am grateful to [my parents] and to my Lakota ancestors for the right to 

say in Lakota, “Le mįye,” meaning “this is who I am.” 
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SOFTWARE RESOURCESSOFTWARE RESOURCESSOFTWARE RESOURCESSOFTWARE RESOURCES    
 
Adobe ElementsAdobe ElementsAdobe ElementsAdobe Elements    
 
If you have a knack for photography and want to take your skills to a new level, 
Adobe Elements is for you.  Adobe Elements provides tools to both edit photos and 
creatively experiment with different photo options, including special effects or creating 
Web animations. For more information, visit 
http://www.adobe.com/products/photoshopel/main.html 
 
Adobe IllustratorAdobe IllustratorAdobe IllustratorAdobe Illustrator    
 
 Adobe Illustrator is a software program that provides tools for designing images 
for print, online, or other mediums.  It has many special applications, such as 3D 
effects and scribble effects, meant to enhance images. For more information, visit 
http://www.adobe.com/products/illustrator/main.html 
 
Adobe After EffectsAdobe After EffectsAdobe After EffectsAdobe After Effects    
 

This software program is designed to aid in the production of motion graphics and 
visual effects, for film, video and the Web.  According to Adobe, it is easy to learn and 
use, and has extensive visual effects. For more information, visit 
http://www.adobe.com/products/aftereffects/main.html 
 
AdoAdoAdoAdobe Premierbe Premierbe Premierbe Premier    
 
 Adobe Premiere Pro software is a nonlinear video-editing application. Powerful 
real-time video and audio editing tools give you precise control over virtually every 
aspect of your production. Built for the exceptional performance of Microsoft Windows 
XP systems, Adobe Premiere Pro takes video production to an entirely new level. For 
more information, visit http://www.marcpeters.co.uk/adobe.html 
    
AuthorWareAuthorWareAuthorWareAuthorWare    
 

 Authorware is the leading visual authoring tool for creating rich-media e-learning 
applications for delivery on corporate networks, CD/DVD, and the Web. Develop 
accessible applications that comply with learning management system (LMS) standards. 
For more information, visit 
http://www.macromedia.com/software/authorware/?promoid=home_prod_aw_082403 
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Avid XpressAvid XpressAvid XpressAvid Xpress    
 

 Avid Xpress is another option for the editing and creation of digital video.  It 
has both Windows and Mac software available and has numerous training and support 
options. For more information, visit http://www.avid.com/products/xpressdv/ 
 
DirectorDirectorDirectorDirector    
 

 Macromedia Director aids in the development of high-performance multimedia 
content and is currently being used by a number of Indigenous language advocates.  If 
you’re interested in working more with multimedia in DVDs, websites, or CDs, Director 
can be a powerful tool.  For more information, visit 
http://www.macromediacom/software/director/ 
 
Final Cut ProFinal Cut ProFinal Cut ProFinal Cut Pro    
 

 A Macintosh product used to capture DVCPRO HD over FireWire, edit using 
camera-native footage and output over FireWire with no quality loss. RT Extreme, now 
for HD, can deliver multiple HD streams, effects, filters and transitions in real-time to 
an attached Apple Cinema Display. For more information, visit 
http://www.apple.com/finalcutpro/ 
    
GoldWaveGoldWaveGoldWaveGoldWave    
 

 GoldWave is a professional digital audio editor. GoldWave allows you to play, 
edit, mix, and analyze audio and apply special effects, such as fade, equalizer, doppler, 
mechanize, echo, reverse and more. You can also digitally remaster and restore old 
recordings with noise reduction and pop/click filters. For more information, visit 
http://www.goldwave.com. 
 
HP CD Writer PlusHP CD Writer PlusHP CD Writer PlusHP CD Writer Plus    
 

    The Hewlett-Packard 9510i is an internal IDE CD-re-writable drive for writing 
and rewriting CDs fast. This drive lets you save your files to CD quickly and cost 
effectively. Compatible with large-capacity, 80-minute CDs, this drive comes with CD 
creation and backup software so you can create reliable custom CDs for music, photos, 
and data; back up and protect individual files or folders; or restore your whole hard 
drive. For more information, visit http://welcome.hp.com/country/us/en/prodserv.html 
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Macromedia FlashMacromedia FlashMacromedia FlashMacromedia Flash    
 

 Flash provides the tools to create rich content and applications across desktops 
and the Web.  Flash is installed on 97% of Web-enabled desktops, and would enhance 
any Indigenous language based website. For more information, visit 
http://www.macromedia.com/software/flash/ 
 
Microsoft Front PageMicrosoft Front PageMicrosoft Front PageMicrosoft Front Page    
 

 This software program is designed to make website development an easy and 
enjoyable process.  Like other Microsoft products, it has helpful templates and step-by-
step instructions to help you master HTML. For more information, visit 
http://office.microsoft.com/home/office.aspx?assetid=FX01085802 
 
Microsoft Picture ItMicrosoft Picture ItMicrosoft Picture ItMicrosoft Picture It    
 

 A powerful photo-editing tool making it easy to improve photos. This software 
uses advanced editing and creative tools to make your good pictures great pictures. For 
more information, visit http://www.microsoft.com/products/imaging/products/pipinfo.asp 
 
Microsoft PubMicrosoft PubMicrosoft PubMicrosoft Publisherlisherlisherlisher    
 

 Microsoft Publisher is a software program that helps you to create and publish 
various materials, including newsletters, flyers, and brochures.  It also has built in 
templates that aid in the creation of these various types of publications. For more 
information, visit http://office.microsoft.com/home/office.aspx?assetid=FX01085794 
 
Paint Shop ProPaint Shop ProPaint Shop ProPaint Shop Pro    
 

 Paint Shop Pro is an mage-editing package which combines low price and 
powerful features. Paint Shop Pro is a fully featured digital darkroom in the same mold 
as Adobe Photoshop and Corel Photo-Paint. Version 7 adds new features for retouching 
digital images, creating business graphics, and producing interactive Web graphics. For 
more information, visit http://www.jasc.com/products/ 
    
Roxio Easy CDRoxio Easy CDRoxio Easy CDRoxio Easy CD----and DVDand DVDand DVDand DVD Creator 6.0 Creator 6.0 Creator 6.0 Creator 6.0    
 

The digital media suite has been redesigned - it's easy to install and use. For more 
information, visit http://www.smallbusinesscomputing.com/biztools/article.php/2106401 



 168 

Sound ForgeSound ForgeSound ForgeSound Forge    
 

    The Sound Forge® digital audio editor includes a powerful set of audio processes, 
tools, and effects for manipulating audio. Sound Forge software allows you to edit, 
record, encode, and master nearly any form of digital audio including WAV, AIFF, 
MP3, and more. For more information, visit 
http://mediasoftware.sonypictures.com/products/soundforgefamily.asp 
 
Studio 8Studio 8Studio 8Studio 8    
 

 Studio 8 is a software program that focuses on video editing and DVD authoring.  
It does not provide a template based learning environment, however, and would be 
more useful for those with extensive computer experience. For more information, visit         
http://www.pcmag.com/article2/0,4149,574600,00.asp 
 
Toolbook InstructorToolbook InstructorToolbook InstructorToolbook Instructor    
 

 This software program aids in the creation of software application simulations and 
is easy to use.  It is intended to help make learning more interactive and assessment 
comprehensive – tools essential to Indigenous language programs. For more information, 
visit http://www.sumtotalsystems.com/toolbook/instructor.html 
 
VoiceVoiceVoiceVoice----ItItItIt    
 

 Technology supporting personal voice recording.. The latest device records up to 
5 minutes of notes with flash memory, which protects against data loss if the battery 
runs out. This recorder is easy to carry, weighing only 2 ounces and measuring 3.5 by 
2.25 by 0.5 inches. Its features include four channels for sorting messages, a keypad 
lock, two erase options, two play options, and skip-forward and -reverse buttons. It runs 
on one AAA battery, which is included and lasts up to six months. For more 
information, visit http://www.blueswimmer.com/category.act?categoryid=00008 
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SELECTED ONLINE SELECTED ONLINE SELECTED ONLINE SELECTED ONLINE SOFTWARE SOFTWARE SOFTWARE SOFTWARE TUTUORIALSTUTUORIALSTUTUORIALSTUTUORIALS & ONLINE COURSES & ONLINE COURSES & ONLINE COURSES & ONLINE COURSES    
    
Microsoft Home PageMicrosoft Home PageMicrosoft Home PageMicrosoft Home Page    
  
 This is the central site for accessing new information and tutorials about 
Microsoft Office products. See http://www.microsoft.com. 

 
Florida Gulf Coast UnFlorida Gulf Coast UnFlorida Gulf Coast UnFlorida Gulf Coast Universityiversityiversityiversity    
 
 This site offers excellent tutorials for Office 2000 including Word, FrontPage and 
PowerPoint.: http:/ www.fgcu.edu/support/office2000/ 
 
Electric TeacherElectric TeacherElectric TeacherElectric Teacher    
 
 This is a very helpful site for simple tutorials on PowerPoint, FrontPage, other 
software and many lesson plan ideas. http://www.electricteacher.com 
 
Learning Electric.comLearning Electric.comLearning Electric.comLearning Electric.com    
 
 A number of helpful, easy-to-follow tutorials can be found at 
http://www.learningelectric.com/word.htm 
 
Downloads.comDownloads.comDownloads.comDownloads.com    
 
 If you are looking for free software and lots of it check out 
www.downloads.com. 
 
Multimedia Learning LabMultimedia Learning LabMultimedia Learning LabMultimedia Learning Lab    
  
 This is a University of Arizona resource site. Look under ‘Workshops’ for helpful 
tutorials at http://www.mll.arizona.edu 
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SELECTED WEBSITESSELECTED WEBSITESSELECTED WEBSITESSELECTED WEBSITES    
    
Teaching Indigenous LanguagesTeaching Indigenous LanguagesTeaching Indigenous LanguagesTeaching Indigenous Languages    

� http://jan.ucc.nau.edu/~jar/TIL.html 
 

The Society for the Study of the Indigenous Languages of the AmericasThe Society for the Study of the Indigenous Languages of the AmericasThe Society for the Study of the Indigenous Languages of the AmericasThe Society for the Study of the Indigenous Languages of the Americas 
� http://www.ssila.org 
 

The Alaska Native Language CenterThe Alaska Native Language CenterThe Alaska Native Language CenterThe Alaska Native Language Center 
� http://www.uaf.edu/anlc/ 

    
The Piegan InstituteThe Piegan InstituteThe Piegan InstituteThe Piegan Institute    

� http://www.pieganinstitute.org 
 
The Indigenous Language InstituteThe Indigenous Language InstituteThe Indigenous Language InstituteThe Indigenous Language Institute    

� http://www.Indigenous-language.org 
 
The Foundation for Endangered LanguagesThe Foundation for Endangered LanguagesThe Foundation for Endangered LanguagesThe Foundation for Endangered Languages    

� http://www.ogmios.org/home.htm 
 
TerralinguaTerralinguaTerralinguaTerralingua    

� http://www.terralingua.org 
 
Oneida Nation Cultural HeritageOneida Nation Cultural HeritageOneida Nation Cultural HeritageOneida Nation Cultural Heritage    

� http://language.oneidanation.org 
 
TechnologyTechnologyTechnologyTechnology----Enhanced Language RevitalizationEnhanced Language RevitalizationEnhanced Language RevitalizationEnhanced Language Revitalization    

� http://projects.ltc.arizona.edu/gates/TELR.html 
    
Technology and Indigenous LanguagesTechnology and Indigenous LanguagesTechnology and Indigenous LanguagesTechnology and Indigenous Languages  

� Language Learning & Technology Special Issue  
Volume 6, Number 2 May 2002 

� http://llt.msu.edu/vol6num2/default.html 
    
NaNaNaNative Languages Pagetive Languages Pagetive Languages Pagetive Languages Page    

� http://www.nativeculture.com/lisamitten/natlang.html    
        

        

 
"When a language dies, its 
universe--a unique way of 
understanding, interpreting, 
and inventing the world--dies 
with it.  A cultural gene pool 
dries up, and all of us are the 
weaker and the poorer for the 
dying of diversity." 
 

                        

Brian Swann, 

         Coming to Light. 
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FUNDING SOURCESFUNDING SOURCESFUNDING SOURCESFUNDING SOURCES    
 
 The information about funding sources was taken from each website listed. These 
represent just a few of the many possible organizations which offer support for 
endangered languages. 
 
Government BasedGovernment BasedGovernment BasedGovernment Based    
 

� ANAANAANAANA    
    Website: http://www.acf.dhhs.gov/programs/ana/programs/index.html 
 Administration for Native Americans  
 Mail to: 8th Fl. West Aerospace Center  
 370 L'Enfant Promenade  
 Washington, D.C. 20447-0002  
 Toll Free 1-877-922-9262    
 
 The Administration for Native AmericansAdministration for Native AmericansAdministration for Native AmericansAdministration for Native Americans (ANA) promotes the goal of 
social and economic self-sufficiency of American Indians, Alaska Natives, Native 
Hawaiians, and other Native American Pacific Islanders, including Native 
Samoans. 

 
� NEHNEHNEHNEH    

Website: www.neh.gov 
The National Endowment for the Humanities        
1100 Pennsylvania, NW, Washington, DC 20506 
Call: 1-800-NEH-1121 
Email: info@neh.gov 
 

 The National Endowment for the Humanities National Endowment for the Humanities National Endowment for the Humanities National Endowment for the Humanities supports a wide range of 
projects, including language preservation. Because democracy demands wisdom, 
the National Endowment for the Humanities serves and strengthens our Republic 
by promoting excellence in the humanities and conveying the lessons of history 
to all Americans. The Endowment accomplishes this mission by providing grants 
for high-quality humanities projects in four funding areas: preserving and 
providing access to cultural resources, education, research, and public programs.  

NEH grants typically go to cultural institutions, such as museums, 
archives, libraries, colleges, universities, public television, and radio stations, and 
to individual scholars. The grants strengthen teaching and learning in the 
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humanities in schools and colleges across the nation, facilitate research and 
original scholarship, provide opportunities for lifelong learning preserve and 
provide access to cultural and educational resources strengthen the institutional 
base of the humanities.  

    
� NSFNSFNSFNSF  

Website: www.nsf.gov 
The National Science Foundation 
4201 Wilson Boulevard, 

 Arlington, Virginia 22230 
USA 

 
 The National Science FoundationNational Science FoundationNational Science FoundationNational Science Foundation funds research and education in science 
and engineering. It does this through grants, contracts, and cooperative 
agreements to more than 2,000 colleges, universities, and other research and/or 
education institutions in all parts of the United States. The Foundation accounts 
for about 20 percent of federal support to academic institutions for basic research. 

  
            

Private FoundationsPrivate FoundationsPrivate FoundationsPrivate Foundations    
    

� The Benton FoundationThe Benton FoundationThe Benton FoundationThe Benton Foundation    
            

Website: www.benton.org 
Benton Foundation 
1625 K Street, NW 20006 
11th Floor 
Washington, DC 20006 
Phone: 202-638-5770 
Fax: 202-638-5771 
 

 “The mission of the Benton Foundation is to articulate a public interest 
vision for the digital age and to demonstrate the value of communications for 
solving social problems. Current priorities include: promoting a vision and policy 
alternatives for the digital age in which the benefit to the public is paramount; 
raising awareness among funders and nonprofits on their stake in critical policy 
issues; enabling communities and nonprofits to produce diverse and locally 
responsive media content. TTTThe Benton Foundation does not accept unsolicited he Benton Foundation does not accept unsolicited he Benton Foundation does not accept unsolicited he Benton Foundation does not accept unsolicited 
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grant applications or offer general grantsgrant applications or offer general grantsgrant applications or offer general grantsgrant applications or offer general grants. We are a private foundation, an 
institutional hybrid, bridging the worlds of philanthropy, public policy and 
community action. We assume diverse, crosscutting roles as nonpartisan 
knowledge broker, convener, public interest advocate and policy analyst. The 
Foundation has an endowment of approximately $10 million, the annual income 
from which is devoted to our own operating projects. Because of Benton's 
pioneering work, a number of foundations and corporations have provided 
additional funding.” 
 
� The Christensen FoundationThe Christensen FoundationThe Christensen FoundationThe Christensen Foundation    
        

Website: www.christensenfund.org 
145 Addison Avenue 

 Palo Alto, California 94301    

 Geographic Bio-Cultural Focus: The Christensen Fund (TCF) is developing 
a new grant-making program that combines our interests in arts, biological 
conservation science and education into a single approach. Funding will be 
directed towards strengthening the understanding, appreciation and creative 
persistence of biological and cultural diversity in four geographic regions: 

� The Greater South West (USA and Mexico)  
� Turkey, Iran and Central Asia  
� The African Rift Valley (Ethiopia)  
� Northern Australia and Melanesia  

 We will also accept proposals from California San Francisco Bay Area-
based organizations whose activities support bio-cultural and educational outreach 
efforts linked to one or more of these geographic regions or the diaspora from 
those regions living in the Bay.  A small number of grants will also be made 
that support efforts to build knowledge and practice worldwide around integrating 
concerns for cultural and biological diversity. 
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� Endangered Language FundEndangered Language FundEndangered Language FundEndangered Language Fund    
 

Website: http://www.ling.yale.edu:16080/~elf/ 
Endangered Language Fund, Inc.  
Department of Linguistics  
Yale University  
P. O. Box 208366  
New Haven, CT 06520-8366  
USA 

             
The Endangered Language Fund is devoted to  

� The scientific study of endangered languages  
� The support of native efforts in maintaining endangered languages  
� The dissemination, to both the native communities and the scholarly 

world, of the fruits of these efforts  

 The fund supports efforts originated by the native community or the 
scholar planning to work with a language. Each year, we solicit proposals for 
such work as  

� Preserving the texts of a native culture  
� Preparing videotaped instruction in the language  
� Support for "generation skipping" language learning  

 

� The Indigenous Language InstituteThe Indigenous Language InstituteThe Indigenous Language InstituteThe Indigenous Language Institute    
    

  Website: http://www.Indigenous-language.org 
  560 Montezuma Avenue, 202 
  Santa Fe, NM 87501 
  Ph: 505/820-0311 
  Fax: 505/820-0316 

The Indigenous Language Institute (ILI) recognizes the imminent loss of 
Indigenous peoples' languages and acknowledges the individuality of Indigenous 
communities. ILI facilitates innovative, successful community-based initiatives for 
language revitalization through collaboration with other appropriate groups and 
organizations, and promotes public awareness of this crisis.    
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� FoundatiFoundatiFoundatiFoundation for Endangered Languageson for Endangered Languageson for Endangered Languageson for Endangered Languages    

Website:  http://www.ogmios.org/home.htm 

 A few of the stated aims of the Foundation are:  To raise awareness of 
endangered languages, both inside and outside the communities where they are 
spoken, through all channels and media; to support the use of endangered 
languages in all contexts: at home, in education, in the media, and in social, 
cultural and economic life; and to monitor linguistic policies and practices, and to 
seek to influence the appropriate authorities where necessary;  

    
� Ford FoundationFord FoundationFord FoundationFord Foundation    

        
        Website:    office-of-communications@fordfound.org 

Ford Foundation  
(Headquarters)  
320 East 43rd Street  
New York, NY 10017 USA  
tel: (212) 573-5000  
fax: (212) 351-3677 

 
 “We work mainly by making grants or loans that build knowledge and 
strengthen organizations and networks. Since our financial resources are modest 
in comparison with societal needs, we focus on a limited number of problem 
areas and program strategies within our broad goals.” 

 

    
� Lannan FoundationLannan FoundationLannan FoundationLannan Foundation    
    

  Website: www.lannan.org 
  Lannan Foundation 

  313 Read Street 

  Santa Fe, New Mexico 87501-2628  

  505-986-8160 phone 

  505.986.8195 fax 

 Lannan Foundation is a family foundation dedicated to cultural freedom, 
diversity and creativity through projects which support exceptional contemporary 
artists and writers, as well as inspired Native activists in rural Indigenous 
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communities. The foundation recognizes the profound and often unquantifiable 
value of the creative process and is willing to take risks and make substantial 
investments in ambitious and experimental thinking. Understanding that 
globalization threatens all cultures and ecosystems, the foundation is particularly 
interested in projects that encourage freedom of inquiry, imagination, and 
expression. The Indigenous The Indigenous The Indigenous The Indigenous Communities ProgramCommunities ProgramCommunities ProgramCommunities Program (ICP) supports the resolve of 
Native Americans to renew their communities through their own institutions and 
traditions. Funding priority is given to rural Indigenous projects that are 
consistent with traditional values in the areas of education, Native cultures, the 
revival and preservation of languages, legal rights, and environmental protection. 
The foundation has supported the efforts of several national organizations, though 
funding priority is currently given to smaller, rural grassroots organizations 
serving communities that are Indigenous to specific geographic locations. 
Organizations supported both serve and are controlled by Native people. 
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GLOSSARYGLOSSARYGLOSSARYGLOSSARY 
 
We have included many basic technology-related terms here. For more, check 
online at  

www.webopedia.comwww.webopedia.comwww.webopedia.comwww.webopedia.com....    
    

 

Adobe AcrobatAdobe AcrobatAdobe AcrobatAdobe Acrobat    
Software that allows the user to read certain files, called pdf files that may be sent via email or 
found on the Web. This is free software that is easily downloaded. 

 
AnalogAnalogAnalogAnalog    

A format used for storing data, including sound recordings. Sound is stored in analog format on 
audio cassette tapes, for instance. 

 
AudacityAudacityAudacityAudacity    

An open source sound editing system. 
 

AuthorwAuthorwAuthorwAuthorwareareareare    
Authorware is a software meant to provide tools for creating interactive learning and training 

environments that use digital movies, sound, animation, text and graphics.  
    
AWE cardAWE cardAWE cardAWE card 

A sound card that uses wave table. 
 

BackupBackupBackupBackup    
Making a copy of software and files/documents on another storage device so that it can be 

restored if the computer loses that information. 
    

BandwidthBandwidthBandwidthBandwidth    
Technically, bandwidth is the difference, in Hertz (Hz), between the highest and lowest 

frequencies of a transmission channel. However, as typically used, it is also the amount of data, 
usually measured in bits per second, that can be sent through a given communications circuit. 

 
BatteryBatteryBatteryBattery    

Your laptop can run on a battery, which will need to be recharged if it runs down. The 
computer usually has an automatic recharge function that will recharge the battery when your 

computer is plugged in. 
 

BinaryBinaryBinaryBinary    
Computers store information in the form of on-off electrical impulses, which correspond to the 

binary (2 base) digits, 0 and 1. Files can be transferred over the Web in either binary or ASCII 
(text) format. A binary file is one that contains any non-printable characters, such as compiled 

programs, graphics files, word processing and spreadsheet files, audio files, and so on.  
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BitBitBitBit    
A binary digit. A bit is the primary unit of digital data and is written in binary language as a 1 

or a 0. There are eight bits in a byte and in one ASCII character. 
    
BetaBetaBetaBeta 

A beta version of something is not yet ready for prime time but still possibly useful to related 

developers and other interested parties. 
    

BookmarkBookmarkBookmarkBookmark    
A list of frequently accessed websites which you can create using a ‘bookmark’ function such as 

clicking on ‘Favorites’ in Internet Explorer.        
    

BootBootBootBoot 
Starting up an operating system (OS) is called ‘booting’ it. If the computer is already running, it 

is more often called ‘rebooting’. 
 

BrowseBrowseBrowseBrowse 
When you browse on the Web, you look around at various websites, following links or doing 

searches. 
 

BrowserBrowserBrowserBrowser    
An application that displays HTML and other information found on the Web. Netscape and 

Internet Explorer are examples of browsers. This software accesses the Web and let you drift 
from link to link without having to have a purposeful search. 
 

ByteByteByteByte    
Unit of measurement for computer memory roughly equal to one character (For example, the 

letter "A"). A byte is a grouping of bits. . . . Memory is typically measured in kilobytes or 
megabytes, and disk space is typically measured in megabytes or gigabytes. 

    
                          1000 Bytes=1 Kilobyte (K, KB)                  1000 Bytes=1 Kilobyte (K, KB)                  1000 Bytes=1 Kilobyte (K, KB)                  1000 Bytes=1 Kilobyte (K, KB)    

                    1000 Kilobytes=1 Megabyte (MB)                    1000 Kilobytes=1 Megabyte (MB)                    1000 Kilobytes=1 Megabyte (MB)                    1000 Kilobytes=1 Megabyte (MB)    
                    1000 Megabytes=1 Gigabyte (GB)                    1000 Megabytes=1 Gigabyte (GB)                    1000 Megabytes=1 Gigabyte (GB)                    1000 Megabytes=1 Gigabyte (GB)    

    
CD read/write driveCD read/write driveCD read/write driveCD read/write drive    

(see Drive) 
 

CDCDCDCD----ROM (CDROM (CDROM (CDROM (CD----R and CDR and CDR and CDR and CD----RW)RW)RW)RW)    
A portable CCCCompact DDDDisk ROM, which means that you cannot interact with the data on this disk. 

 
ClickClickClickClick 

When the cursor is pointing to something you want to access on your screen, click with the 
mouse by pressing down with your right forefinger on the left mouse button.     
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Double clickDouble clickDouble clickDouble click – by pushing the left mouse button twice in a rapid manner. 
Left click Left click Left click Left click - Used for navigating within your documents and on the screen and it operates the 

cursor.    
Right click Right click Right click Right click -    Enables you to bring materials into your file, to cut and paste, and change 

document formats.        
    

ClipboClipboClipboClipboardardardard    
A temporary storing area for cut or copied information. 

    
ComputerComputerComputerComputer    

An electronic machine that accepts, processes, outputs and stores data. More technically, a 
computer is a programmable machine. Some of the major parts of a PC include the motherboard, 

CPU, memory (or RAM), hard drive, and video card.  
 

CPUCPUCPUCPU    
CCCCentral PPPProcessing UUUUnit (the circuitry or ‘engine’) controls storage and processing of data. CPU's 

have a clock speed measured in Megahertz (Mhz). Higher numbers usually mean faster 
computers.  

    
CookieCookieCookieCookie 

A cookie is a small file that a web page on another machine writes to your computer’s disk to 
store various bits of information.  

 
CrashCrashCrashCrash 

This is what you DON’T want to experience! A computer ‘crashes’ when a bug (problem) enters 

a program severe enough to cause the computer to become inoperable without being restarted.  
 

CursorCursorCursorCursor    
This is the symbol on your display screen which represents your logical position within a 

document. The cursor can be either an arrow, a hand, a vertical bar, an hourglass, or some other 
symbol. 

    
DatabaseDatabaseDatabaseDatabase    

A collection of related information (data) that can be sorted, searched and calculated.  
 

DefaultDefaultDefaultDefault    
The option that is selected automatically by a system unless an alternative is specified. 

    
DeleteDeleteDeleteDelete    

To delete a file, click on its name, hold down the mouse button and drag the name to the 
recycle bin icon. Then let go. 

    
DesktopDesktopDesktopDesktop    

The desktop is the main screen of your computer. When you turn the computer on, you will see 
the desktop. Go from here to other software or functions. 
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DigitalDigitalDigitalDigital    
A format for storing data, including sound recordings. Sound is stored in digital format on 

computers, CDs, and disks. The digital format is used whenever a computer is involved: digital 
code is the language of computers. It is called digital because it is made of binary code.  

 
Digital cameraDigital cameraDigital cameraDigital camera 

A digital camera looks and behaves like a regular camera However, instead of using film, it 
stores the image as a file for later transfer to a computer.  

 
DiDiDiDirectoryrectoryrectoryrectory    

On a hard drive, a file which acts as a folder and contains other files or directories. On the Web 
a Listing of websites, email addresses or other data. 

    
DiskDiskDiskDisk 

A disk is a physical object used for storing data. It will not forget its data when it loses power. 
It is always used in conjunction with a disk drive. Some disks can be removed from their drives, 

some cannot.  
 

DocumentsDocumentsDocumentsDocuments    
Any files you may create, especially on a word processing program like Microsoft Word. 

 
DomainDomainDomainDomain    

A named collection of network hosts. Some important domains are: .com (commercial), .edu 
(educational), .net (network operations), .gov (U.S. government), and .mil (U.S. military). Most 
countries also have a domain. For example, .us (United States), .uk (United Kingdom). 

 
DownloadDownloadDownloadDownload    

To ‘download’ a file is to copy it from a remote computer to your own. The opposite of this 
action is upload. 

 
Drive Drive Drive Drive     

A device for storing and/or retrieving data. Usually you will be saving files to a hard drive, 
which is an integral part of the computer’s hardware. You may also wish to keep files on floppy 

disks, which are portable. Some drives (such as disk drives, zip drives, and tape drives) are 
typically capable of having new data written to them, but some others (like CD-ROMs or DVD-

ROMs) are not. 
 

DVD playerDVD playerDVD playerDVD player    
This port allows you to play DVDs.    
    

EditEditEditEdit    
To make changes to a document, a sound file, a video file, and so on.  
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Email (electronic mail)Email (electronic mail)Email (electronic mail)Email (electronic mail)    
A system whereby a computer user can exchange messages with other computer users (or groups 

of users) via a communications network. Electronic mail is one of the most popular uses of the 
Web. 

 
FAQFAQFAQFAQ    

FFFFrequently AAAAsked QQQQuestions. 
    
File(s)File(s)File(s)File(s)    

Where you keep your work. You may want to think of them as file folders like the ones we put 

in filing cabinets. On the computer, these are usually kept on the hard drive or stored on a CD 
or Floppy disk. A file is an information packet, either data or code, identified by a filename and 

accessible by a filing system. 
    
FirewallFirewallFirewallFirewall    

A hardware device (or collection of devices) that is placed between two networks. One network 

is considered inside the company (safe) and one is considered outside the company (not safe). All 
traffic, both from the inside and outside, must pass through this device. 

 
Floppy disk (aka Floppy)Floppy disk (aka Floppy)Floppy disk (aka Floppy)Floppy disk (aka Floppy)    

Small portable devices that are used to save files and transport these files between computers. 
 

Floppy driveFloppy driveFloppy driveFloppy drive    
(see Drive)(see Drive)(see Drive)(see Drive)    

    
Folders Folders Folders Folders     

Folders contain and help you organize your files. You may wish to have a separate folder for 

different subjects or projects. All of your files related to that subject or project can then be 
stored together in the same folder. 

    
FontFontFontFont    

The font defines what each letter, number, and other symbol looks like.  
 

GIFGIFGIFGIF    
GGGGraphic IIIInterchange FFFFormat is a highly compressed format for storing and transferring graphic 

images.  
    

GigabyteGigabyteGigabyteGigabyte    
Approximately one billion bytes or 1,000 MB (actual 1,073,741,824 bytes).  

    
GopherGopherGopherGopher    

A simple, menu-based system for searching and retrieving information from resources across the 
Web. 

 
GraphicGraphicGraphicGraphic    

A binary file that is displayed as an image (picture or drawing) as opposed to text. 
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Graphical User InterfaGraphical User InterfaGraphical User InterfaGraphical User Interface (GUI)ce (GUI)ce (GUI)ce (GUI)    
A GUI is a software which lets the user use pictures and "point-and-click" technology to access 

the software application. It allows a computer user to interact with the computer by manipulating 
graphic (image) representations (called icons) with a mouse or other pointing device instead of 

typing text commands. 
    

Hard copyHard copyHard copyHard copy    
A printed copy of any produced document or data. 

    
Hard driveHard driveHard driveHard drive    

A piece of computer hardware used to store files or information. They are currently getting 
cheaper and smaller---some now fit on a key chain.  

    
HardwareHardwareHardwareHardware 

The actual physical parts of a computer system: monitor, keyboard, mouse, the CPU and so forth 
– anything you can actually touch. These are the pieces of equipment that hold the working parts 

of the computer as well as the working parts themselves. Also included are drives and boards. 
 
Home pageHome pageHome pageHome page    

The starting point for a set of information about a particular topic in the Web; the first screen 

you see when you access a website. 
 

HostHostHostHost    
A computer that provides a physical link to the Web and allows users to communicate with other 
host computers on a network. 

 
HTMLHTMLHTMLHTML    

HTML stands for HHHHyper TTTText MMMMarkup LLLLanguage, which is a standardized method for defining 
formatting, links, and other special handling of text, images, and objects. The Web can be thought 

of as a single VERY large HTML document. Every browser has the built-in ability to understand 
HTML. 

 
HttpHttpHttpHttp    

The HHHHyper TTTText TTTTransfer PPPProtocol is the native protocol of browsers and is most typically used to 
transfer HTML formatted files.  

 
IIIIconconconcon 

A graphic image that appears on your computer monitor which represents a computer task or 
file. You can click on it to access its function. Double clicking on an icon for Microsoft Word 

will load that software program so that you can use it. Icons have a variety of functions. They 
usually have a hidden attached description that can help you see what they are and what they do 

which appears when you place the cursor over the icon. 
    
ImportImportImportImport    

To bring new information into an existing file from an outside source. 
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InputInputInputInput    
Any data or instructions entered into a computer through any of a variety of processes for storing 

and configuring application software on a hard drive. Also, adding hardware to a system. 
 

InterfaceInterfaceInterfaceInterface    
Hardware that connects one thing to another, enabling you to move or change the format of data; 

also,     a means by which the two systems interact. 
    
Internet (aka Web)Internet (aka Web)Internet (aka Web)Internet (aka Web)    

(see Web) 

 
Internet Explorer Internet Explorer Internet Explorer Internet Explorer     

A popular browser. Double click on this icon to get access to email, and the Web. 
    
JavaJavaJavaJava    

An independent programming language, developed by Sun Microsystems. Java Applications are 

compiled and stored on a server and downloaded to be run on local "Java Virtual Machines" 
embedded into the client software. 

 
JavascriptJavascriptJavascriptJavascript    

A special purpose Java-like language especially adept at interacting with user input and used 
extensively to make web pages interactive. 

    
JPEGJPEGJPEGJPEG    

JPEG stands for JJJJoint PPPPhotographic EEEExperts GGGGroup, which defines a standard compression format 

for high-resolution color images.(.jpg) 
 

KilobitKilobitKilobitKilobit    
One thousand bits. The kilobit is a convenient unit of data for talking about transmission speeds 

over computer networks. 
 
KilobyteKilobyteKilobyteKilobyte    

Approximately one thousand bytes (1,024). 

 
LANLANLANLAN    

LLLLocal AAAArea NNNNetwork is a linking of many computers so that they may exchange files and share 
hardware (like printers and disk drives). 

    
LAN portLAN portLAN portLAN port    

This is the location (port in back of the computer) where you connect to LANs. 
 

Language lesson modulesLanguage lesson modulesLanguage lesson modulesLanguage lesson modules    
Sets of short, related lessons written on MaxAuthor. 
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LaptopLaptopLaptopLaptop    
A small, portable computer that can be held on your lap (if you want!). This name distinguishes 

it from a desktop computer. Desktops have separate monitors, keyboards, and CPUs. Laptops 
have everything in one package.  

    
Local printerLocal printerLocal printerLocal printer    

This usually refers to a printer that is directly connected to a computer, as opposed to one 
connected via a network. 

 
Login (verb)Login (verb)Login (verb)Login (verb)    

A procedure used to establish communication, by the user, to a computer. 
    
Login (noun)Login (noun)Login (noun)Login (noun)    

The same as User ID – ‘UUUUser IdIdIdIdentification’ name or number.    

    
LinkLinkLinkLink    

A word, phrase, graphic, or address that, when clicked on, loads other information about the 
linked phrase or loads a related web page. 

 
ListservListservListservListserv    

An automated mailing list distribution. Listserv’s are used to send single messages to a wide 
audience (usually with a common interest like, ILAT - Indigenous Languages and Technology 

listserv) usually to promote a discussion among members of the list.  
 
LurkingLurkingLurkingLurking    

Listening without responding publicly on a listserv or mailing list. As the name implies, this 
activity is considered somewhat antisocial, but lurking allows beginners to get a feel for the flavor 

and response patterns of the participants of the group, and also lets them get up to speed on the 
history of the group. 

    
Macintosh (aka Mac)Macintosh (aka Mac)Macintosh (aka Mac)Macintosh (aka Mac)    

The type of microcomputer made by the Apple computer company. 
    
Mail folderMail folderMail folderMail folder    

A file organized in a standard format where one or more email messages are stored. 

    
Mail serverMail serverMail serverMail server    

A program that distributes files or information in response to requests sent via email. 
 

Main menuMain menuMain menuMain menu    
The ‘main menu’ usually refers to the first menu you encounter in a software program. 

    
MaxAuthorMaxAuthorMaxAuthorMaxAuthor    

Software created by the Critical Languages program at the University of Arizona for language 
learning. It contains self-directed lessons and learning modules in which students can see, hear, 

practice, and repeat language lessons. Designed primarily for languages that are less commonly 
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taught. MaxAuthor contains video, audio, and text so that learners may simulate a classroom 
experience by listening to, reading, and repeating words, phrases and sentences. Many of the 

lessons include video of the language being spoken by native speakers. Users of MaxAuthor can 
also create their own lessons. 

 
MegabitMegabitMegabitMegabit    

One million bits.    
    

Megabyte (MB)Megabyte (MB)Megabyte (MB)Megabyte (MB)    
Approximately one million bytes (1,048,576). 

 
Megahertz (MHz)Megahertz (MHz)Megahertz (MHz)Megahertz (MHz)    

A unit of measurement, equal to one million cycles per second, used to compare the speed of 
computers. The higher the number, the faster the computer. 

 
MemoryMemoryMemoryMemory    

Computer hardware (usually chips) used to store information, not to be confused with the hard 
drive. 

 
MenuMenuMenuMenu    

A list of items that you may select that may have a variety of functions such as provide 
information, start an application, or show another set of choices. 

 
MicrocomputerMicrocomputerMicrocomputerMicrocomputer    

A personal desktop or portable computer; usually refers to either a compatible PC or Macintosh. 

 
Microsoft WindowsMicrosoft WindowsMicrosoft WindowsMicrosoft Windows    

A graphical interface that runs on the MS/DOS operating system modem.  
    

ModemModemModemModem    
A modem converts digital signals to analog and back again to digital. 

 
MonitorMonitorMonitorMonitor    

Output device that produces on-screen display of processed data and computer instructions. 
 

MouseMouseMouseMouse    
A hand-operated pointing device that enables you to operate your software programs to create and 

manipulate files. On the screen you will see the blinking cursor that indicates where the mouse 
is pointing. The mouse itself rests on the table or desk and can be moved easily by hand. It 

usually has rolling ball underneath it that helps it move. It’s easier to use a mouse with a mouse 
pad, a special pad with a surface that makes mouse movement go more smoothly.  

    
Mouse operationMouse operationMouse operationMouse operation    

The mouse has two buttons near the “tail” or cord which you may ‘click’ left or right on.  
These buttons enable you to interact with your software, give commands to the computer and 

move around the screen. 
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MPEGMPEGMPEGMPEG    
MMMMotion PPPPictures EEEExperts GGGGroup, which defines a standard compression format for video and 

sound. It is used to display and hear online movies. 
 

MS/DOSMS/DOSMS/DOSMS/DOS    
(see Operating System) 

 
MultimediaMultimediaMultimediaMultimedia 

Multimedia refers to the combination of sound and video on a computer or software package. 
This indicates a capability to work with and integrate various types of things including audio, still 

graphics, and especially video as part of specific software programs. 
    

NetiquetteNetiquetteNetiquetteNetiquette    
A pun on "etiquette" referring to proper behavior on a network. There currently is no "Miss 

Manners" of the Web—but ‘netiquette’ is expected of users. 
 

NetworkNetworkNetworkNetwork    
The term refers to any group of computers that are connected to each other and can share 

information.  
 

Network printerNetwork printerNetwork printerNetwork printer    
A printer that is attached to a network and is accessible by other machines on that network. 

 
NotebookNotebookNotebookNotebook    

Portable, battery powered computer, a small laptop, with monitor, system unit and keyboard 

combined as one unit. 
 

OnlineOnlineOnlineOnline    
Connected to or part of a network especially the Web. 

 
Open URLOpen URLOpen URLOpen URL    

The dialog box you use to type the complete URL address for a web page or other Internet 
server. 

 
OpenOpenOpenOpen    

When you open a file, you are telling your software program to find a particular file or piece of 
software and bring it up on your monitor screen. In the Microsoft environment, the Open 

command can be found in the main menu under the command ‘File’.  
 

Open sourceOpen sourceOpen sourceOpen source 
Open source software goes one step beyond freeware. Not only does it provide the software for 

free, it provides the original source code used to create the software. Thus, curious users can 
poke around with it to see how it works, and advanced users can modify it to make it work 

better for them.  
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Operating systemOperating systemOperating systemOperating system    
This is the software that enables your computer to run other software. The two main operating 

systems are the DOS system (which is usually used on IBM-type PCs) and the Mac system 
(Macintosh or Apple computers). 

 
OOOOutpututpututpututput    

Data that is displayed on the computer monitor or printed in hard copy. 
 

PCPCPCPC 
The term PPPPersonal CCCComputer (PC) properly refers to any desktop, laptop, or notebook computer 

system. 
    
PDF filesPDF filesPDF filesPDF files    

These files have a format that requires you to use the software Adobe Acrobat when you want to 

read them. In many cases, this software will load automatically when you attempt to open the 
files.  

 
PixelPixelPixelPixel 

The smallest distinct point on a computer display is called a ‘pixel’.  
 

PlugPlugPlugPlug----inininin 
A plug-in is a piece of software designed not to run on its own but rather work in cooperation 

with a separate application to increase that application's abilities.  
 
PortPortPortPort    

A small plug-in or connection station in the back of your computer.. There is usually more than 
one port. The mouse port, for instance, is where you plug in your detachable mouse. 

 
Power Point (Microsoft)Power Point (Microsoft)Power Point (Microsoft)Power Point (Microsoft)    

Software that you use to create presentations. It makes colorful and visually interesting slides that 
can be shown to an audience on a projector. You can also add audio and video files to Power 

Point slides making it a good medium for creating language lessons. 
 

Power supplyPower supplyPower supplyPower supply    
The plugs and cords connect you to a wall plug. The battery is also a power supply. 

    
PresentationPresentationPresentationPresentation    

Using Power Point, a presentation usually covers a small subject that can be discussed in detail 
in ten to twenty minutes. It is meant to be an oral talk that is based on information recorded on 

the slides. The presentation itself is a performance, in front of an audience, that uses the Power 
Point slides to underscore, emphasize, or illustrate the points you wish to make. Learning to be a 

language advocate, means that you might make many such presentations! 
 

PrinterPrinterPrinterPrinter    
The hardware component that produces hard copy output. 

 



 191 

ProgramProgramProgramProgram    
A set of instructions or steps that tells the computer how to perform a task. Also, another word 

for ‘software’. A program is designed to accomplish certain tasks on the computer. For instance, 
the Power Point program (software) is used to create presentations, the Microsoft Word program 

is used to create documents. 
 

ProtocolProtocolProtocolProtocol 
A protocol is a means of communication used between computers. As long as both computers 

recognize the same protocol, they can communicate without too much difficulty over the same 
network or even via a simple direct modem connection regardless whether or not they are 

themselves of the same type.  
    
QueueQueueQueueQueue    

A backup of packets or print selections, lined-up and awaiting processing. 

    
Quick TimeQuick TimeQuick TimeQuick Time    

A video format for making movies available on the World Wide Web. 
 

RAMRAMRAMRAM    
RRRRandom AAAAccess MMMMemory temporarily stores current application software. 

    
RealPlayerRealPlayerRealPlayerRealPlayer    

Software that enables you to play movies and listen to sound files on your computer. 
 
RealRealRealReal----timetimetimetime 

Something that happens in real-time will keep up with the events around it and never give any 
sort of "please wait" message. 

 
Recycle BinRecycle BinRecycle BinRecycle Bin    

If you delete files, they will go to the Recycle Bin. You can empty this bin by clicking on the 
icon and following instructions on the window that comes up. 

 
ROMROMROMROM 

RRRRead OOOOnly MMMMemory    stores permanently essential system programs and start-up instructions for the 
PC. 

 
RobotRobotRobotRobot 

A robot (or ‘bot’ for short) in the computer sense is a program designed to automate some task, 
often just sending messages or collecting information. A ‘spider’ is a type of robot designed to 

traverse the Web performing some task (usually collecting data).  
 

SaveSaveSaveSave    
A command like Open,  Save is commonly used in the Microsoft environment. To keep the 

changes or edits you make to your files, you must use this command. It records the changes you 
have made on the older version of the file that is stored on the computer’s hard drive, changing 



 192 

the original version of the file. If you want to keep the old version, you should use the Save As 
function and name the revised file a new name.      

 
ScannerScannerScannerScanner    

A scanner is a piece of hardware that will examine a picture and produces a computer file that 
represents what it sees. Scanners digitize (converts into a series of dots) hard copy and stores it 

as a graphics scanner file. 
    

Search engineSearch engineSearch engineSearch engine    
A search engine is a computer program or group of programs which can take a search string 

(usually a word or words) and rapidly compare that string with the information in its database, 
keyword index, or the text of many documents.  
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